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AN INDIAN BLOG died last month, and its readers
wept copious tears. It died not because of the blogger’s
ennui, but because he was served a legal notice by one
of India’s largest media entities asking him to shut up.

In the larger scheme of things, mediaah.com, an
Indian media watchdog blog maintained by Pune-
based journalist Pradyuman Maheshwari, was just
a blip on the media radar. With a claimed reader-
ship of just 8,000 readers, it could have hardly
changed the world. Yet, the media conglomerate’s
bosses decided that they had had enough of Mahesh-
wari’s “jibes” at them and their organisation. In
March, they sent him a legal notice asking him to
delete entries they felt were defamatory.

Maheshwari, on his part, decided to stop pub-
lishing the blog, saying he neither has the time nor
the money to fight the giant. 

He also chose not to apologise.
The media had successfully gagged its toddler

cousin, the Web log. Sadly, yet predictably, no news-
paper or television channel followed up this story.

Compare this with the case of a slew of bloggers
in the US who recently wrote so much about Eason
Jordan—a senior CNN executive who allegedly said at
the World Economic Forum in Switzerland that the
US military had killed 12 journalists by taking delib-
erate aim—that he had to resign from his post.

No one knows for sure whether he made the
statement at all; and no one would say the bloggers
themselves were completely ethical in their uproar-
ious response to the statement. Yet, to its credit, CNN
never tried to shut these bedroom bloggers up.

Honestly, though, I was delighted at the legal
notice sent by India’s largest media house to
Maheshwari. For one, it bared once and for all the
Indian media’s hypocritical “Speech-is-free-and-the-
media-will-ensure-it-remains-that-way” stand; but
more importantly, it proved that Web publishing is
here to stay, and that the blog is already an alternate
publishing medium in India just as it is in several
mature democracies across the world.

When a Rs 1500-crore media giant takes on a one-
man blog (Maheshwari’s silent capitulation notwith-
standing), it is good news. Judging by the response of
the blog’s readers (many of them on the conglomer-

ate’s rolls), there is a community of readers hungry
to know the truth—the reality on the other side.

It is in this community that I have the most faith;
the group of people who will effect that much-
needed change in our perceptions about the media. 

And all because of a phenomenon called the
Internet. As common citizens with apolitical agen-
das, it is technology that will bring us closer to real-
ity. It is a prospect we should all be happy about.

It’s The Medium, Stupid!

Editorial

“When a Rs 1500-crore
media giant takes on a

one-man blog, it is
good news”

Sachin Kalbag Executive Editor

sachin_kalbag@jasubhai.com
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29 Security Superheroes
iViz Techno Solutions, a part of IIT
Kharagpur’s incubation programme, has
the grand vision of “making computing
free from all security threats”

Enter

18 
Acclaimed
thinker and
author 
Dr Edward
deBono doesn’t
use much tech 

18
Netscape Rises
From The Ashes

19 
A worm that
spreads via
P2P networks
such as KaZaA

28
What 3G is, and
how 3G-enabled
devices work

Digital Passion

76 Just Push Print
Standalone printers or MFDs? Regardless,
we test some of the best of both

42 Tube It Up
CRT monitors will remain with us quite some
time, the LCD invasion notwithstanding. We test
the good and the not so good of the tube kind

Contents Magazine

66 Exporting India
We take a look at how one Web enterpreneur
returned to India from France—and switched from
importing to exporting Indian goods worldwide

49 Pixel Palette
Digital art has evolved beyond being a mere novelty.
Here’s a look at how the Web can help digital artists

46 Take A Crack
Just remove a couple of tabs from
‘Internet Options’ and win! Think you
can do it?

38 The Smart Life
Technology  is everywhere... Here’s a
glimpse of what it will be like when we
move around with tech literally
surrounding us—at home, in the car, on
the road...

44 30 Hours With...
The Apple Mac mini. One of our
reviewers—a Wintel faithful—spent time
with this little box to see whether it
could make a convert of him. It might
have, if not for the price

Digital Tools

68 Tech Nightmares
Microsoft Word has its share of niggles.
Here’s what to do about five of them

34 Behind The Lens
Digital cameras, simple though they may be
to operate, are complex assemblies of
several technologies

47 Geek Dreams
The Sony Ericsson V800 is a camera
phone. Or is it a phone camera? Check
out this sleek beauty

70 New & Notable
Presenting a nifty little securicam; the
Motorola MPx—a nice but expensive smart-
phone; a 23-inch BenQ LCD; and more
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85 Dude! Where’s My Truck?
Here’s a look at how one company uses various
technologies, including GPS, DGPS, and GPRS, to
provide a comprehensive tracking system for vehi-
cles and more

108 Wired LANs Or Wi-Fi-based WLANs?
This is a pressing question faced by upcoming
as well as existing businesses. So is upgrading
to a WLAN worth it?

111 Creating A Million Smiles
HP Digital Studio’s ‘Project Muskaan’
aims to take technology to the rural
and urban masses, by converting
conventional photo labs into digital
photo studios

116 ...And There Was Order!
Organising, tagging, and enhancing your
digital pics is easy with the right
software. We introduce you to two such
software that will help you find your
photos even a few years later

106 How Videoconferencing Works 
What do you need to conduct a succesful videocon-
ference? What are the options available? A visual
tour of the technology that could well be the norm
tomorrow

Digital Business

Escape

120
Dennis Hayes
invented the PC
modem—and
changed the
Internet forever  

123
Nanotechnology
may soon find its
way into your
food—no sweat,
it’s not about
little robots in
your tummy
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90 Why-Fi?
Alongside our face-off on whether it’s worth 
upgrading to a WLAN, we give you the facts on what
it involves
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Splinter Cell: Chaos Theory

Sam Fisher is back, and in the middle of
a massive war in the Pacific

Freedom Force vs Third Reich

Dynamic storytelling,  fast-paced
tactical role-play and larger-than-life
characters from the comic book pages
to the computer screen

PLUS
■ LEGO Star Wars
■ Empire Earth 2

DEVELOPER’S KHAZANA
■ NetBeans IDE 4.0
■ JBuilder 2005
■ JBoss 4.0.1
■ J2EE 1.4 SDK

DEV TOOLS
■ jEdit 4.2
■ PHP Designer 2005
■ Mozilla Suite
■ HTMLGate FREE
■ Macromedia HomeSite 5.5
■ NetBeans mobility
■ Bugzilla 2.18
■ Apache 2.0.53
■ Debuggy Version 1.02
■ Hexplorer
■ Hackman Hex Editor 8.02
■ HelpMaker 7.1.385
■ Shalom Help Maker 0.5.2 Beta
■ Notepad2
■ #develop
■ Doxygen
■ Scilab 3.0

LINUX
■ Muine
■ Splint 3.1.1
■ Splint manual
■ Doxygen
■ Scilab 3.0
■ QuickDownloader 5.0
■ Downloader for X 2.5 Beta 2
■ GAIM 1.1.0
■ Yahoo! Messenger 1.0.4-1 
■ Mozilla Thunderbird 1.0
■ LimeWire 3.6.15
■ BitDefender 7.0.1.3
■ Getleft 1.1.2

DIGITAL PASSION DIGITAL TOOLS DIGITAL BUSINESS DIGITAL LEISURE

CD
 

Contents Interactive

NNoottee  11:: Grey areas show the content also available on the CD. The DVD contains all that is on the CD
NNoottee  22::  If you do not want to boot from the CD, remove it from the drive at startup
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Adobe multimedia suite 
The latest versions of Adobe Premiere,
Adobe Audition and Adobe AfterEffects

VMware Workstation 4.5.2
Run multiple operating systems simul-
taneously on a single computer without
the need to partition. You can switch
between them instantly without the
need to reboot your system

MULTIMEDIA
■ Zmatrix 1.5.2
■ TuxType2 1.5.3
■ Anvil Studio 2004.09.05
■ FL Studio 5.0.2
■ AudioEdit Deluxe 4.05
■ Ashampoo Media Player+ 2.03
■ BOOMBox Internet Radio Player 1.0
■ Media Catalog Studio Lite 1.9
■ MP3 Organizer 1.6.55
■ MediaJoin 2.0
■ MP3 Splitter and Joiner 2.86
■ CD Rider 2.1
■ dBpowerAMP Music Converter R6
■ Total Recorder Standard Edition 4.3
■ Power Mixer 1.2
■ CyberLink PowerDVD 5.0
■ DestroY MediaPlay 1.1.0
■ SplitCAM 3.0
■ Beyond TV 3.5
■ SnagIt 7.2.1
■ MWSnap 3.0.0.74
■ ScreenShot Wizard 1.01
■ Advanced GIF Animator 2.21

SYSTEM 
■ Latest ATI Catalyst Drivers
■ MSN Messenger 7 build 604
■ BitDefender 7.2
■ H-Menu 5.0
■ BackupX 1.1
■ DFIncBackup 1.20
■ AES Free 2.7
■ DeepBurner 1.1.2.137
■ Folder Style 1.3
■ Fresh UI 6.60
■ Xteq X-Setup 6.3
■ Fresh Diagnose 6.40
■ SpeedFan 4.20
■ Vilma Registry Explorer 1.6.0
■ EasyCleaner 2.0.6.369
■ SmartBuster 0.97
■ McAfee.com SecurityCenter 4.0
■ VMware Workstation 4.5.2

INTERNET
■ Advanced Call Center 5.1
■ CallStation 4.0
■ Snappy Fax 2000 3.48.3.1
■ Fax4Outlook 2.19
■ ASB AntiSpam 1.54
■ Email Remover 3.0
■ FreeProxy 3.6
■ DC++

OpenOffice.org 2.0 Beta
OpenOffice.org is a free productivity
suite compatible with all major office
suites. This beta version comes with 18
new and major features

EasyOffice
An office suite compatible with
Microsoft Word and Excel and Adobe
PDF files. Also includes EasyAntiVirus,
which you can install if you don’t have
an antivirus program

WHITE PAPERS
■ The Impact of Web Performance on

Retail Success
■ Phishing and the threat to corporate

networks
■ The spam economy: the convergent

spam and virus threats

PRODUCTIVITY TOOLS
■ Inventory & stock control

management

■ Cafe Cop Desktop Edition 1.0
■ Customer Database Pro 6.0
■ Art-Copy Business Edition 7.5.4
■ eBookGuard 3.0
■ FormDocs 7.0.12
■ Find Desktop 1.29
■ Cornolius Database Application 1.3
■ Projetex 2005 build 120

MOVIE AND GAME TRAILERS
■ Hitchhiker's Guide to the Galaxy
■ Metal Gear Solid: Snake Eater
■ Batman: Dead End
■ Sin City

DESKTOP THEMES
■ Gant 2 Ocean SP2
■ WindowBlinds 4.51
■ 6 WindowBlinds Themes

WALLPAPERS 
■ 80+ MB of wallpapers —  games,
bikes, celebrities — we have 'em all

SMALL GAMES
■ Microsoft Urban Assault
■ Worminator 3 (FULL GAME)
■ Cue Club

E-BOOKS
■ Linux From Scratch
■ Books by Bruce Eckel:

Thinking in Java
Thinking in C++

Thinking in Enterprise Java
Thinking in Patterns

Note::  Dear Reader, Due to replication errors, some DVDs and CDs
may require you to launch them by double-clicking the “start.hta”
file from your optical media drive, instead of the regular Auto-run
feature. Team Digit regrets the incovenience.
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By Demand
You get to choose what goes in Digit
Interactive. This month, you chose:

Mozilla Suite
Splinter Cell: Chaos Theory

Online Digit Patrons
It really does

pay to be loyal!

Find out more

on www.
thinkdigit.com

Digit Reader Poll

This Month’s Question

What do you use the
Internet the most for?

E-mail
Downloading Software
Downloading Movies &
Music
Adult Content
Idle Surfing
Research and Education

Log on to www.thinkdigit.com
and vote

taste technology at www.thinkdigit.com

Less
than
Rs 500

Rs 500
to
Rs 1,000

Rs 1,000
to
Rs 2,000

Rs 2,000
to
Rs 5,000 

Anything, Just
give me fast
Internet 

April 2005

There’s something for everyone on the Digit Forum www.thinkdigit.com/forum

Last Month’s Question:

What is the maximum you are willing to
spend per month on a broadband or
always-on Internet connection?
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Dr Edward deBono
Thinker and Author

Dr Edward deBono,
Rhodes scholar to

Oxford, PhD from
Cambridge and MD
(University of Malta) is one
of the world’s foremost
‘thinkers’, and has
authored over sixty books—

translated into 34
languages—on

‘lateral thinking’
methods. He has
also worked with
such corporations
as IBM, Du Pont,

AT&T, NTT (Japan),
Ericsson (Sweden),

Siemens, and Microsoft.

What does technology
mean to you?
Technological advancements
have made it possible for us
to get to places much faster,
use PCs to write, and e-mail
to communicate with people
more efficiently.
What kind of gadgets do
you normally use?
I use the PC to write my
books, and to compose and
send e-mails. The only other
gadget I use is a shaver! 
How do you interact with
technology on a day-to-
day basis?
I don’t browse the Web too
much but I listen to the radio
and watch the news on TV.
Do you feel the surfeit of
information on the Web is
hampering normal thought
processes? Are people
thinking enough?
The Net has made it possible
for people to obtain vast
amounts of information.
Children find answers easily
to several questions. But they
need to be taught and enco-
uraged to think for thems-
elves and use the information
in a productive manner.

Apple To Join Blu-ray Forum
Apple will join the Blu-ray forum to offer support for
Sony’s next-gen DVDs and to enable its own cust-
omers to develop higher-quality videos. The addition
of Apple on the board of the Blu-ray Association could
help decide the format to replace standard DVDs.

Samsung Unveils 3GB HDD Smartphone
On March 11, at the CeBIT 2005 show in Hanover,
Germany, Samsung announced the world’s first phone
with a 7-megapixel digital camera. The SCH-V770 has
3x optical zoom, a flash, full manual mode, 1/2000
shutter speed, and the scope to add additional lenses.

The market for
downloaded music is

strong enough to take a
price rise, according to most
major music labels in
Europe and the US.

Several big labels are in
talks with online music

retailers to get them to
increase prices, according to
a story in London’s Financial
Times (FT). Labels are looking
to increase the wholesale
prices shops pay for tracks.
Sites in the US typically sell
tracks for 99 cents each (Rs
43). The wholesale price is
currently 65 cents (Rs 28) per
track, according to FT.

Universal and Sony BMG
are less keen to push prices
up. EMI and Time Warner,
in fact, refused to comment
on the FT story. Some

observers are concerned
that increasing prices
would push people back to
peer-to-peer networks and
dodgy copies of songs.

The music industry is
apparently unhappy with
Apple’s increasing

share of the market—the
firm sells about 65 per cent
of songs sold online. The
arrival of cheaper iPods is
likely to give the firm an
even larger share of the
market. Apple refused to
comment on the story but
Steve Jobs is reportedly
deeply unhappy with the
attempted price hike.

One suggestion is that
labels want to introduce
variable pricing—so they
can charge more for top-
selling tracks. Meanwhile,

the European Commission
is investigating allegations
that British consumers are
being ripped off by Apple’s
iTunes service because
it charges more for
downloads from the UK site
and does not allow
customers to buy tracks
from other iTunes sites. 

PIZZA ON YOUR PHONE

Two
Companies,
A Talking
Browser And
A Pizza Place

If phone makers get their
way, pretty soon, we’ll all

tote little Web browsers in
our pockets, whipping them
out 10 times a day instead
of running back to a
desktop screen. Sounds
great, until you try to
navigate Mr Pizza Man’s
online menu on your cell
phone’s tiny screen. By the
time you’ve thumb-typed or
stylus-tapped your way
through the dozens of
yummy options, you could
have ordered a hundred
pizzas the old-fashioned
way. Wouldn’t this all be
easier if you could talk to
your browser like it was the
pizza guy?

It certainly would, based
on a test drive of the Opera
browser for Windows,

Enter
CHAINING MELODY

Music Download Prices Set
To Rise
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which comes with built-in
voice support. At least in
the beta version, Opera’s
most useful voice-activated
features are the commands
that control the browser
itself. All you have to do is
plug in the USB headset—if
you have a laptop, you can
just use the inbuilt speaker
and microphone—and turn
on the voice feature in the
preferences panel.
Instantly, the browser
obeys commands.

“Opera, back!” and the
back button clicks. “Opera,
next link! Opera, open link!”
It all seems like a cute
gimmick at first, but as you
continue to use it, you will
surely find it easier to shout
at Opera to scroll up and
scroll down than to reach
over a whole two inches to
grab your mouse!

The browser itself is fast
and consistently crash-free.
The speech-recognition
software, which comes from
IBM, performed well even
with the stereo cranking a
couple of feet away, but
there are a few missing
features. You can’t speak
URLs into the browser yet. It
would also be nice if Opera
had a ‘search’ command—
shouting “Opera, search
Digit Magazine!” would look
for the phrase “Digit
Magazine” using your
default search engine.

Speech-driven computer
interfaces are nothing new,
but the Opera browser is
significant because it adds
support for a new mark-up
language called X+V. Short
for XHTML plus Voice, X+V
has been jointly developed
by IBM, Motorola, and

Opera. The language makes
it easy for Web designers to
hide special tags on their
sites that voice-enabled
browsers can both speak
and listen for.

GRAPHICS POWER 

ATI Paves
Way For Sub-
$50 Graphics
Cards

ATi has introduced a low-
end Radeon X-class

graphics card that utilises
the company’s AGP-like
HyperMemory technology
to save money by limiting
the on-board memory.

The Radeon X300 SE is
expected to ship in 128 MB
and 256 MB versions, of
which just 32 MB and 128
MB, respectively, consists of
on-card video memory. The
rest is taken from the host
system’s main memory
bank, accessed across the
PCI-Express bus.

Clearly, anyone who’s
chosen a PCI-Express
machine is likely to have a
more powerful graphics
card in any case, so ATi is
pitching the part primarily
against PCIe machines built
from integrated chipsets, in
particular Intel’s.

Integrated graphics core
are not only offering ever-
better performance, but
crucially, they’re grabbing a
bigger and bigger share of
the graphics chip market.
That’s why Intel’s graphics
market share dwarfs those

of ATi and nVidia even
though it doesn’t make
standalone desktop or
notebook graphics cores.

If it’s to win back share,
ATi has to offer a product
that’s significantly more
powerful yet not much
more expensive than the
‘free’ graphics sub-systems
in integrated chipsets.
Hence the X300 SE cards,
which ATi reckons will cost
consumers less than $59
(Rs 2560) a pop yet offers
around 60 per cent more
performance, when
measured using 3DMark 03
at 1024 x 768.

ATi also claimed its
product offered better
performance and a lower
price than arch-rival
nVidia’s competing
product, the GeForce 6200
with TurboCache.

Radeon X300 SE-derived
graphics cards will be

Nivedita Varadharajan, Tamil Nadu

Kushal Sharma, Rajasthan

The TRAI
The TRAI
slashed
broadband and
international
call rates by 71

per cent. Now, broadband
will be more affordable, and
calling your relatives abroad
will be cheaper. Three cheers
for the TRAI!

The IT Act
India’s outdated
Information
Technology (IT)
Act leads to
scripted ‘sting’
operations by television
channels, harassment of
people using cyber cafés, silly
arrests of CEOs of public Web
sites, and much more.

“As if darkness has descended on the

entire planet.”
“What I have been living for quite
some time now…” Sachin Sakpal, Mumbai

“Like Mumbai without localtrains.” Sushant Shetty, Mumbai
“A nasty nightmare come true.”

Sagar Patki, Navi Mumbai
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Security Watch
WORM_ELIPTER.D
The problem
March 13th,
Trend Micro
reported the
emergence of a
worm called WORM_ELIPTER.D,
which is a cause of concern for
users of peer-to-peer networks
such as KaZaA. The worm is in
the wild, and affects all
Windows platforms. It may
arrive via any of the following
P2P applications: BearShare,
Edonkey2000, Grokster, KaZaA,
KaZaA Lite, KMD, and
Morpheus. It drops a copy of
itself as the file ‘WWE Torrie And
Sable Screan Saver.exe’ in the
default shared folders of these
programs. The damage
potential of ELIPTER.D is
‘medium’.

Damages
This worm terminates processes
and modifies the HOSTS file to
prevent access to anti-virus and
security-related Web sites. It
also changes the Windows
registry to prevent users from
doing the following tasks:

Running programs through
Start>Run

Running Registry Editor
Running Task Manager 

In addition, the worm prevents
the execution of certain
applications. It also disables the
following:

Closing IE windows
File opening, saving, and

printing functionalities of IE
Notifications for new

Windows update components
and firewall- and antivirus-
related events

Precautions
There are several steps needed
to get rid of an infection. Refer
http://snipurl.com/deot.

One Silly Question

“Like a body without a heart.”

Life without a computer would be... ?
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Old versions, searching, and a directory

OOllddVVeerrssiioonn..ccoomm
“Because newer is not always better” is
the tagline of this site. Here, you can
find old versions of several programs-
Acrobat Reader, for example; you
might definitely prefer an older version
over the bloated new Adobe Reader 7.
The site has the old versions of several
programs—506 versions of 51
programs, to be precise. Sometimes
useful, sometimes for nostalgia’s sake.

SSqquuiirrrreellNNeett..ccoomm
Here is a site you’d do well to visit
before you begin researching a topic.
“Gather your Internet information
here,” as the site says. The site has
such topics as “SquirrelNet Users
Prefer Google Over Yahoo,” “Top 20
Search Engines,” and a “Simple and
concise guide to searching”.

EEnnccyybbeerrppeeddiiaa
This is a listing of useful sites across the
Internet. Very much like the Yahoo!
directory or other directories available
out there—but with a greater range and
elaboration of topics. For example, in the
Encyberpedia index, you have such
abstruse listings as ‘arbitration’,
‘cyberticket’, ‘deafness’, and so on-along
with regular, useful categories such as
‘English’ or ‘Dinosaurs’.

www.squirrelnet.com

www.encyberpedia.com

www.oldversion.com

available ‘soon’ from ATi
itself and third-parties,
including ABIT, Asus, MSI,
Sapphire, Tul, Gigabyte
and VisionTek.

PAPER ON THE SCREEN

Philips
Unrolls
‘Paper’
Display

Philips has announced
that it will start

developing rollable displays
in earnest. Until now, the
Dutch company only had a
working prototype.

Such displays are
projected to be the primary
solution to demand for
larger displays in mobile
devices: just pull the screen
out of a smart phone or
PDA and enjoy a movie. Or
read an electronic
newspaper that you can
roll up and put in your
pocket.

The Polymer Vision PV-
QML5Philips says that
current process and yield
improvements will enable

large scale production
within two years. The
newest five-inch PV-QML5
rollable display already has
a decreased radius of
curvature, improved
operational and
mechanical lifetime and
paper-like viewing contrast,
all improvements on the
world’s first rollable
display prototype
introduced by Philips’
Polymer Vision just over a
year ago.

A couple of specs for
display buffs: The Polymer
Vision PV-QML5 is an ultra-
thin (100µm) featherweight
QVGA (320 x 240 pixels)
active-matrix display with a
diagonal of five inches.
When not actively used, the
display can be rolled up into
a small housing with a
radius of curvature of less
than 7.5 mm.

With four grey levels,
the monochrome display
provides paper-like viewing
comfort with a high (10:1)
contrast ratio for reading-
intensive applications. Even
in bright daylight, the
display is easy to read. The
display, Philips claims,
consumes an exceptionally
low amount of power.

A Round-up Of Technology News From Across The GlobeThe Digital World

RUSSIA

Russia’s Communists are now considering a
propaganda device Lenin and Stalin never dreamed
of: SMS, known as ‘esemeski’ in Russia. At a party
plenary meeting outside Moscow that focused on
propaganda, first deputy chairman Ivan Melnikov said
the Communists should turn to methods such as
graffiti and mobile phone messaging.

UNITED STATES

Groundbreaking technology in GPS Internet
vehicle tracking is now being sold to the public.
The Millennium Plus Mobile Locating Unit (MLU)
uses cellular airwaves and GPS. Users can now
track and contact vehicles at any time via a Web
browser. If a car is stolen, an e-mail and/or a cell
phone call is issued immediately, and the owner
can disable the vehicle starter and lock the doors.

CHINA

In the first week of March, Chinese authorities
summoned managers of the mainland’s main
Internet providers, major portals and Internet café
chains, warning them against allowing “subversive
content” to appear online. This stern instruction is in
keeping with a trend toward assigning greater
responsibility to Internet providers to assist the
government and its army of as many as 50,000
Internet police.

SINGAPORE

According to a recent survey by the World Economic
Forum, Singapore made the most of technological
progress over the past year, while the US fell to No. 5
on the list. The survey evaluates such factors as the
quality of maths and science education, affordability
of phone connection charges and government
procurement of Information Technology.

BRAZIL

In a recent report by the Inter Press News Agency
(IPS), it was reported that Brazil just might be the
cyber-crime capital of the world. A surprisingly
large number of hackers are based in Brazil.
South Korea recently informed the Brazilian
authorities that over 5,000 Web sites in the
nation had been invaded by individuals
operating out of Brazil.

SOUTH AFRICA 

Three Incredibly Useful Sites

According to Africa’s cell phone operators, the life of
people who have never surfed the Internet could
change with the launch of third generation technology
they say will bring Internet access via mobile phones
to millions of the world’s poorest people. Sceptics,
though, say it will take years before villagers in places
such as Malawi surf the Web, due to the high prices of
handsets and poor infrastructure.
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RISING FROM THE ASHES

Retooled
Netscape
Back In The
Browser
Game

Netscape, the Web
browser out-muscled a

decade ago by Microsoft’s
Internet Explorer, has
undergone an extreme
makeover in an attempt to
regain its former relevance.

America Online, its
current owner, released a
trial version of Netscape 8.0
recently (browser.
netscape.com), which packs
some powerful security
features, but falls short on
speed and ease of use.

Among the useful
aspects of this test release of
Netscape 8.0 are tools for
assessing the trustworthi-
ness of Web sites and
managing passwords. You
can, for example, set a
‘super’ password granting
one-word access to various
Web sites; your many

different passwords can be
stored one time, managed
or changed easily, and
secured from others who
might use your computer.

The new Netscape is
based largely on the open-
source code for the
increasingly popular Firefox
browser, though Netscape
has a different design and
several functions that Firefox
doesn’t. Like Firefox,
Netscape 8.0 supports tabbed
browsing; unlike Firefox,
Netscape has an elaborate
new system for adjusting
security settings. It stores a
‘blacklist’ of Web sites
known to be dangerous on
the user’s computer and a
list of sites thought to be
trustworthy and updates
those lists regularly. The
browser displays a small red
check mark—and a large
security warning—when a
user visits a site on the
blacklist or if it detects
other security issues at a
site a user tries to call up.

Another difference is
that Netscape has added
Internet Explorer’s page-
rendering software under
the hood, as an alternative
viewing option. Since some
sites are written to display

in only IE (or aren’t tested
to see how they look in
other browsers), this gives
users the option of viewing
a site with the predominant
browser if it looks bad or
hangs up with Netscape.

Speaking of hanging up,
Netscape’s new browser
crashed twice during a
recent four-hour test.
Worse, it was painfully slow,
taking much longer than
Internet Explorer or Firefox
to render streamlined sites
such as Google News.

MMS ATTACK

MMS Virus
Discovered

The first mobile phone
virus capable of

replicating via MMS
messages has been
discovered. Commwarrior-A,
which targets Symbian
Series 60 phones, is not
spreading, but its ability to
propagate via Multimedia
Messaging Service messages
(MMS) worries some experts.

To date, phone viruses
have spread over Bluetooth—
so they were only capable of

affecting nearby phones. An
MMS virus could potentially
spread as quickly as an email
worm. Finnish anti-virus
firm F-Secure thinks the
virus may be from Russia
because it contains text that
says “OTMOP03KAM HET!”.
Which roughly translates to
“No to braindeads”!

CRIPPLEWARE OVERDUE

Windows XP
Starter
Edition In
June

AMicrosoft India official
said that the company

would launch Windows XP
Starter Edition, the
stripped-down version of
XP, with local language
capabilities in India by
June. It was initially slated
to be released in March. “It
is a little delayed and the
engineers are still sorting
out local language
features,” Microsoft India
director (business and
marketing operations)
Ranjivit Singh told

Pulse
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Last Month’s Winner!
No one was able to beat Digit’s
caption last month.

Send your captions to
beatthat@thinkdigit.com
and win the
Cricket 2004
full version
game worth
Rs 999 from
Gayatri Impex
Pvt Ltd

Every month, Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game!

Digit Caption
Can you hold? People want
to go home and make their
morning tea!
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reporters in Bangalore at
the launch of its Web
conferencing and
enterprise IM service in
India. “We can’t
underestimate the huge
development effort
involved in providing
language functions. OEMs
should start offering it in
June,” he said. Microsoft
has already launched
Windows starter in
Malaysia, Thailand and
Indonesia.

XP Starter Edition, to be

priced far cheaper than XP
Home and Professional,
will be rolled out first in
Hindi and “will be quickly
introduced in 10 other
Indian languages,” Singh
said. He said Microsoft had
already worked out details
with computer
manufacturers such as HP
and IBM on the price of the
software, which will be
bundled with PCs.
Microsoft eventually plans
to work with local
assemblers.

BEAM, DON’T SWIPE

Mobile
Phones As
Credit Cards

Now, a software/hardware
combination can let

consumers in India use their
cell phones as credit cards.

Customers simply aim their
cell phone at the payment

counter, and their purchase
is charged to their account.
The move has excited
interest in cell phone circles
because it is perceived as
‘high-tech’ and innovative,
and also has considerable
utilitarian appeal. 

Standard Chartered and
Visa have launched the
service, called m-Wallet, in
Mumbai and Bangalore. 

Murali M Natrajan, head
of consumer banking, India
and Nepal, Standard
Chartered, said, “The launch
of the m-Wallet makes us
pioneers in ushering mobile
commerce in India.”

How it works is, your
credit card information is
downloaded to your
Infrared-capable mobile
phone. When you are done
purchasing, you need to
stand near the payment
terminal—a standard
terminal, with added IR
capability—and your credit
card information gets
beamed across.

Users need to first
download a Java midlet onto
their phones, which does the
work of handling security
and communication with
the terminal.

Paying this way is a
good thing. First off, you
don’t need to carry your
credit cards around and
worry about them getting
lost—it’s a lot harder to

lose your phone than your
credit card. Second, if your
phone does get stolen, it
cannot be used for
payments unless your PIN
is keyed in. Another
advantage is that the
receipt gets stored on your
mobile, so you don’t have
to worry about lost bills.

The problem, of course,
is that not too many
retailers have IR-enabled
payment counters.

PIRATES TO BE ‘TOLD OFF’

Invention To
Turn Off
Music
Pirates

Up until now, we have
seen copy protected

music CDs and Digital
Rights Management attempt
to stop unauthorised
copying of music files (or
CD ripping). Now, a pair of
New York inventors believe
they can thwart music
pirates by secretly burying
an anti-piracy warning in a
track, which is disinterred if
the copyright has been
abused, New Scientist reports.

With help from the US
Air Force Research
Laboratory, the inventors,
Mark Bocko and Zeljko
Ignjatovic, professors of
electrical engineering,
found they could bury
around 20 Kb of speech
data in a song without
affecting how it sounds.
The speech data, which is
the warning—for instance,
a voice from a record
company boss, berating the
user for piracy—exploits
the fact that the tones of a
musical instrument
consist of a complex

GENDER 

BENDERS

Uneasy at the beginning, Rita’s confidence increases with each
successive click. She accesses the Control Panel from the Start
Menu and soon enough, clicks on the ‘Regional and Language
Options’ icon. The dialog box pops open and displays ‘Regional
Options’, ‘Languages’ and ‘Advanced’. Rita clicks ‘Languages’
and then ‘Advanced’, but to no avail. She comes back to
‘Regional Options’ and spots the drop-down box that lists 
100-odd languages. Just in time to be first! 

Rita Aiyar vs Yash Mody
Changing The Default Language
On The Computer

1 min
55 sec

2 min
05 sec

Yash maintains his composure. He clicks ‘My Computer’ and
opens the Control Panel. Hesitantly, he clicks the ‘Fonts’
option, and spends almost a minute in a fruitless search. He
returns to Control Panel, and finally spots the ‘Regional and
Language Options’ icon. By the powers that be, he follows the
same path as Rita—wastes time on ‘Languages’ and ‘Advanced’
before he spots the drop-down box and heaves a sigh of relief! 

There’s a lot of buzz going on about IE7, the
latest version of Internet Explorer, slated for

a beta release this summer. As it says on the
Microsoft Internet Explorer Weblog, developers
have gotten a clear message from users that
SP2 is a good thing, and that they want more
security—in the browser.

Some details about IE7 have emerged, and if the
rumours are true, it will have tabbed browsing, an
inbuilt news aggregator, and will be integrated
with Microsoft’s anti-spyware product. Other fea-
tures include no cross-domain scripting and/or
scripting access, an improved SSL user interface,
and simpler printing from within the browser.

Internet Explorer 7.0
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pattern of randomly-
phased harmonics. Bocko
and Ignjatovic tweaked a
few harmonics to shift out
of the pattern and then
used those shifts to convey
a 20-kilobit speech message.

Their patented idea is to
incorporate a software
decoder in file-sharing
applications which
encourage mass copying
and are the bane of the
music industry.

The decoder would
detect the telltale phase
shifts and convert them
into the warning message,
causing them to boom out
through loudspeakers or
headphones, New Scientist
reports.

For legitimate listeners,
the digital shifts are so
small that there is no
difference in the
perception of the music.
This may not always be the
case, though—there is
speculation that tracks
might skip at the point of
insertion of the message. 

Earlier attempts by

researchers to bury anti-
piracy signals in
copyrighted music and
films have run into
countermeasures by
hackers, who filter out the
message. Earlier attempts
also almost always resulted
in compatibility problems
with players—the track
would either skip, or not
play at all.

GIMME THE MEGAPIXELS!

Digicams A
Must-buy
For 2005

Arecent poll by GMI
(Global Market Insite,

Inc, headquartered in
Washington state, USA)
focusing on new personal
technology purchasing
patterns revealed that new
technology’s appeal is
strong worldwide. The
GMIPoll
(www.gmipoll.com), which
surveyed 20,000 consumers
in 20 countries, found that
59 per cent have a need for
more technology.

In all countries except
for the US, the PC has
overtaken TV as the one
technology that people
cannot live without. The
GMIPoll found that 75 per
cent of consumers ranked

their PC as their must-have
technology, compared to 67
per cent for TV, and the
mobile phone came in a
close third with 54 per cent.

Looking at what new
technology consumers are
most likely to purchase in
2005, overall the GMIPoll
found that digital cameras
came out tops, with nearly
40 per cent choosing digital
cameras over wireless,

home printing and DVR
technology.

Asked what technology
they most frequently
upgrade, 63 per cent cited
mobile phones. The
readiness to upgrade one’s
mobile phone seems
strongest in Asia and South
America. Almost 75 per cent
of consumers in India and
China said they upgraded
their phone more often
than any other technology.

The survey suggests that
in the West, word of mouth
is the biggest influence on
customers’ purchasing
choices. But in the fastest-
growing economies of Asia,
such as India and China,
advertising came in as the
number one influencer,
with 70 per cent citing it.

BLOGGING CUM SOCIAL
NETWORKING

Yahoo!
Launches
New Service

Yahoo! has introduced a
new service that blends

several of its site’s popular
features with two of the
Internet’s fastest growing
activities—blogging and
social networking. The
hybrid service, called
‘Yahoo 360’, was launched
March 29. Yahoo! has been
Yahoo is testing the service
with a small group of
employees, some of whom
have been working on the
project since last year.

The service is designed
to enable Yahoo’s users to
pull content from the Web
site’s discussion groups,
online photo albums and
review sections, and plug
them into their own blogs.
Yahoo! will also make it
easy for the service’s users
to connect with others who
share common interests and
friends—the practice known
as social networking. 

Compiled by Aditya Kuber,
Ahmed Shaikh,

Meera Vankipuram,
Preethi Chamikutty, 

Ram Mohan Rao 
and Renuka Rane 

What is a 3G phone?
A 3G phone is one that can
use 3G networks. 3G is an
abbreviation for ‘third
generation cellular
technology’, the ‘first
generation’ having been
analogue cellular, and the
‘second generation’ being
today’s digital cellular
networks. 3G supports very
high-speed data services over
a cellular network. In fact,
multimedia 3G networks
transmit wireless data up to 2
Mbps. 3G mobile phones offer
high-speed Internet
connectivity using Universal
Mobile Telecommunications
System—the technology of
choice for third-generation
wireless service delivery.
Why do we need 3G phones?
3G will support bandwidth-
hungry applications such as
full-motion video, video-
conferencing and full Internet
access.
Where has 3G been
deployed?
3G has been deployed in all the
developed nations, as well as
in Pakistan, Vietnam, Thailand,
and several other countries.
India is still awaiting the TRAI’s
recommendations on 3G.
Who was responsible for the
development of 3G?
3G is an initiative of the
International
Telecommunications Union
(ITU). The World
Administrative Conference
(WAC) assigned 230 MHz of
spectrum at 2 GHz for
multimedia 3G networks.
When did 3G first appear on
the scene?
3G network trials started in
Japan in 2001.
How do 3G-enabled devices
operate?
3G-enabled devices send and
receive radio signals to and
from base stations. The base
stations are low-power radio
transmitters—each providing
coverage to a cell. Cells need
to overlap to enable
seamless coverage.
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Tomorrow

The Smart Life

M

Technology is pervasive, but has not integrated with our lives—yet. What would it be like
when every aspect of daily life is technology-driven? We give you a glimpse...

In Your Car
On your way home from work, you receive
an MMS from your significant other.
There’s grocery shopping to be done!

“Don’t forget to buy sugar, milk and
that stationery I mentioned earlier,” says
the message.

Your car’s LCD display plays back the
video message, uses primitive AI to under-
stand keywords such as ‘buy’, ‘sugar’,
‘milk’, and ‘stationery’. It then automati-
cally charts the ideal route to the nearest
and cheapest supermarket where all the
items on the list are available.

Payment
Once you have picked up all the necessary
items, you head to an automated, tag-reading
checkout counter. 

The total is beamed to your
WiMAX-enabled watch, which con-
nects to your bank account, veri-
fies that you have sufficient
funds, and then makes a secure
wireless payment.

Illustrations Shyam Sriram
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Photography And Imaging
On your way home, you see an interesting adver-
tisement. With a click of a button on your spec-
tacles, you capture an image of exactly what you
are seeing. The image is sent to your watch, which
OCRs the image, extracts the contact details and
saves it in your address book.

Communications
Just as you are exiting the supermarket, your wrist begins
to tingle—your watch shows you that your spouse is calling.
You say “accept call”, and the call is patched to your WiFi-
enabled spectacles. You assure her that you have not for-
gotten anything, only because technology wouldn’t let
you—the stupid watch kept sending reminders in that silly
robotic voice to your spectacles’ earpiece, informing you
that the stationery department was the nearest to your cur-
rent location, and was a priority.

Once you are
done with the
call, you tap your
wristwatch face

to end the call.

Global Positioning
Using WiMAX, your car contacts your home and
informs it that you are just 10 minutes away.

Your house sends a notification (like an
MSN Messenger popup) to your spouse who is
watching a cooking show, and your kids, who
are playing a game on their portable 60-inch
wireless LCD. 

The kids inform the robot helpers to start
clearing their room, while
your spouse decides to start
preparing dinner.
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Intelligent Devices
Your wife clicks a button on the TV to save a few
recipes that were shown on the cooking show. The
TV communicates with the fridge to tell it the ingre-
dients of the recipes. The fridge informs you, via its
LCD display, that you only have the requisite ingre-
dients for three of the recipes.

The fridge also offers useful information, such
as how many times in the past year the three recipes
have been prepared, and how much each was liked
by the individual members of the family—by
requesting the dishwasher to provide data on how
much each family member
wasted, etc.

Your spouse
chooses the dish
that hasn’t been
prepared for the
longest period, so as
to keep the menu
fresh, and starts to
make dinner.

Gaming
The family sits down to have dinner, but kids
will be kids. They have wirelessly transferred
all their game data from their console to hand-
held gaming devices. No longer are games plat-
form- dependent, and all game data can be
transferred from any gaming device to another.

Needless to say, this is one technology
enhancement that your spouse is not pleased
with! A few yells and some threatening remarks
involving a ban on gaming devices and a year’s
pocket money later, dinner is a little more
orderly and peaceful.

RFID
Once dinner is done, you decide to request a classic
movie from your favourite digital movie-on-demand
channel provider—the family’s favourite pastime. How-
ever, it’s very hard to do so without the remote. Sigh!
The kids again. Funny how they can remember how you
promised to take them on a camping trip a few years
ago, but can’t remember what they did with a remote
that they were using less than an hour ago.

Time to ask good old house find it. You log into the
house’s control panel, it authenticates you using a
retina scan and voice recognition, and then promptly
answers your ques-
tion. It shows you a
graphical representa-
tion of where the
remote is—dropped
and then perhaps
kicked under the sofa.
How do the kids
manage such feats?
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Data Syncing
As you head off to sleep, you place your watch in its
cradle, where it is charged and transfers all newly
recorded data, such as contact information and updated
schedules, to the house computer. This will help the house
decide what time to wake you tomorrow and also what
you might need for work.

The kids, meanwhile, have carried the wireless LCD
into their room, and are continuing their game from
where they left off. You tell the house to cut off power
supply and connectivity to the LCD in half an hour and go
off to sleep; your kids mutter their disapproval, but value
their allowances too much to actually complain.

Security
While the neighbourhood sleeps, your house is on full
alert. A passing police car broadcasts its encrypted ID,
which your house recognises as the trusted neighbour-
hood watch, and sends the patrol car the all-clear
signal. The neighbouring houses do the same.
Life is just too hard for burglars, espe-
cially after physical money was
stopped—everything’s electronic now.

The Technologies
Wireless: Everything uses WiFi or WiMAX
to communicate—with high security
and encryption.
Tracking: Everything has an ID and can be
tracked or traced easily.
Storage: No gadget needs a sizeable hard
disk anymore. All devices can share each
others’ storage as well as centralised storage.
Bandwidth: With advancements in wireless
technologies, there is no more bandwidth
crunch and no more messy cable laying; band-
width is cheap.
AI: Artificial Intelligence is limited, but capable of han-
dling mundane tasks, and is self-learning.
Networks: Networks are global and ad hoc, but secured
with high encryption.

ahmed_shaikh@thinkdigit.com
robert_smith@thinkdigit.com

Smart Homes
While your family is enjoying the movie, your house
automatically switches into your predefined ‘Movie
Mode’. It automatically lowers the ambient lighting by
70 per cent, rejects all phone calls from numbers of less
than ‘Level Three’ importance, and turns off all com-
munication notifications to your family.

This level also has increased security, as all mem-
bers of the family are engrossed. Doors and windows

are locked automatically,
and the security alarm is
activated to prevent unau-
thorised entry to the house
or garage.
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Take a Crack 
and Win
Webster’s New World
Computer Dictionary
By Bryan Pfaffenberger
Published by 
IDG Books India (P) Ltd

WINNER
Debangshu Sen.
Radhanagar Road, West Bengal

Rules and Regulations
Readers are requested to send

in their answers by the 15th of the
month of publication.

Employees of Jasubhai
Digital Media and their relatives
are not permitted to participate
in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any damage
to your system that may be
caused while you are solving
the problem.

Remember, using
third-party utilities is
not allowed. If you
still think you can
remove the Security,
Connections and
Advanced tabs from
the Internet Options
dialog box, write in to
us at takeacrack@
thinkdigit.com with
your solution

Three-step Process

First, design an appropriate
bitmap and save it in the
“C:\Documents and
Settings\All
Users\Application Data”
directory as LogoName.BMP.
Use the 8.3 naming
convention.

Since the Application
Data directory is a hidden
directory, you may need to
unhide it by opening
Windows Explorer and
going to Tools > Folder
Options, click on the View
tab and check the 'Show
hidden files and folders'
option. Click on Apply and
then on OK. 

Next, open the registry
editor by going to Start >
Run, typing “regedit” and
pressing [Enter]. Navigate to
the key “HKEY_USERS
\.DEFAULT\Control
Panel\Desktop”. In the
right pane, double-click on
the string called
“Wallpaper”. Under ‘Value
Data’ enter the full path to
your bitmap image—for
example, “C:\Documents

and Settings\All
Users\
Application Data
\LogoName. BMP”.

Now double-
click on the string
called
“TileWallpaper”,
and change the
value according to
your preference—
the value ‘0’ will
not tile the
image, while the
value ‘1’ will tile
it. Next, double-
click on the
string called
“Wallpaper Style”
and change the
value according
to your choice;
here the value ‘0’
is normal, while
the value ‘2’ will
stretch the image
to fit the screen.

If you don't
want to tile or
stretch your
wallpaper, and would
rather choose its position
on the screen, you will
need to create two new data

strings in this
same registry
directory.
When at “HKEY
_USERS
\.DEFAULT
\Control
Panel\
Desktop”,
right-click on
the right pane
and select New

> String Value. Name the
string “WallpaperOriginX”
and set the value to the
number of pixels from the
left edge of the screen that
you want the picture to be
located. Now, create
another String Value, call it
“WallpaperOriginY” and set
its value to the number of
pixels from the top of the
screen. 

Close the Registry
Editor, and reboot your
machine to see your
handiwork.

Remove the
Internet Options
tabs for Security,
Connections and
Advanced

THIS MONTH’S CHALLENGE

Displaying Your Company Logo Before The Windows XP Login ScreenLAST MONTH’S CHALLENGE

Win!

Set your logo using Regedit

The logo is displayed before the logon screen
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Digital cameras are fast replacing their
film-based cousins. Digicams have quick-
ened the process of clicking and viewing

images, and their costs have also come down
substantially. This southward trend continues
as newer and better cameras flood the market.
All this has made the digital camera the instru-
ment of choice for amateur photographers.

What Goes Into The Making?
Though it’s physically smaller than many
other computer peripherals, the digital cam-
era is not a simple piece of technology. From
the lens and sensor processor, to the memory,
and finally the storage device, everything
works in sync. The final result is there for you
to see on the LCD screen within a matter of
seconds. Here, we go a little deeper into each
of these components to see how their func-
tions affect the overall quality of the camera—
and that of your pictures.

The Lens
The lens is the eye of any camera. It is what
focuses the image and projects it onto the sen-
sor, which in turn captures it. Image quality,
therefore, depends on the quality of the lens.

Digital cameras come with either a fixed
focus lens or a zoom lens. A fixed focus lens
doesn’t give you the option to zoom in on
distant objects. A zoom lens, on the other hand,
can zoom in on objects depending on the opti-
cal zoom capacity of the lens. Therefore, if you
are planning to buy a camera for outdoor shots,
especially landscape photography, it is advis-
able to opt for a model that has at least 5x
optical zoom.

Nature photography enthusiasts need to pay
attention to the macro focus range of the
camera. A smaller macro distance will enable
you to move closer to the object. Digital
cameras also have a digital zoom option, which
is nothing but software interpolation of an
image. They do this by cropping the central part
of the image and reducing its resolution, thus
making it appear as if it’s been zoomed into.

Your guide to
what makes
those digicams
click—literally!

Behind The Lens

Im
aging Atul D

eshm
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However, the quality of the image suffers heav-
ily because of this reduced resolution.

Sensor
The sensor’s function is to capture the light
coming in through the lens. This information,
which is in the form of light, is converted into
a digital signal and forwarded to the processor
for reconstruction. A high-quality sensor will
reproduce a crisp image.

Sensors are of two types: CMOS (Compli-
mentary Metal Oxide Semiconductor) and CCD
(Charge Coupled Device). Low-cost CMOS
sensors are found in low-end cameras. CCDs, on
the other hand, are found in most mid-level to
prosumer-class cameras. CCDs offer better
image quality, but at the same time, are expen-
sive to manufacture. CMOS is cheaper to
produce, consumes lesser power, and current
improvements in quality have helped it find a
place in high-end digital SLR cameras such as
the Canon 350D. 

The Processing Engine
The camera’s processor gets its information
from the sensor and starts reconstructing the
image. Here, speed is of prime importance, you
wouldn’t like to sit idle for a full minute while
your processor crunches numbers. The start-up
time and time interval (cycle time) between
two shots depends on the processing engine.
Cameras such as the Sony DSC-P100 boot up
very quickly, and you don’t have to wait long

after clicking one pic to click the next. The
Canon IXUS400, with its DIGIC processor, is
another camera with a low cycle time.
Cameras with a low cycle time are easy to use
when images have to be captured in quick suc-
cession, for instance, in wildlife photography.

Memory
The small pieces of plastic that store captured
images are called memory cards. The speed at
which an image is stored depends on the
card’s read-write speed. Thus, a card with a
fast write speed reduces the time interval
required between two shots, and a lower read
time means faster image transfer to a PC.
MultiMedia Card (MMC), SecureDigital (SD),
Compact Flash (CF), xD-Picture card and
MemoryStick Pro are some of the widely-used
memory card formats. SD cards have one
advantage over the others: they are compatible
with MMC. Many models, such as the HP
Photosmart R707 and the Samsung V5,
support both formats.

An important point to note, however, is that
the camera writes the data onto the memory
card at a certain speed, say 12x. Thus a faster
card, with a faster write speed—say 40x—need
not mean improved performance if the camera
cannot handle it.

The Interface
USB is the interface of choice for digital cam-
eras. The newer generation cameras come with

Cameras with a
low cycle time
are easy to use
when images
have to be
captured in quick
succession, for
instance, in
wildlife
photography

1/2 PG AD
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the faster USB2.0 interface, which can transfer
data at a maximum speed of 480 Mbps. Of
course, to take advantage of this, you need a
USB2.0-compatible PC. Digital cameras also
come with the A/V port, using which one can
view images on a television set.

Usability Does Matter
Since most low-end digital cameras come with
some level of manual override, getting to any
feature using the menu needs to be easy. As you
move towards better cameras, the complexities
increase. High-end cameras have more features
and manual overrides. This in turn means a
deeper and more complex menu structure.
Navigating through such a menu can be a prob-
lem if it is not well laid out. The problem gets
compounded if the buttons aren’t placed intu-
itively. Therefore, while checking the other
aspects of a camera such as the megapixel
count, number of flash modes etc, make sure
that the menu is easy to navigate and buttons
are easily accessible.

Kodak cameras have menus with the easiest
navigation. Every feature is neatly arranged and
the sub-menus are just a few clicks away. Also, the
menu is standardised for all their cam-
eras, so an upgrade from a low-end
camera to a higher-end one is easy.

Sony, on the other hand, has a
cumbersome menu with tiny
captions, which takes a while
getting used to. One needs to
remember that a  compact
camera will have tiny
buttons, and menu navi-
gation will therefore
get a little tedious.

What Size And
Shape Suits
You?
With the reduction
in size, the form fac-
tor of a digital cam-
era has also changed.
If you take a look at
the current genera-
tion of digital cam-
eras, you will notice
that they are not
plain boxes with a flash and a shutter button.
Nowadays, you have ergonomically-designed
cameras such as the Sony DSC-P100, and the
Exilim from Casio, which is thin and fits snug-
ly in your pocket. Even heavy-duty, perform-
ance-oriented cameras such as the Kodak 6490
with 10X optical zoom have extremely com-
pact bodies, and are not very heavy. 

The digital camera, however, is not devoid
of its share of problems—first and foremost,

storage capacity and battery life. Most cameras
come with very little memory—usually 8 to 16
MB. This makes it difficult for shutterbugs, as
a 16 MB card cannot hold more than 20 images
taken at a 3-megapixel resolution. So, if you are
planning on an extensive outdoor shoot, it is
advisable to spend some extra money and get
a 512 MB memory card. 

Battery life is another major area of
concern: if the camera has a regular Li-Ion
battery, you need to purchase at least one extra
battery pack. But this is not going to help you
much if you are on vacation and do not have a
power source to recharge your batteries. If your
camera runs on regular batteries, you can carry
as many extra batteries as possible. This,
however, will prove expensive in the long run. 

The Current Market
The grey market is still the market of choice
for most digital camera buyers in India. The
obvious reason for this is price. 

The Nikon Coolpix 5100 is the best example
of the price difference. The camera, if
purchased from an authorised dealer, would
set you back by Rs 20,800—but is available for
just Rs 11,750 in the grey market. On one lead-
ing online site, the same model is priced even
lower—at Rs 10,500. The HP Photosmart, which
we tested in October 2004, had an official 
price tag of Rs 29,990, and the grey market
price is Rs 14,000.

Companies such as Kodak, however, 
sell their cameras at competitive prices,
making it difficult to find their models in the
grey market. 

With big brands such as Sony, Canon and
HP having already set up shop in the country,
and with duties on electronic goods decreasing
after every Budget, it makes sense to buy a
genuine product from an authorised distribu-
tor. This gets you a warranty, which takes care
of any damage to your camera within the
warranty period, and even a replacement if
there is any serious flaw in your camera.

Companies have also come up with innova-
tive ways to wean the consumer off the grey
market. For instance, Sony sends a representative
to your house to walk you through the various
features of the camera. This service is, however,
limited to only a few cities. Then there’s also
Kodak, which has a toll free number to help you
arrange for a professional photographer.

The price factor is still very important in
India, than in some other countries—so how the
‘white’ market fares vis-a-vis the grey market
remains to be seen. 

aliasgar_pardawala@thinkdigit.com

Vendors’ Contact Numbers
Sony India Ltd: 1600 1111 88
Kodak: 1600 2249 49
Canon: 39010101
HP: 1600 447 737

Digital Camera Type
3-megapixel
4-megapixel
5-megapixel
6-megapixel

16 MB
13
8
6
5

32 MB
26
16
12
10

64 MB
53
32
25
20

128 MB
106
64
51
40

256 MB
213
128
102
80

512 MB
426
256 
204
160

1 GB
853
512
409
320

Memory Capacity

Table explaining number of images that can be stored by different size media when used with different
megapixel cameras 

An inside view of a standard digital camera
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Dial V for Video—with
a 1.3 MP camera, the
Sony Ericsson V800
shoots to thrill

Camera phones are so been there, done that:
remove phone, aim, click, show. Yawn… But

hey, what’s this? A video phone, eh? With a
video camcorder, an MPEG4 video player, and
what’s that, video telephony!? You mean I
could video conference with another V800 user
with just a press of this button?

The camera, the shiny heart of this beast,
nestles on the hinge; it can do much—twist
around for one. So taking those vanity shots is
oh-so-easy! While the 4X digital zoom is nothing
novel, the panorama mode will let you combine
three overlapping pictures into one larger
picture. Being MMS-enabled, it allows you to
share your video-pictures-sounds-fancy-text
creation with others.

Playing video and audio is passé; this baby
gets you live audio and video streams.
Additional memory is a must for any phone that
can record and play MP3 files, a need that is

fulfilled by the Memory Stick Duo support that
the V800 lends—as much as 1 GB. 

You can also play 3D Java games on this
phone, complete with force feedback and
multiplayer support via Bluetooth. The
multitasking feature lets you upload images
while telling your friends about it. 

We could point out its other features—tri-
band, GSM/GPRS, inbuilt modem, Web browser
etc,  but that would be so been there, done that…

APRIL 2005 DIGIT 34

Imaging Sivalal S

Sony Ericsson V800



The Mac mini

Digital Passion l 30 hours with...

Day 1, 10:00 am; Hello, Hello It’s so small! I have used bigger modems! I connectedthe mini to a 23-inch BenQ LCD. Connect the networkport, a mouse, and an Apple keyboard, press thepower button and we are in OSX land. Time taken toreboot—60 seconds. Ah, look, a blinking LED!
10:15 am; The OS
I wanted to push this little box to its 256 MB limits, sothe first thing I did was turn on all the eye-candy. Iwas pleased by how OSX would instantly reflect anychange to its settings—no need to click on Apply andtwiddle your fingers. Also noteworthy was the use ofanimation to grab attention: icons on the dock wouldjump up and down eagerly, demanding to be clicked.Getting on the local network was easy, as wassharing files with Windows and Linux. Getting on theInternet was similarly painless.

2:00 pm; Installing ApplicationsI installed Opera just by dragging the file to the

“Applications” folder; then, with a simple click, I addedit to the dock. I now had Opera, six MSN Messengerwindows, and three Safari windows open. OSX pantedto keep up.

3:00 pm; Pushing It
As I type this, I am importing 53 high-resolutionimages from a camera while updating OSX; I alsohave two Safari windows, 13 MSN Messengerwindows, four Opera tabs, iCal, iPhoto, iMovie, asystem profiler, and a text editor open. OSX ishectically caching to the mini’s tiny hard disk, andthe little bugger is actually keeping up.

4:15 pm; Integration
Everything is well integrated, with a uniform interfaceand minimal surprises. iPhoto and iMovie are bothvery good at what they do—and what they do is morethan sufficient for a general user like myself.

6:00 pm; Bugs
Add third-party software and things begin to breakapart. Opera, for example, did not inherit the system-wide “spell check” umbrella; the quality of font smooth-ing, drag-and-drop of text and a consistent look and feelwere other casualties. Oh well, tomorrow is another day!

Day Two, 10:30 am; IrritantsNo tool tips on icons and files, the [End] key ismissing, [Delete] does a backspace, pressing [Enter]renames a file, and AppleWorks needs a lot of work.
5:00 pm; A Sad FarewellThe mini is returned to its rightful owners. OSX isbeautiful—both to behold and to work with. The minibolsters the software with able hardware. Add the iLife‘05 suite and the mini turns into a very temptinginvestment. If only the Geeks at Apple would sacrificeRs 10,000 off the mini’s price, I would gladly drag thisTrojan in, blinking LED and all.

ahmed_shaikh@thinkdigit.com

Ahmed Shaikh

When I first heard about the Trojan War, I could not believe the stupidity of a people who would drag a

wooden horse, the size of a building, and created by their enemy, inside their erstwhile safe haven. Did they

think it was filled with chocolate?Much later, I read Steve Jobs proclaim the superiority of software to hardware. It was a good sermon: user

experience is nine-tenths software, I sagely nodded. Finally, a seldom-used part of my brain connected two disparate dots—what if you wrapped your OS in a tiny,

sleek package, adorned it with a blinking LED and christened it the “mini”? Would this Trojan succeed in

injecting OSX inside my safe, Windows haven? And all that in just 30 hours?



Special  Advert is ing Sect ion

Many of the technology tools used by small and midsized businesses
today are solutions that companies wouldn’t consider conducting busi-
ness without. From PCs and e-mail to imaging and printing devices, all are
integral parts of the daily workflow that IT professionals rely on to help
employees be more productive, and businesses in general need to be
more efficient.

What about color? Color imaging and printing, to be precise. You’ve
probably heard a lot about color, and all of the benefits that it can bring
to a business. Like some, however, you may be thinking that color is dif-
ficult to manage and maintain, as well as costly and slow—even a non-
essential luxury that, in times of tight tech budgets, is tough to justify.

THE BUSINESSVALUE OF

COLOR
Today’s color imaging and printing devices are easier to use and more cost effective than you

may realize. They’re helping IT professionals and business executives around the world to
make a bigger impact and become more successful.
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For Milestone Architectural
Ornamentation, color means cost-effective,
customized, highly professional marketing
collateral that’s helped the company build
its reputation worldwide and increase
sales. Based in Amarillo, Texas, Milestone
is an expert manufacturer of reproductions
of ancient antiquities. The company has
mastered its market, and it has done so by
concentrating on the needs of its cus-
tomers.

Early on, however, Milestone found it
needed to stand out in the crowd. Like
many companies, Milestone had a great
product, but was faced with several daunt-
ing business challenges that are common
to companies around the world. To suc-
ceed, it needed to make a big impact with
current and future customers.

In the words of Milestone CEO Melody
Brenna, “We were a little company with a
totally new product, and we didn’t have the
sales volume or funding to hire an adver-
tising agency. In our business, everything is
ultimately visual. We have to be able to por-
tray to a client exactly what the end project
will look like to pique their interest and win
the business.”

The means to that end was color. And
today, it’s easier to use, more readily avail-
able and more cost effective than you may
realize.

ENABLING SUCCESS
WITH COLOR
Using color came naturally to Milestone,
which relies so heavily on the visual appeal
of its products. Like many businesses, it
started producing its own marketing mate-
rials in-house as a way to reduce costs,
increase contract closure percentages and
boost quality control.

To make the most of these internal
capabilities, it enlisted the help of HP print-
ing solutions. Milestone started using HP
printers for two basic reasons: ease of
access to the hardware and supplies, and
low price combined with high-quality
results.

In addition to four HP Business Inkjet
1100 series printers, the firm’s principal
graphic designer Jay Ferranti uses an HP
Photosmart printer for professional-quality
photos in eight-color or black and white.
The Photosmart printer that Ferranti uses
allows direct photo printing from a digital
camera, which Ferranti describes as highly
useful in the brochure design process.
Milestone also relies on an HP Designjet

large-format printer for line drawings, pre-
sentations and signs.

Printers are not the only HP products in
use at Milestone. The company also uses
HP supplies—including ink, paper and spe-
cial media—because the printers and the
supplies work together as a system to pro-
duce exceptional results.

“We’re a very small company, but with
the professional look of our proposals and
posters that we print in-house, we look
huge, and HP has given us that capability,”
says Milestone CEO Brenna. “The consis-
tent quality and flexibility of our HP printers
not only makes it possible for us to com-
pete against much larger companies, it
enables us to succeed.”

CONNECTING 
WITH COLOR
The natural connection that Milestone
made between “visual” and “color” is
increasingly being made by organizations
around the world that are seeking to opti-
mize sometimes limited exposure to mar-
ketplace opportunities.

Usage of color in business documents
such as presentations, sales collateral
and marketing brochures, for example,
bridges the gap between concept and com-
prehension. It connects and persuades its
audience. Black and white, by comparison,
is valuable in a different way—it conveys
content accurately, and it provides the
informational infrastructure. Color creates
lasting impressions and appeals to the
powerful sense of vision.

“Color is the easiest and most effective
way to increase the clarity of a document,”
points out Robert McCullough, president of
McCullough Research, in “The Definitive
Guide to Office Color Printing” (real-
timepublishers.com, 2004).

The guide further claims that color com-
munications can improve comprehension
by 75 percent over black-and-white com-
munications. That’s a powerful, enabling
message to small and midsize businesses
that are trying to carve out market share—

on any continent or in any country. So by
using color in customer-facing materials,
sales and marketing employees, for exam-
ple, may increase their chances for suc-
cess with potential customers. Color is the
great equalizer, and color technology—par-
ticularly color imaging and printing—is the
vehicle for that equality.

Given the increasing business value of
color, it’s not surprising that the market for
color laser printers is taking off. And the
good news for buyers is that growing popu-
larity is driving affordability and features.
According to analysts at Lyra Research,
color laser printers priced under $1,000
will account for 56 percent of total color
laser printer shipments worldwide by 2008
(“Color Laser Printers: Worldwide Market
Forecast and Analysis,” August 2004). Lyra
further predicts that by 2008, 10-23 ppm
(page per minute) color laser printers will
replace 1-9 ppm units as the dominant
devices shipped.

DEBUNKING 
COLOR MYTHS
Despite numerous advantages, color imag-
ing and printing devices may still be below
the cut line on some companies’ IT-budget-
expenditure priority lists. Given the history,
this view is a bit more understandable. At
the high end, the output was good, but the
devices were expensive and complex, and
therefore out of reach for the average
small business. At the other end of the
spectrum, personal color devices also pro-
duced good output, but weren’t designed
for office use.

Indeed, why should an IT professional
keeping a watchful eye on the budget make
the commitment to color under those cir-
cumstances? The truth is that those cir-
cumstances have changed significantly.
Color has become fast, affordable and
practical—as well as easy to use and more
reliable.

SPEED
In the past, all color laser printers

COLOR SUCCESS STORY
■ Company: Milestone Architectural Ornamentation, Amarillo, Texas
■ Challenges: Create professional marketing collateral and proposals cost-effec-

tively, customize proposals, print top-quality color and monochrome photos.
■ Solution: HP Business Inkjet 1100 printers,HP Photosmart printers,HP media.
■ Results: Individualized proposals create client trust in company’s work. Eighty-

five percent success rate winning business with customized packages.
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employed four-pass printing, which meant
that colors were applied to the paper indi-
vidually, one after the other. As a result,
printers were faster when printing black
and white because with black and white
printing, it is only necessary to apply the
black. Thanks to technology advances,
four-pass color laser printing is being sup-
planted by single-pass technology, in which
all four colors are laid down simultane-
ously.

Now, it’s possible to purchase color
laser printers from HP that print up to 24
pages per minute in color. Inkjet printers
have also benefited from advances in tech-
nology—models from HP now reach color
printing speeds of 24 ppm as well. And
some HP color multifunction devices reach
color print speeds up to 22 ppm.

AFFORDABILITY
The best way to appreciate the financial
value of color printing is to understand the
value in terms of time to market, impact
with customers, and total cost of owner-
ship.

Eager to better manage their publishing
expenses, Bellevue, Washington-based
ArtSource, a digital media staffing and
design agency, purchased multiple HP
printers—including HP Color LaserJet
5500s, Color Inkjet cp1700s and Business
Inkjet 1100s—that work together seam-
lessly to help increase productivity and
customer satisfaction.

ArtSource founder Melody Christensen

estimates that the business marketing
packet her company created using
Microsoft® Publisher 2003 and printed in-
house on HP printers costs less than $5
per unit, but will generate eight new cus-
tomers per month worth $5,000 each. She
further predicts that the annual revenues
from this new source of income could

reach $500,000 per year.
The bottom line is that professional-

quality digital color is becoming more and
more affordable. In fact, total cost of
printer ownership (TCO) and cost per page
have declined dramatically from the early
days of color printing in the office.

RELIABILITY AND EASE OF USE
To their credit, monochrome laser printers
from HP have developed stellar reputations
for reliability and ease of use. The down-
side is that, in the past, this created unre-
alistic expectations for color laser printer
performance. And unfortunately, many
early color models failed to live up to those
expectations.

According to Gartner, reliability has a
large impact on printing costs, which is why

it’s so crucial in a business
environment. The firm
stated, “Reliability, quality
and ease of use are key driv-
ers of printing cost because
they drive labor—the single
biggest cost of printing.”1

User-required maintenance,
end-user downtime and tech-
nical service were cited by
Gartner as primary cost cul-
prits.

Those culprits have
become less culpable as
color printer reliability has
improved. Vendors such as
HP have dedicated them-
selves to increasing reliabil-
ity, which has led to
significant improvements in
the areas of design, manu-
facturing and testing. And
more reliable devices help IT

spend less time troubleshooting and field-
ing calls for help, and more time on strate-
gic initiatives.

Reliability, as well as ease of use and
interoperability of HP digital imaging solu-
tions is helping the UK’s BMW WilliamsF1
Team, a Formula One racing team, make a
big impression with its Paddock Club

guests on race weekends. Using HP
Photosmart digital cameras and printers,
the team’s hospitality staff can take photos
of the guests with their favorite drivers dur-
ing tours of the pit lane, and then print
those photos immediately, so guests may
take autographed pictures home with
them.

“This kind of initiative could not suc-
ceed without products that are extremely
easy to use,” said Jonathan Odell, spon-
sorship account manager for the BMW
WilliamsF1 Team. “Hospitality is very
important to the BMW WilliamsF1 Team. In
order for guests to capture the moment,we
use the innovative HP Photosmart solution.
It is a great way of enhancing people’s
experience of Formula One racing as
guests of the Paddock Club.”

MAKING A DIFFERENCE
WITH MEDIA
The enhanced quality of ink and media has
also bolstered the image of color printers.
Consider the opinion of David Axelbank,
production manager at Magnum Photos,
one of the world’s largest global coopera-
tives of professional photographers, with
offices in New York, London, Paris and
Tokyo.

“As for the quality of ink on paper, in my
opinion, the HP Designjet [printer] pro-
duces prints that very closely resemble tra-
ditional C-type prints. The colors were
beautifully saturated and highly accurate.”

Magnum used HP Designjet six-color
printers to reproduce images for a recent
series of international exhibitions. All
prints were created using HP satin-finish
photo paper and HP state-of-the-art inks
designed for rich color depth, gloss unifor-
mity, color stability and consistency.

1Source: Gartner, November 2003.

COLOR SUCCESS STORY
■ Company: BMW WilliamsF1 Team, Oxfordshire, UK
■ Challenges: Enhance guests’ experiences of Formula One race weekends, pro-

vide a fast,easy-to-use solution for printing photographs for guests on race days.
■ Solution: HP Photosmart digital cameras and printers.
■ Results: Better customer relations, ease of use helps staff be more productive.
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Axelbank was also impressed with the
HP Designjet’s ease of use in terms of cal-
ibration. “Essentially there is nothing for
the user to think about beyond the initial
command and the result was highly accu-
rate color rendition from our files.”

Results like these make it clear that
color printing products have improved to
the point where companies of all sizes can
use them with confidence.

THE HP ADVANTAGE
HP’s worldwide presence allows the com-
pany to consistently provide an unparal-
leled depth of products, services and
support, while offering local advice based
on an intimate knowledge of indigenous
business environments. It’s the best of all
worlds for imaging and printing customers
such as Netopia (Phillipines), Yuen Foong
Paper (Taiwan) and IndoChine (Singapore).

For Netopia Internet Café, the luster
wore off its inexpensive, non-HP inkjet
printers when it came time to purchase
supplies. The printers’ high cost per page
drove up the company’s expenses on sup-
plies, while the service and support
needed to address frequent printer break-
downs was inadequate.

“If you look at the total cost of owner-
ship, we were not saving at all,” said
Raymond Ricafort, president of Digital
Paradise, Inc., owner and operator of
Netopia. “We had to discard the [non-HP]
inkjet printers altogether if we wanted to
provide the best professional printing serv-
ice to our customers in the long run.”

So the company turned to its local HP
office for help. The recommended solution
included color laser and business inkjet
printers.

“The level of customer support and
technical expertise we have been getting
from HP has just been amazing,” Ricafort
said. “Your partners must understand what
your business needs and where you want
to bring it. By partnering with HP, we’ve
achieved entirely new levels of productivity,
efficiency and cost savings to give us that
winning edge.”

CONTROLLING COSTS
Yuen Foong Paper Co., a subsidiary of the
Yuen Foong Yu Group, found itself in a
stalemate when the five HP Color LaserJet
5500 printers it purchased for external pre-
sentations became increasingly popular
for the production of internal documents
due to the printers’ superior image quality.

This led to a proliferation of unauthorized
color print jobs and an increase in printing
expenses, for which the source could not
be traced. To resolve the dilemma, Yuen
Foong Paper, which is one of the largest
commercial printing enterprises in Taiwan,
sought help from its local HP office.

HP responded with a solution that

enabled the company to allow only author-
ized personnel to use the printers, and to
determine where all print jobs originated—
a cost-management tool for color. As a
result of the improved procedural controls,
Yuen Foong has reduced costs by 30 per-
cent.

“It is a cost-saving solution,” explains
Yuen Foong President Y.C. Huang. “We find
it a unique way to continue enjoying the
high quality of color printing while keeping
our costs of consumables low.”

“But what we appreciate most has been
HP’s desire and commitment to make is
solutions work better for us. With HP, we
can really derive the maximum benefit from
our investments.”

DRIVING PRODUCTIVITY
With restaurants, bars, cafes and galleries
located throughout 20 outlets in three
countries, The IndoChine group determined
that it needed a more advanced imaging
and printing solution that included a serv-
ice package to eliminate in-house device
maintenance. IndoChine also wanted reli-
able all-in-one devices to handle high-vol-
ume color printing needs in the office and
at its food and beverage outlets.

Enter HP. Based on its local knowledge
of IndoChine’s needs, the company brought
in the right mix of printers, network capa-
bilities, all-in-one products and pay-per-use
services to optimize the company’s pro-
ductivity.

“The commercial deal
with HP’s imaging and print-
ing division has allowed us to
deploy laser printers into
every office and outlet cost
effectively without the tradi-

tional capital outlay and no internal skills
required from our staff to enjoy the latest
HP imaging and printing technology,”
reports IndoChine CIO Ian Aniszewski.

“The proactive monitoring by the HP
service center directly eliminates workload
and taxi expenses for our stretched IT
department, allowing our staff to be pro-

ductive in other areas. With HP managing
our fleet, we have the assurance of relia-
bility, efficiency and availability always.”

The bottom line: IndoChine estimates a
75 percent savings in printing costs and a
threefold improvement in productivity in the
graphics department alone.

COLOR FOR ALL
The benefits of color imaging and printing
can be experienced by all business func-
tions. Color enables IT professionals to
serve their customers better while manag-
ing costs. It allows sales and marketing to
make a professional impact with potential
clients. And color may help the business
overall to become more successful by
effectively distinguishing its products and
services from those of its competitors.

There are as many ways to optimize
business opportunities with color as there
are imaginative, innovative companies.
And many of those companies, recognizing
the value of color, are already using it to
drive a competitive advantage.

HP has been helping businesses expe-
rience the value of color for a long time,
providing expert, up-front advice based on
local knowledge and experience, leading-
edge products and solutions, and industry-
recognized service and support. So no
matter what your business objectives, or
where your business is located, HP is there
to help you get better business results

through the value of color
imaging and printing. ❚❚❚

COLOR SUCCESS STORY
■ Company: Yuen Foong Paper Co., Taipei, Taiwan
■ Challenges: Control escalating print costs, restrict staff usage of color laser

printers for printing internal documents.
■ Solution: HP JetCAPS solution for Yuen Foong’s HP Color LaserJet 5500 print-

ers restricts usage to authorized personnel only and helps track usage.
■ Results: Imaging and printing costs lowered by 30 percent.
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Barai, head of business development at iViz,
has always been deeply interested in anti-spam
technology, network and wireless security,
cognitive hacking and social engineering. He
jointly holds several patents on anti-spam tech-
nologies. And so does De, now CTO of iViz. An
electronics and electrical communication engi-
neer from IIT-K, De is by now a known name in
network security.  

The IIT Aura
Barai expalins, “iViz stands for ‘intelligent vision’.
We conceptualised this company in late 2003
when I was in my third year B.Tech. in computer
engineering and De was a GRA (Graduate
Research Assistant) at IIT-K. We had a grand vision
of making computing free from all security
threats. We got our company incorporated as ‘iViz
Techno Solutions’ in February 2004.”

iViz has a full-fledged office on campus. Apart
from Barai and De, the core technical team
includes current IIT students Rudra Sinha Roy, an
expert in penetration testing (see box on facing page),
and Abhishek Dutta, a specialist in exploitation
techniques. As of now, iViz has five full-time and
15 part-time employees and six consultants—all IIT-
K alumni. Also, iViz’ board of advisors has some of
the most eminent educationists, professors and
executives in India.

Two tech-whiz
IITians develop
ground-
breaking
solutions to
ward off
security threats

Renuka Rane

hen an educational institute claimed that
its physically segregated virtual network
for students, employees and administra-

tors could not be penetrated, a handful of IIT grad-
uates proved it wrong. Having only the privilege
and rights a student is entitled to, the team
accessed a guest account, entered the administra-
tors’ network, then the students’ and finally the
employees’ network. 

The team is from iViz Techno Solutions
(www.iviztechnosolutions.com), a technology-
driven products and solutions company conceived
and based in IIT Kharagpur (IIT-K), West Bengal.
iViz is a part of IIT-K’s incubation programme,
wherein graduates who would like to start a
venture of their own are provided  infrastructure
support. The company provides managed security
services, anti-spam consultancy, Web and database
security assessment, forensics and data recovery. 

The Pioneers
The duo behind iViz are just in their twenties—
and they have their quirks. Bikash Barai, 23, has a
penchant for unconventional magic tricks, and
enjoys the works of Swami Vivekanand and Netaji
Subashchandra Bose. Nilanjan De, 25, enjoys
science-fiction and is a confirmed night person.

W

Im
aging

Atul D
eshm

ukh

Security 
Superheroes 



38 DIGIT APRIL 2005

penetration testing can be conducted remotely
over the Internet and does not require physical
access to the premises or any privileged informa-
tion such as usernames or passwords. It involves
detection of vulnerabilities, their removal, and
then, continuous maintenance of the system,”
says De. For a network with three to four servers
and 100-odd users, the iViz team can complete
penetration testing in three days.

Bramhastra To The Rescue
iViz has built a penetration testing tool called
Bramhastra. “Bramhastra simulates an attack that
can be launched by the worst possible malicious
user. It tests the security of an organisation by
actually breaking into the system, gives a report
and suggests measures to correct the flaws and
finally, it clears up all the traces of the test,”
reveals Barai and claims that Bramhastra can
break into the toughest of networks. 

Bramhastra is supposed to be able to break
into the toughest of networks. New exploits are
constantly added to keep the Bramhastra
updated. iViz claims to be the sole Indian
company to have developed such a tool.

Blocking With Spam Walls
iViz also has a patented algorithm to detect spam
that passes through conventional filters and is
provably more efficient than other solutions such
as ‘Bright mail Anti Spam Enterprise Edition’,
‘MacAfee Spam Killer’ and ‘Postini Perimeter
Manager’. ‘Spam Wall’ is a unique anti-spam solu-
tion from iViz that can be used for individual and
server installations. It is a hardware-based filter
that sits between the mail server and the Inter-
net. Spam Wall is platform-independent, and one
just has to plug-and-play. Once installed, it takes
a week to resolve the spamming problem.

A major issue with existing anti-spam solu-
tions is the large number of false positives
returned (valid e-mails being stopped as spam).
“With ‘Spam Wall’ we already ensure extremely
low false positives. Hopefully, we will be able to
guarantee zero false positives in a few months,”
assures Barai. 

The Road Ahead
iViz conducts its core research work and product
development at IIT-K, and has a marketing and
corporate presence in Kolkata and Texas, USA.
Currently, iViz is looking for venture funding for
further expansion. It has job openings for profes-
sionals with a deep knowledge of security fields
and a zest for innovation. 

iViz wants to make computing secure at an
affordable price. Barai says, “We plan to market
our products shortly. In fact, the beta versions are
ready. However, we are not sure about marketing
the Bramhastra, as it could be very dangerous if it
falls into the wrong hands.” The team will soon
provide training on computer security.

“This is just the beginning and the best is yet
to come,” reflects De. With its grand vision of
cordoning off the increasingly susceptible virtual
space from anti-social elements, the student-
turned-entrepreneurs of iViz Techno Solutions
will have to keep up the good work. 

E-mail: renuka_rane@thinkdigit.com

Teamwork At iViz
Team members keep up-to-date with the most
recent exploits and vulnerabilities. They keep
track of trends in intruder activities, analyse
product vulnerabilities and malicious codes and
record their research. De explains, “We develop
customised security solutions based on our
clients’ needs. Our strength lies in penetration
testing and security audit, and more so in
exploitation development, vulnerability analysis
and discovery.” At the same time, De admits to
having undertaken preliminary and at times not
very challenging network security projects in
order to sustain the company.

Managed Security Services
As the cornerstone of iViz’ security solutions are
Managed Security Services (MSS), which enable
24 x 7 monitoring and management of network
security infrastructures. MSS comprise security
audit, penetration testing, vulnerability analysis,
security implementation and policy design.
Through iViz’ security information management
architecture, critical security issues can be iden-
tified; clients can be alerted of impending
danger; and appropriate and effective response
measures can  be prepared. 

“MSS is a set of services that start with the
detection of vulnerabilities, followed by their
elimination and then continuous maintenance
of the system. Although most firms spend huge
amounts on security, they end up building a
house with strong iron doors and walls made of
straw. MSS can equip them with robust security
at a lesser cost,” says Barai. 

Looking Beyond Firewalls
Popular belief says that a firewall and an Intru-
sion Detection System (IDS) can keep an organi-
sation safe. Not so, claims Barai. “In all the
sensational hacking cases we have seen, the
affected parties had firewalls and IDSes. We look
beyond firewalls and IDSes to find vulnerabilities
in the human and computer interface—one of the
weakest links in the chain, which determines the
effectiveness of security. We help organisations
become secure from all known vulnerabilities.”

Penetration Testing
A part of MSS, penetration testing is popularly
known as ethical hacking. An established tech-
nique for the live testing of network security,
penetration testing attempts to compromise a
system, as a potential attacker would, to see what
kind of information is actually divulged, thus
determining the vulnerability of a system. It
enables companies to receive a real-life vulnera-
bility test of their security status.

The iViz team has exposed several vulnera-
bilities and exploits that were hitherto unknown.
“A valuable testing, auditing and evaluation tool,

Write In

Done something just
as geeky? 
Tell us about it. 
Write to editor@

thinkdigit.com

Network Security Jargon

Penetration Testing: Also called ethical hacking, it entails breaking into the
security network of a system to assess its flaws
Vulnerability Analysis: Assess vulnerabilities of a system to security threats
Security Audit: Appraisal of the existing security framework of a company
Exploit Development: Exploiting existing vulnerabilities in a system in order
to know all existing flaws in security

We look beyond
firewalls and IDSes
to find
vulnerabalities in
the human and
computer
interface—one of
the weakest links
in the chain, which
determines the
effectiveness of
security

Nilanjan De
Chief Technology
Officer,

iViz Techno Solutions 
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Preethi Chamikutty

here is currently a large
worldwide market for
Indian art. And the Inter-

net is, naturally, facilitating this
exchange. Indians settled abroad
as well as those in India have
started exporting Indian art
overseas. As a case in point, we
take a look at Shalini Verma,
founder and director of Shalin-
Craft India, who returned to
India from France to set up her
own business. 

In The Beginning
Verma’s company was first
named Shalin Fine Arts. (‘Shalin’
means ‘grace’ in Hindi.) In 1996,
Verma established ShalinCraft,
because she was “not enjoying
sitting idle at home.” Shalin-
Craft earlier sold Western art
reprints in India, called Euro-
pean trend prints. These were
imported from France. Archi-
tects and interior designers were
the channels of distribution. 

The clientele mostly-
comprised offices and hotels

that were interested in the art
for their décor.

In 1998, when the rupee was
devalued, the company faced
problems in importing artwork. It
was then that Verma decided to
use the Internet as a medium of
conducting business—and rather
than importing, to get into
exports. Verma chose to export
hand crafted Indian products,
since after having dealt in art
products for over two years, she
had developed “an eye for beauti-
ful products.” 

T

Technology For Personal And SoHo Productivity

Exporting India

74 Just Push PrintTube It Up Pixel Palette

For Haryana based ShalinCraft, the Internet was the gateway to getting Indian art—and other
products—to a worldwide market
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24 hours, and delivered within
three to five days.

ShalinCraft does not have any
brick-and-mortar presence or
branches anywhere in the world,
except in India. Headquartered in
Gurgaon, Haryana, ShalinCraft
has country representatives
across different regions including
the US, the UK, Europe, South-
East Asia and Japan.

As a matter of fact, the US
alone accounts for almost 80 to 90
per cent of ShalinCraft’s business. 

Capturing The Market
ShalinCraft reaches out to 
the right audience? Using of
various marketing tools such as
e-mail marketing, online adver-
tising, search engine optimisa-
tion, affiliate programs and link
partnerships, newsletters and
press releases, customer profil-
ing, targeting user databases
and blogging.

ShalinCraft boasts of a
customer base of more than 4,000
customers across the globe.

The Customer Is King
The products at ShalinCraft pass
through three levels of quality
check to ensure that the
customer gets his money’s worth.

First, when the product is
purchased from the artist; next,
when it is entered into the inven-
tory; and finally, before it is

shipped. That may explain why
less than two per cent of shipped
items are returned.

What about standards? “We
are dealing mainly with the
unorganised sector. Our suppli-
ers are artists from remote
villages all over the country. It
will be extremely difficult at this
stage if we were to ask them to
manufacture products as per any
quality standards. But we are
certainly planning to apply for
quality standards in the future,”
says Verma.

ShalinCraft ensures that the
customer is at ease at all time.
The various return policies with
no strings attached help cement
the customer’s faith in the
company. ShalinCraft also has a
24 x 7 call centre that answers
calls from the USA. 

Using the Internet as an effec-
tive marketing tool, ShalinCraft
has made the transition from an
import house selling European
and Western art to Indian buyers
to a portal selling Indian handi-
crafts in the global market.
However, will an Internet art-
shop, catering to a niche clientele,
survive in the cut-throat world of
Internet shopping?

With Indian art becoming a
craze overseas, ShalinCraft may
just be able to outdo the competi-
tion if it makes the right moves. 

preethi_chamikutty@thinkdigit.com
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Enter The Internet
In October 1998, ShalinCraft
started with a five-page Web site
called www.shalinart-india.com.
There was little infrastructure
at that time for online shop-
ping; yet, their first sale—a
Madhubani-style painting—was
sold for $1,000 (Rs 43,500 today)
over the Internet. And this
cemented Verma’s faith that
business could indeed be
conducted over the Web. 

Today, ShalinCraft deals in a
wide variety of products such as
apparel, furnishing, books, folk
art, jewellery, sculptures, and
gift items. One new addition to
this list has been various
flavours of tea such as ‘Darjeel-
ing’, ‘Assam’, and ‘Spice’. “We
received various requests from
our customers for genuine
Indian tea and we thought, ‘why
not’,” says Verma.

Customers have the option to
select from a variety of products
available on the site, and can
even place custom orders for
products such as salwar kurtas
and sarees.

Business Over The Net
Most of ShalinCraft’s business
happens over the Net. A brief
description of every product on
the site helps customers under-
stand what they are ordering.
Products are shipped within

Search Engine Optimisation
When you have a Web site—especially if
it’s a store—you need to tell a search
engine that it exists. Most search
engines use automated programs—
known as spiders—to gather data.
Spiders look for certain indicators to
guide them to a site’s relevancy. The
more easily these indicators can be
found and understood, the more
accurately the spider can assess the
relevance of the page.

Though spiders have limited
intelligence, they are able to recognise
some of the more obvious tricks, and
can thus de-list ‘tricky’ sites.

When a page has been optimised, it
is submitted to the search engines for
evaluation and—hopefully—a high-level
listing. This last part of the process is a
question of finely judged timing—
multiple submissions are necessary.
But avoid overdoing as this could lead
to your site being delisted. 

Affiliate Programs
Suppose you have a Web site, say,
xyz.com and I have a site, abc.com. We
form an affiliate partnership. You place
a link (banner, product image or text
link) to abc.com on your site. A visitor
to your site clicks on that
advertisement and reaches my site and
makes a purchase. In that case you
stand to earn a certain percentage of
commission for that sale. 

There are different types of
programs with different structures.
The order tracking is done by cookie-
based software, either developed in-
house or by third party service
providers. 

In the case of ShalinCraft, it is a
third part service provider, Kowabunga
Technologies, which tracks sales, leads,
and calculated commissions.
ShalinCraft does all this by integrating
the affiliate tracking system with their
online ordering mechanism and

managing the program interface.
Affiliate marketing and management is
done wholly by them. They invite other
sites to join their program, give them
incentives for joining, and based on the
numbers of sales/visitors they have
sent, motivate them to drive further
traffic to the site.

Link Exchanges
This is similar to an affiliate program,
but there is no tracking involved. Two
sites exchange links (text, banners)
with each other and send each other
traffic. This helps in getting higher
rankings in search engines—
particularly Google.

Blogging
Search engines have started indexing
content published in blogs and showing
them with other search results. Blogs
are vital online marketing tools, more
so for new ventures. 

Marketing Methods

Our Internet
presence has
quickened our
response time
to customer
grievances and
queries. Our
sales have also
increased by
almost 5 times”

Shalini Verma
Founder and
Director,
ShalinCraft
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A
monitor is your window to
an exciting virtual world
that your hardware and
peripherals work quietly

to produce. Whether it’s a movie,
game or Web page, your viewing
experience depends heavily on your
monitor’s size and performance.

An good example is the feeling
of euphoria you get when you
upgrade from a 15-inch screen to a
17-inch or a 19-inch monitor; an
even better example is the dismal
experience of having to make do
with a 15-inch monitor after being
used to the 17-inch or the 19-inch
one for quite some time.

Although your graphics card
plays a key role in what the image
on your screen looks like, your
monitor is equally important.
Sharpness, colour reproduction,
refresh rate and resolution define
a monitor’s capabilities. And this
chain of features is only as strong
as its weakest link—if the monitor
underperforms in any of these
areas, you end up dissatisfied.

We tested 27 monitors; 18 were
17-inch, and nine were 19-inch
monitors. The products came to us
from nine vendors, and came in
beige, black and dual-tone. Some
were both beige and black. As
black cabinets are popular nowa-
days, black monitors are a must to
maintain uniformity—and cost, on
average, Rs 500 extra.

Since we can’t go about switch-
ing monitors for each task we
perform, monitors need to be all-
rounders, and should be capable of
offering you the best possible
experience while gaming, working
on text documents, watching
movies or surfing the Net.

Flat And Flatter
If you thought monitors were
either normal or flat, think again.
Now you have even flatter screens,
also known as ‘true-flat’ screens.
This difference is justified when
you see the differences between
each vendors ‘flat’ model and their
‘true-flat’ model. The regular flat
models display irregularities at the
corners, and though the screen
appears flat, the same does not

As the battle over which is better—LCD or CRT—continues, we take a close look at some of the
options in the CRT category

Tube It Up 
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hold true for the display. On the
other hand, ‘True-flat’ screens do
not have this problem. 

A flat tube is preferred over a
regular curved monitor because
of the better geometry offered by
the former. True-flat monitors,
such as the NEC MultiSync
FE791SB and Viewsonic E71f,
show no skewed corners when
displaying straight lines or grids.

In the 19-inch category, the
scene is no different. However,
models such as the LG
Studioworks 910E don’t claim to
be flat, and neither is there an
additional glass over the picture
tube to fool you into thinking it is
flat. The NEC MultiSync FP912SB,
on the other hand, is an aperture-
grille tube-based monitor, and is
therefore, a true-flat.

Dot Pitch
Dot pitch plays a significant role in
the sharpness of an image. This is
the distance between the individ-
ual pixels on the monitor screen.
A finer dot pitch results in a sharp
image, and inclined lines will
appear less crooked. 

However, aperture-grille tube-
based monitors with a tighter dot
pitch or line pitch cost a lot more.
As of right now, most monitors
have diagonal dot pitches ranging
from 0.27 to 0.24 mm. If you read
that a monitor has a dot pitch
smaller than this, make sure it is
the diagonal dot pitch, and not the
horizontal dot pitch.

Samsung advertises its moni-
tors as having a dot pitch of 0.20
mm, however, this is the horizon-
tal dot pitch, which is naturally
smaller than the monitor’s diago-
nal dot pitch value.

The 19-inch NEC MultiSync
FP912SB has a fine dot pitch of
0.24 mm, which was the best
amongst all the monitors we
tested. The Microtek 43F1, a 17-
inch monitor, had the coarsest
dot pitch: 0.28 mm.

Video Bandwidth
Most of us would love to own moni-
tors that can display 1,280 x 1,024
at 85 Hz, which means more view-
ing area without headaches due to
flicker. This translates to the need
for higher video bandwidth, which
in turn increases the cost of the
monitor. None of the 17-inch moni-
tors we tested, except for the Acer
AF715, had such specifications. It
offered 200 MHz of video band-
width, which enables it to reach a
maximum resolution of 1,600 x

1,200 at 75 Hz, which is an accept-
able figure, even for the most
discerning amongst us. However,
no other 17-inch monitor came
even remotely close to this figure.

In the 19-inch category, the
NEC, Philips and Samsung models
offered 1,920 x 1,440 resolutions.
The NEC offered a refresh rate of 73
Hz, but the others could not offer a
flicker-free viewing experience.
The NEC could pull this off because
of its high video bandwidth of 290
MHz, whereas the rest maxed out
at 250 MHz. The Viewsonic E90f+
could only generate 202 MHz
of video bandwidth.

Dimensions
By and large, a CRT
monitor is the
bulkiest device
attached to a
computer. This is
one of the main
reasons why LCD
monitors have
gained such a big
foothold in the display
market. Vendors have
tried to slim down CRTs, but this
can only be achieved to a certain
extent.

In the 17-inch category, moni-
tor widths ranged from 396 mm to
410 mm, and the depths ranged
from 410 mm to 430 mm. A differ-
ence of 20 mm is hardly notice-
able, so no matter what  monitor
you choose, be ready to make space
for it on your desk. Also, the 19-
inch category saw no noticeable
variations in dimensions.

Weight Problem
CRTs are heavy, and we are used
to this fact. The heaviest part is
the picture tube. Unless the tech-
nology changes drastically, CRTs
will remain heavy. The lightest
17-inch CRT monitor in our test
was the Philips 107 E5, weighing
in at 13.4 kg. The Viewsonic
EF72+SB weighed in at 18.1 kg,
and was actually heavier than
some of the 19-inch models. 

In the 19-inch category, the
lightest monitor was LG
Studioworks 910E at 17.3 kg. NEC
MultiSync FP912SB was the heav-
iest, at 23.8 kg.

Power Consumption
CRT monitors are power-hungry
beasts, and therefore, it’s a good
idea to power them separately
instead of using the cabinet’s
power supply. A CRT monitor 
typically needs 70 W of power or

more. This requirement can stress
a PC’s power supply, which can
lead to an unstable system. 

Amongst the 17-inchers, the
BenqV773 needed 70 W of power,
whereas the Acer AF715 demanded
a massive 120 W. If an office buys
the Acer for its employees, it
should be prepared to foot large
electricity bills.

In the 19-inch category, the
Philips 109 E5 was the most power-
efficient. It needed just 65 W of
power, which was lower than even
the best 17-inch monitor in this
test. Even the 109 B6 from Philips
needed just 75 W. 

These are very impressive
figures as far as power consump-
tion is concerned. The biggest
power hog in the 19-inch category
was—you guessed it—the Acer
AC915-130 W. 

Extras
All monitors came with a quick
start guide, a power cord, and a CD
with a manual and a colour
profile. The LG Studioworks 700S
came with a blue card with a spec-
tral code. This works in conjunc-
tion with the Colorific
display-tuning utility bundled
with the monitor. You can adjust
the brightness and contrast
perfectly by comparing the colour
of the card to the colour on the
screen—when they match, your
monitor is set perfectly. 

Samsung’s MagicTune soft-
ware and Viewsonic’s Wizard
allow you to tune your monitor’s
settings to specific applications
with minimum hassles.

How They Performed
Both the 17-inch and 19-inch moni-
tors were tested by running 32
selected slides from DisplayMate
Video Edition, which pushes the
CRTs to the limit. These tests
included checking of the geomet-
rical display, sharpness of lines,
curves and text, uniformity of the
screen, and other problems related
to CRT technology—defocusing
level shift and ghosting.
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A moiré pattern is a wavy pattern formed on the
monitor when very a fine pattern is displayed. These
patterns can be due to the graphics board or shadow
mask in a CRT monitor when there is cross-talk or
noise induced in a signal, or when the electron beam
spot size is small. If the spot size is small, it does not
adequately fill the hole in the shadow mask—and
hence makes the moiré visible.

What is moiré?

Samsung SyncMAster 793MB



Digital Tools l Test Centre

44 DIGIT APRIL 2005

Pincushion And Barrel
Distortion
This is a problem with almost
every CRT monitor. If you thought
the factory default settings get you
straight lines, you will be disap-
pointed to find that these settings
are hardly optimised.

Pincushion is a form of distor-
tion where lines bend inwards.
The opposite of this is barrel
distortion. There are multiple
reasons why these effects happen,
the primary one being that the
screen is constructed almost flat,

disturbing its natural spherical
shape. With this in mind, moni-
tors come with special circuitry
that corrects pincushion and
barrel distortion. However, not all
the monitors displayed straight
lines even after trying every trick
in the book to calibrate them.

In the 17-inch category, the
NEC MultiSync FE791SB, Samsung
793S and LG Flatron E700SH were
the ones that returned the best
results. The results, after all the
adjustments, were not perfect, but
they were acceptable to the point

where only graphics professionals
could make out flaws. Users work-
ing with office applications and
surfing the Net would find the
results impressive.

The HCL785RFM and the
Philips 107 E5 failed to display
horizontal lines straight. The HCL
and the Philips monitors failed to
provide the necessary tools for
perfect adjustment, and scored
lower on this test. If your work
involves working with graphics or
industrial design, we recommend
the NEC MultiSync FE791SB.

Our test bed consisted of a Pentium 4 2.8 GHz equipped with an
nVidia GeForceFX 5950 Ultra graphics card. The system ran

Windows XP SP2. The CRT monitors were tested at their native
resolutions (1024 x 768 at 75 Hz for 17-inch, and 1280 x 1024 at 75
Hz for 19-inch monitors). 

We adjusted each display to perform optimally in the viewing
conditions, using manufacturer-recommended or Windows’ default
settings when possible. We also had a reference monitor, which was
evaluated first, and then the rest of the monitors were compared to
the image displayed by the reference monitor. 

DisplayMate Tests
With help from DisplayMate Technologies, we ran through our own
scripted selection of test screens in DisplayMate Multimedia Edition.
These screens help us isolate common phenomena such as flicker,
moiré, bounce, ghosting, and convergence errors. We broke down
our own analysis into five categories: focus, regulation, geometry,
colour quality and uniformity, reverse text, moiré and interference.
A product’s scores in each category was compiled and averaged to
produce a single performance rating. The ratings you see in our
reviews are a composite of the battery of individual screen analyses
we ran for each monitor.

Our test script, described below, represents only our base-
testing. Many of the screens in this test suite can be configured in a
variety of ways, including with different background and foreground
colours. Depending on the characteristics of an individual display,
we used several variations of the screens listed below, along with
other DisplayMate screens. 

Resolution Tests
Horizontal Line Resolution: This screen contains five horizontal
bars composed of vertical white lines in varying frequencies of lines
per inch. The higher line frequencies demand more from the
display’s horizontal resolution capabilities. We used this screen to
adjust the sharpness of the monitor and evaluate its horizontal
resolution capabilities. 
Vertical Line Resolution: This screen is similar to the previous test,
and contains five horizontal bars composed of horizontal white lines
in varying frequencies of lines per inch. The higher number of lines
per inch areas stressed the display’s vertical resolution capabilities. 
Focus Matrix: The graphic pattern on this screen reveals variations
in focus across the display. This screen was used to adjust and to
test image focus. It is also handy for checking geometric linearity,
especially in the corners. 
Page Of Text: This screen allows us to examine the display’s ability
to render text under a variety of conditions. With it, you can cycle
through various text and background colours, view split screens
with inverse text and background colours, and alter the type and
size of a font. We found it especially useful in evaluating a display’s
ability to render anti-aliasing enhancements. 

Sharpness And Resolution Tests
Midrange Streaking: As the title suggests, this screen allows us to
check the display’s propensity for streaking and ghosting, light or
dark shadows that trail an image in areas where large changes in
intensity are present. You may detect this on your own monitor
when it renders large, chunky graphics elements such as bar graphs
or tiled arrangements of open windows.
Fine Focus And Resolution Matrix: Moiré looks like a tiger’s
stripes, or like ripples, superimposed on a CRT monitor’s screen.
Though it’s found on virtually all CRTs, it’s actually less common in
consumer CRTs because they are generally not as sharp as higher-
end displays. Some monitors include moiré-reduction features.

Geometry Tests
Pincushion And Barrel Distortion: This screen is used to measure
the geometric distortion displayed by the CRT monitor after
calibrating it using its OSD menu. 
Screen Regulation: This screen helps detect image contraction and
expansion with strong changes in brightness. It displays a large,
flashing square against a black background. The square can be
assigned various colours, but white is generally the most useful. On
a poor-quality CRT, the square appears to grow slightly as it flashes. 

Colour And Greyscale Tests
Streaking And Ghosting: In this test, various screens comprising
grey and colour bars are displayed against a grey background.
Streaking and ghosting usually occur when there is a change in the
intensity between adjacent areas. We looked for shadows trailing
the edges of bars and blocks. 
Level Shift: This, again, occurs at the edge of areas with varying
brightness. In white and black level shift, the area adjacent to the
dominant white or black area will have a blurry edge—displaying a
red, green or blue edge.  

Miscellaneous Tests
Background Noise And Interference (Screen 10:3): We examined
this screen for a list of things that should not be seen. These may
include irregularities relating to noise aggravated by poor-quality
cables or other problems as are normally associated with the
electronics of the display.
Defocusing Blooming And Halos: This slide displays lines and rings
of varying brightness. The monitor should be able to satisfactorily
produce the image, and the bright part should not look washed
out or appear thick.
Features Test: In the features test, we looked for the set of
features the monitor provided—such as a flat screen, video
bandwidth, the maximum horizontal and vertical frequency
supported by the particular monitor, dimensions, weight, and other
relevant aspects. The monitors were awarded points according to
the extra features they offered. 

How We Tested
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Among the 19-inch monitors,
the Philips 109 B6 and the
Samsung SyncMaster 957MB got
the lines correct. The Samsung
957MB returned results as good as
Philips. Both these 19-inch  moni-
tors will make good companions
for those with eyes sensitive to
correct geometry, as well as for
CAD/CAM professionals.

The Pump Effect
When there is a sudden change
in brightness, the screen expands
or gets displaced. This is called
the pump effect, and is a
common problem with CRT tech-
nology. Vendors are yet to provide
a solution for it.

You can see this effect by using
a wallpaper with a dark back-
ground and running an office
application with a light or white
background—if you switch from
the application to the wallpaper,
you will see the screen contract.
Switching back to the application
will result in the screen expand-
ing. This adversely affects your
experience, especially while
watching a movie.

In the 17-inch segment, the
NEC MultiSync FE791SB returned
solid results. There was very little
pump effect visible. Some moni-
tors such as the Samsung Sync-
Master 793DF returned very poor
results; the screen not only got
bigger in size, but also got
displaced by more than a millime-
tre. Therefore, if you are a movie
buff, spend that extra money and
get the NEC MultiSync FE791SB.

Amongst the 19-inch monitors,
NEC MultiSync F912SB returned
impressive results, followed by
both the Samsung models. The
Viewsonic UltraBright E90f+SB
returned unacceptable results.

Resolution And 
Sharpness
Here, we were looking for sharp-
ness in horizontal and vertical
lines and bars, crispness of
patterns in the middle and corners

of the screen, and the moiré prob-
lem. Sharpness suffers because
monitors are not able to draw
every detail correctly at the reso-
lutions and refresh rates we
usually work at. This results in
serrated edges in bars and lines,
both horizontal and vertical. Since
the screen is drawn at very high
speeds—typically 75 to 80 times a
second—misconvergence occurs,
which in turn results in a pattern
appearing blurred at the corners.

The other reason for imper-
fectly crisp images at the corners
is the deflection of the electron
beam from its path. The beam,
which hits the middle of the
screen, is not deflected much, and
therefore doesn’t lose its circular
shape. However, when it hits the
corners, the circular shape turns
into an elliptical one, and as a
result of this, neigh-
bouring pixels
get highlighted
at the same time.

In this set of
tests, the LG
S t u d i o w o r k s
700S displayed
crisp images at
our test resolu-
tion of 1,024 x
768 at 75 Hz. It
displayed sharp hori-
zontal and vertical
lines, and even single
dots didn’t bleed too much into
neighbouring pixels. It also
managed to display fine patterns
generated by DisplayMate crisply
in the middle and with very little
fuzziness in the corners.

The Samsung 793S, an entry-
level monitor, was not up to the
mark. Horizontal lines appeared
serrated, and the dots were
nowhere near round. Even the
patterns appeared rather hazy in
the corners.

The moiré effect, which is
another problem with CRT moni-
tors—whether shadow mask-based
or aperture-grille-based—happens
not because the monitor is faulty,
but because of the limitations
imposed by the technology. A dot
pitch as fine as 0.24 mm is not
sufficient to eliminate moiré
completely. Any finer dot or stripe
pitch will increase the price of the
monitor drastically, making it
unfeasible for the mass market.

There is a moiré-correcting
function on the On-Screen Display
(OSD) controls of all monitors. But
in most cases it doesn’t help to
eliminate moiré completely. 

The Acer AF715 and the View-
sonic E71f were the only monitors
that provided a moiré-free display.
There was absolutely no trace of
line moiré, and the visible dot
moiré was almost negligible. The
LG Flatron E700SH and Samsung
793S returned images filled with
moiré in both the line and dot
tests. All attempts to correct this
using the OSD were in vain.

In the 19-inch category, the
HCL HCM985RFM returned the
best results, with very little
moiré in both the line and dot
tests. The Philips 109 B6, too,
returned commendable results,
but the Philips 109 E5, on the
other hand, had moiré smattered
all over the screen. Even the NEC
MultiSync FP912SB suffered in
the dot moiré test. 

Screen Pixel
This is a test that uses a curved and
an inclined line. Since the dots in
a CRT screen are arranged in
triads, it is not possible to display
an inclined line or curve smoothly.
However, a monitor with a tighter
dot pitch will serve up a less
crooked line as compared to one
with a coarse dot pitch.

There was hardly any differ-
ence among monitors which were
tested in both the 17-inch and 19-
inch categories. 

Colour And Greyscale
Here, we looked for the purity of
primary and secondary colours,
reverse text, the ghosting effect,
and level shift. Ghosting and
streaking is an effect visible at the
edges of the display area where
the intensity of the brightness
suddenly drops. This effect is
lower when a CRT is new, but
increases as it gets older. 

This can be very irritating for
those working on MS Word or a
programme with a similar layout,
where a bright area is adjacent to
a dark area. Tweaking the
contrast, in many cases, can take
care of this problem to some
extent, but it can cause strain
while reading text.

A certain colour temperature is defined as the colour
emitted by a black body at that particular
temperature. Colour temperature, also known as
White Point, is a setting in almost all monitors. It is
adjusted so that the monitor displays a natural-
looking colour. 9300 K is termed Cool White, and
6700 K is seen as a warmer white.

What Is Colour Temperature?

A colour profile is a file that holds
information about the colour
reproduction capabilities of an
imaging device such as a monitor
or scanner. It is provided by the
vendor, and is installed on the
computer to enable the monitor to
display colours correctly.

Colour Profiles

HCL HCM985RFM
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In the 17-inch
segment, Samsung
SyncMaster 793S was
free of any ghosting
and streaking when

tested with the four slides we ran
the monitor through. The
Samsung SyncMaster 793MB was
equally impressive, but there was
slight ghosting trailing of a bright
bar on a dark background. The
NEC MultiSync FE791SB, however,
did not manage the impressive
score it did in the other tests.
Ghosting was prominent at differ-
ent intensities, especially with
white and yellow over a
grey background. 

In the 19-inch category, the
HCL HCM985RFM and the
Samsung 957MB were relatively
free from the ghosting effect. Here
again, the NEC MultiSync FP912SB
returned poor results. 

The White and Black Level is
another problem visible at the
edges’ areas of various intensities.

Again, office applications
such as Word, Excel and Power-
Point are good examples where
this ‘level shift’ is visible. In Word,
the white area where words are
typed, and the adjacent grey back-
ground makes for a white-level
shift in the form of a visible tinge
of colour. This makes the edges
blurry. Of course, this is just an
example, and is a minor
problem with office
applications, but for graph-
ics professionals it means
inaccuracy. They need displays
that show crisp images that
match the printouts perfectly. 

In both the 17-inch and the 19-
inch categories, there was very
little level shift visible in the moni-
tors. We could see some red and
blue tinges, which were not very
prominent. The tinges were visible
only if scrutinised.

Text Colour 
You often come across coloured
text on a coloured background—
especially in Web pages. The crisp-
ness of coloured text suffers on
colour backgrounds. In some
cases, the edges will be blurred, or
the text appears thick or thin. Red
text on blue will appear thick,
whereas red text on yellow will

appear thin. This happens because
the brighter colours bleed into
darker colours. 

Among the 17-inch monitors,
the Philips 107 C6 gave good
results, making it a good choice
for Web designers and surfers. The
Microtek Flatvision 43F1 suffered
in this test. The cyan text on a red
background was full of blue
tinges, and red text appeared very
thin on a yellow background.

In the 19-inch category, the
NEC MultiSync FP912SB returned
acceptable results. The colours
weren’t perfect, of course, but they

were definitely acceptable.
The Acer AC915 returned

below-par results, and
left a lot to be desired. 

Miscellaneous
Tests
We looked for
common problems
such as the unifor-
mity of the screen,
flicker, the reflec-

tion problem and the
shadow mask problem. CRT

monitors usually do not display
the screen uniformly. Most of

the CRT monitors appear brighter
at the centre, and get dimmer
towards the corners. Flicker is
another problem with CRT moni-
tors, and it will persist unless the
refresh rate is well above 72 Hz.

Viewsonic E71f
(17-inch)
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Brand Score (Out of 100)Basic SpecificationsModel Price (Rs)

Score Board

0.27mm, 30 - 72Khz, 1280x1024@60Hz, 110MHz, Shadow Mask, 15.5Kg, 75W
0.25mm, 30 - 98Khz, 1600x1200@75Hz, 200MHz, Shadow Mask, 17Kg, 120W
0.25mm, 30 - 72Khz, 1280x1024@67Hz, 110MHz, Shadow Mask, 16.4Kg, 75W
0.27mm, 30 - 72Khz, 1280x1024@67Hz, 110MHz, Shadow Mask, 15.4Kg, 75W
0.27mm, 30 - 72Khz, 1280x1024@67Hz, 110MHz, Shadow Mask, 15.4Kg, 70W
0.27mm, 30 - 70Khz, 1280x1024@60Hz, 110MHz, Shadow Mask, 15.5Kg, 75W
0.25mm, 30 - 54Khz, 1280x1024@60Hz, 110MHz, Shadow Mask, 16Kg, 90W
0.27mm, 30 - 70Khz, 1280x1024@60Hz, NA, Shadow Mask, 14.4Kg, 74W
0.25mm, 30 - 70Khz, 1280x1024@60Hz, 110MHz, Shadow Mask, 16Kg, 74W
0.28mm, 30 - 70Khz, 1280x1024@60Hz, 110MHz, Shadow Mask, 15.5Kg, 95W
0.25mm, 30 - 96Khz, 1600x1200@70Hz, NA, Aperture grille, 17Kg, 68W
0.25mm, 30 - 71Khz, 1280x1024@60Hz, 120MHz, Shadow Mask, 15.8Kg, 68W
0.27mm, 30 - 71Khz, 1280x1024@60Hz, 120MHz, Shadow Mask, 13.4Kg, 64W
0.20(H)mm, 30 - 70Khz, 1280x1024@65Hz, 110MHz, Shadow Mask, 14.2Kg, 80W
0.23(H)mm, 30 - 70Khz, 1280x1024@65Hz, 110MHz, Shadow Mask, 13.8Kg, 80W
0.20(H)mm, 30 - 70Khz, 1280x1024@65Hz, 110MHz, Shadow Mask, 14.3Kg, 80W
0.25mm, 30 - 71Khz, 1280x1024@66Hz, 110MHz, Shadow Mask, 16Kg, 75W
0.25mm, 30 - 72Khz, 1280x1024@60Hz, 110MHz, Shadow Mask, 18.1Kg, 75W

0.26mm, 30 - 98Khz, 1600x1200@75Hz, 202MHz, Shadow Mask, 18.2Kg, 130W
0.26mm, 30 - 98Khz, 1600x1200@75Hz, 200MHz, Shadow Mask, 20Kg, 130W
0.26mm, 30 - 85Khz, 1600x1200@65Hz, NA, Shadow Mask, 17.3Kg, 70W
0.24mm, 30 - 110Khz, 1920x1440@73Hz, 290MHz, Aperture grille, 23.8Kg, 102W
0.25mm, 30 - 97Khz, 1920x1440, 250MHz, NA, Shadow Mask, 20Kg, 75W
0.26mm, 30 - 92Khz, 1920x1440@60Hz, 240MHz, Shadow Mask, 17.8Kg, 65W
0.20(H)mm, 30 - 96Khz, 1920x1440@64Hz, 250MHz, Shadow Mask, 18.2Kg, 100W
0.20(H)mm, 30 - 96Khz, 1920x1440@64Hz, 250MHz, Shadow Mask, 18.2Kg, 100W
0.25mm, 30 - 86Khz, 1792x1344, 202MHz, Shadow Mask, 22Kg, 100W

Acer
Acer
BenQ
BenQ
BenQ
HCL
HCL
LG
LG
Microtek
NEC
Philips
Philips
Samsung
Samsung
Samsung
ViewSonic
ViewSonic

Acer
HCL
LG
NEC
Philips
Philips
Samsung
Samsung
ViewSonic

AF713
AC715
G776
P776
V773
HCM780M
HCM785RFM
StudioWork 700S
Flatron E700SH
FlatVision 43F1
MultiSync FE791SB
107 C6
107 E5
SynchMaster 793MB
SynchMaster 793S
SynchMaster 793DF
E71f
E72f+SB

AC915
HCM985RFM
StudioWork 910
MultiSync FP912SB
109 B6
109 E5
SynchMaster 957MB
SynchMaster 997DF
UltraBrite E90f+

61.88
64.80
55.19
55.85
61.99
59.85
54.91
58.97
51.93
58.67
55.33
55.28
54.34
59.12
60.69
59.46
62.39
59.89

61.31
64.17
58.32
63.83
59.14
61.48
65.53
66.97
62.54

5495
6995
8500
9600
6900
6300
7900
8000
13500
5700
17000
10000
8500
8100
6400
7900
7500
7600

13495
13100
17000
19000
20000
17500
16500
14900
14250
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Acer AF715 (17-inch)

17-inch CRT Monitors

19-inch CRT Monitors

For the complete scoreboard, log on to www.thinkdigit.com
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The flicker is more prominent
when the screen is bright, because
bright pixels do not hold their
brightness levels for long; if the
next refresh is going to take
longer, it will result in flicker. It
is therefore recommended to keep
the refresh rate at 75 Hz or above,
if your monitor and resolution
can support it. 

Reflection when the screen is
dark is another problem. This can
hamper clear vision of what is on
the screen. Most vendors claim to
have anti-glare coating on the
glass, but this only works when
your screen is not dark.

In both the 17-inch and 19-
inch categories, the monitors all
offered good screen uniformity
and flicker-free viewing at 75 Hz,
the only exception being the
Samsung 793DF, which had a
darker shade in the lower left
corner. Overall, the dark screen
test  returned results similar to
those in the screen regulation
test, with all monitors in both
categories suffering. There was
not even a single monitor that
could return a pure dark screen
with no reflection.

In the CRT Shadow Mask test,
four bright blocks are at the
corners of the screen, and stay
bright for 30 seconds. They then
disappear. We looked for any
remnants, or ghost images, of the
bright blocks. As it turned out,

none of the monitors had traces of
ghost images.

This test was a lot more useful
a decade ago, when the phos-
phors, if kept glowing for
extended periods of time, would
keep a bright spot for some time
afterward. This is the reason
screensavers were developed and
used. These days, new monitor
technology has done away with
the need for screensavers, though
we still use them for ornamental
and aesthetic purposes.

Cost Of Ownership 
Prices of everything except
CRT monitors seem to be
falling. For example, the
Microtek 43f1 cost Rs 5,700 last
year, and costs the same even now.
In fact, certain repeat
models have gotten
more expensive—
the NEC MultiSync
FE791SB cost Rs
16,500 last year,
whereas it is
currently priced
at Rs 17,000. The
cheapest 17-inch
monitor avail-
able right now is
the Acer AC713,
at Rs 5,495.

In the 19-inch
category, the
Philips 109 B6
was the costliest model at Rs
20,000, followed by the NEC Multi-
Sync, an aperture-grille-based
monitor available for Rs 19,000.
The cheapest was the HCL
HCM985RFM, at Rs 13,100.

Summing It Up
The notable monitors in this test
were Benq V773 and NEC Multi-
Sync FE791SB, which gave the
highest pure performance scores,
but couldn’t make it to the top due
to low features scores or a higher
price tag. The NEC merits special
mention as it was the only aper-
ture-grille-based monitor  capable
of a high resolution of 1,600 x
1,200 at 70 Hz, which makes it the
best buy for graphics professionals.

The Acer AF715 wins the Best
Buy Gold, thanks to its fine dot
pitch of 0.25 mm and a terrific
video bandwidth of 200 MHz. This
monitor made its mark felt in
many tests. This was the only
monitor which could do 1,600 x
1,200 at 75 Hz—a resolution and
refresh rate usually found only on
19-inch models. It also had easy
OSD functions, returned good
results in the pincushion and
barrel distortion tests, and showed
no line moiré.

The ViewSonic E71f is our
Silver winner. In fact, we also used
it as our reference monitor. The
ViewSonic E71f performed well
and has a good feature set. The
monitor came in a dual-tone black
and silver grey finish, making it an
attractive companion for those
with black cabinets. The price of
the monitor, however, is a little
steep, and this  was compounded
by lower features scores—and it
lost the top spot.

In the 19-inch category, the
NEC FP912SB returned a
commendable overall perform-
ance and the highest features
scores, but because of its high
price, it couldn’t make it to the
top. The HCL HCM985RFM is the
cheapest 19-inch monitor avail-
able, and also performed impres-
sively—making it desirable for
budget buyers.

In the end, the day belonged
to the Samsung siblings: the Sync-
Master 997DF claimed Best Buy
Gold because of its stable all-
round performance. It managed
decent results in difficult tests
such as the screen regulation and
the pincushion and barrel distor-
tion test. The monitor did not
display any ghosting or streaking,
making it a good choice for graph-
ics professionals, gamers, and
those who want to migrate to a
bigger screen.

The Samsung 957MB is our
Best Buy Silver winner, as it had
all the qualities of its sibling in
terms of features and perform-
ance. The higher price tag of Rs
16,500, against Rs 14,900 for 
the SyncMaster 997DF, was the
sole reason it won silver and 
not gold. The 957MB also
deserves special mention, as it
comes with the Magic Bright
button, which is a factory-set
brightness and contrast settings
button optimised for different
viewing conditions. 

jayesh_limaye@thinkdigit.com
sanket_naik@thinkdigit.com
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Samsung SyncMAster 997DF (19-inch)

Samsung SyncMAster 957MB (19-inch)
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Telephone Web siteCompany E-mailBrand

Contact Sheet CRT Monitors

Acer
Benq
HCL
LG
Microtek
NEC
Philips
Samsung
Viewsonic

Acer India Pvt Ltd
Benq India Pvt Ltd
HCL Peripherals
LG Electronics India Pvt Ltd
Microtek International Ltd
Shiba Comp Pvt Ltd
Philips India Ltd
Samsung Electronics India 
Roop Technology Pvt Ltd

080-5219520-23
022-25705230
044-5200 6570
012-2560900-40
022-28362407
011-26413437
022-56912324
011-51511234
022-26680022

Rajesh_Aiyar@acer.co.in
SalesEnquiryIn@BenQ.com
kiruba@hclp.com
avarshney@lgezbuy.com
an.bom@mtk.sril.in
sales@shibacomp.com
pcp.india.info@philips.com
marketing@samsungindia.com
roop@vsnl.com

www.acer.co.in
www.benq.co.in
www.hclperipherals.com
www.lgezbuy.com
www.microtek.com.sg
www.nec-mitsubishi.com
www.india.philips.com
www.samsungindia.com
www.viewsonic.com
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Change The Default Open
And Save Folders

When you choose to
open a new document in

Word, it usually begins
browsing in a specific
directory, such as My
Documents. Similarly, when
you choose to save, there is a
default directory. You can
change these defaults: go to
Tools > Options. Click on the
‘File Locations’ tab. Click on
‘Documents’ under ‘File
Types’, and then on ‘Modify’.
Use the ‘Look in’ list to locate
the folder you want to use
from now on. Click on the
folder name, then click ‘OK’ to
select that location. Finally,
click ‘OK’.

Multiple Clipboards
In Word

You’ll often need to copy
more than one block of

text to the Clipboard, but you
probably didn’t know you
could do this and then paste
everything into a document!

To get to the clipboard in
the task pane in Word XP,
first make the task pane
appear using View > Task
Pane. Then, on the little
‘down’ arrow, select
‘Clipboard’. Click ‘Options’,
then check ‘Collect Without
Showing Office Clipboard’.

Now copy up to 12 blocks
of text (24 blocks in Word XP),
then, when you’re ready to
paste, use the ‘Clipboard’

toolbar in Word 2000, or the
task pane on the right side of
the screen in Word XP. Now,
you can paste everything at
once, or individual items in
different locations. Hover the
mouse over the icons on the
Clipboard toolbar or on the
task pane to get a preview of
the content.

Add A Button To A Toolbar
You’ve probably never
bothered to do this, but

it’s very easy to add your own
buttons to the toolbars. You
can add a button for any of a
variety of commands. For

example, if you often change
the font of selected text to
Verdana, you can place a
convenient button on the
toolbar to make the change
with one click. To make a
new button, go to View >
Toolbars. Select ‘Customize’.
Click on the ‘Commands’ tab,
and select an item under
‘Categories’. Then select an
item from the list of
‘Commands’. Drag the
command to a toolbar. A
beam that looks like an ‘I’
will appear to help you install
the button. By default, the
new button has only a text
label. Right-click on the new
toolbar item, and select
Default Style—the button will
become a plain square. Right
click on the new toolbar item
again. Choose ‘Change Button
Image’, then select a button
image. Finally, close the
‘Customize’ dialog box.

To remove a button from
a toolbar, go to View >
Toolbars, select ‘Customize’,
and drag the button you want
to remove off the toolbar.

Print Out All Of Word’s
Shortcut Keys

Word has an inbuilt
macro that generates a

list of all the keyboard
shortcuts available. To
generate the document, go to

Tools > Macro. Choose
‘Macros’. Select ‘Word
commands’ from the list in
the ‘Macros in’ box. Now from
the list in the ‘Macro name’
box, choose ‘ListCommands’.
Click Run. In the ‘List
Commands’ dialog box, click
‘Current menu and keyboard
settings’. Click OK. The macro
will run, generating a
document in table form that
you can print.

Using Styles
A style is a set of
formatting

characteristics that you can
quickly apply to text in your
document. The Style list is the
pull-down list on the
‘Formatting’ toolbar, where it
usually says ‘Normal’ in a
white box. You can apply
styles by selecting text, then
choosing a style from the list.
There will be a few there by
default. To create your own
styles, select the text that
contains the formatting you
want to use for your style. On
the Formatting toolbar, click
inside the ‘Style’ box. Type
over the existing style name
to create the name for the
new style, then press Enter.
You can set additional
formatting characteristics for
paragraph styles, such as the
style for the next paragraph.
To do this, go to Format >
Style. Click the style that has
the settings you want to
change. Click ‘Modify’, and
then select the options you
want.

Create Your Own AutoText
AutoText is a way to
store and quickly insert

text, graphics, fields, tables,
bookmarks, and other items
that you use frequently. Word
comes with a library of
AutoText entries. To see there,
look at the items listed under
AutoText in the ‘Insert’
menu, or turn on the
AutoText toolbar, and then
click on ‘All Entries’. You can
create your own AutoText
entries with either of the
following methods.

Choose AutoCorrect or
AutoCorrect Options from the
Tools menu, then click on the
AutoText tab. Type in the text
of your new AutoText entry in
the ‘Enter AutoText entries

MICROSOFT WORD

SECRETS THAT KEEP YOU AHEAD IN THE RACE

In Word XP, you can copy and paste up to 24 blocks of text at once, at
different points in your document—using the ‘Clipboard’ task pane
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here’ box, then click Add.
Make sure the ‘Show
AutoComplete tip’ checkbox is
checked. Click OK. Word will
show a tip on the screen after
you type the first four or five
letters that match the
AutoText entry. Press [Enter]
to accept the entry, or keep
typing to ignore it. If
‘AutoComplete’ is turned off,
you can insert AutoText
entries with the AutoText
toolbar (see the next method).

Turn on the AutoText
toolbar by choosing Toolbars
from the View menu, then
selecting AutoText. Select the
text you want for an AutoText
entry, then click on the ‘New’
button on the AutoText
toolbar. Make up a shortcut
name for this entry. To use
the shortcut, type the
shortcut, then immediately
press [F3].

Locking A Range Of Cells
If you want to lock only
a particular range of

cells along with the formula
instead of locking the entire
sheet, use the following steps.
First, unlock all the other
cells. This is necessary
because all the cells start
with their ‘Locked’ property
set to ‘True’. Select the entire
sheet by clicking on the grey
square to the left of the grey
letter A at the top of column
A. Go to Format > Cells. Click
the ‘Protection’ tab. Uncheck
the ‘Locked’ checkbox. Click

‘OK’. Then, you can protect a
certain number of cells. For
example, let’s protect A4:B10:
select cells A4:B10. Go to
Format > Cells. Click the
Protection tab. Check the
‘Locked’ checkbox. Click OK.
Now go to Tools > Protection
> Protect Sheet. Enter a
password if you want to. Now,
only the cells in A4:B10 will
be protected.

Disabling Specific
AutoCorrect Features

In Excel 2000, it may
seem impossible to put

“ehr” in a cell because Excel
changes it to “her”. You can
fool it by concatenating
individual letters, but an
easier way is to disable the
relevant AutoCorrect feature.

To stop Excel from doing
this or any other similar
change, follow these steps: go
to Tools > AutoCorrect
Options. On the first tab
(‘AutoCorrect’), in the ‘Replace
text as you type’ section, there
is a long list with a scrollbar.
Use the scrollbar to go down
to through the alphabetical
list to ‘e’. Find the entry for
‘ehr’. Click that entry to select
it. Now click ‘Delete’.

Round Off Times
Here’s a formula that
can round off a time to

the nearest quarter hour: if
someone clocks in at 7:07, it
counts as 7 AM. If he clocks in
at 7:08, then it should be 7:15
AM. To do this, use this
formula:

=ROUND(A1*96,0)/96

If your times are in
column A, you would enter a
formula like this in column B.
You will have to use Format>
Cells and then format the
cells in column B with a
time format.

Easily Convert Numbers
To Text

If you have a column of
numbers and you need

to convert them all to text,
you would select the column,
then go to Format > Cells,
and on the ‘Number’ tab,
change the formatting to
‘Text’. That doesn’t quite do it
though—the formatted cells
will still work as numbers,
which you can verify by using
them in formulas. To convert
them to real text, you need to
press [F2] and then hit
[Enter], for each and every
cell. Here’s a simpler way to
convert a whole bunch of
numbers to text. Let’s assume
you have numbers in cells
A2:A1000. Insert a temporary
blank column B. In cell B2,
enter this formula:

=TEXT(A2,”0”)
Copy the formula in B2 down
to B3:B1000. We need to
change these formula to
values in order to have them
become text. Highlight cells
B2:B1000. Use [Ctrl]+[C] to
Copy, then Edit > Paste
Special > Values > OK. The
entries in column B will now
be text versions of the
numbers in column A. Now,
copy column B back to
Column A. Delete the
temporary Column A.

The key to this technique
is the =TEXT() function. The
second parameter describes
how the number should be
formatted before being
converted to text. You may
need to adjust this based on
your numbers. The result of

=TEXT(123.25,”0”)
will be 123.
The result of
=TEXT(123.25,”0.0”)
will be 123.3.
The result of
=TEXT(123.25,”0.00”)
will be 123.25.

To always keep only the
decimals as entered, use

=TEXT(A2,”General”).
This function is also useful
for converting dates to
formatted dates. Assuming

you’ve set Windows to use the
Indian system for dates, if you
have ‘10/05/2005’ in cell A2,
then using

=TEXT(A2,”d mmmm,
yyyy”)
will give you ‘10 May 2005’.

Add A Number To
Every Cell

Say you have a
spreadsheet full of

values, and you need to add
0.2 to every cell. To do this,
find a blank cell in your
spreadsheet. Enter 0.2 in that
cell. Select that cell and go to
Edit > Copy. Now, select every
cell that the operation needs
to be applied to. From the
menu, go to Edit > Paste
Special. In the Paste Special
dialog box, select ‘Values’ in
the top section, and ‘Add’ in
the ‘Operation’ section. Click
‘OK’. This will add the contents
of the clipboard (0.2) to every
number in the selected range.

Correcting The Placement
Of The Minus Sign

When you import from
a text document into

Excel, the minus sign may
appear to the right of the
numbers. To correct this in
Excel 2000, use this function:

=VALUE(IF(RIGHT(A1,1)=”-
”,RIGHT(A1,1)&LEFT(A1,LEN(A
1)-1),A1))

In Excel 2002 and 2003,
here’s how to do it: in Step 3
of the Text Import Wizard, or
in Step 3 of ‘Text to Columns
(select from Data)’, click
Advanced. Now, in the
‘Advanced Text Import
Settings’ dialog box, 
select the ‘Trailing minus 
for negative numbers’
checkbox.

MICROSOFT EXCEL
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You can use the ‘ROUND’ formula in Excel to round off times. In this
example, we have rounded off times to the nearest quarter-hour

PPrriinnttiinngg  OOuutt  HHeeaaddiinnggss
Say you have a row of headings
at the top of your spreadsheet.
To make this row appear at the
top of each page when you
print out the spreadsheet, go
to File>Page Setup. In the ‘Page
Setup’ dialog, there are four
tabs across the top. Select the
‘Sheet’ tab. In the field for
‘Rows to repeat at top:’, enter
1:1. This will cause Row 1 to
appear at the top of each
printed page.

Bet You Didn’t Know
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Aliasgar Pardawala

To schedule a meeting at
work is not very

difficult, provided it’s at
your workplace. All you
have to do is pick up the
phone and pass on the
message, right? You could
also send an internal mail
or message and walk up to
the people for a
confirmation.

But what if you have to
schedule a meeting where
associates from all over the
country are required to
meet at a particular date?
The task gets daunting,
doesn’t it? People might
not be available when you
call them up, your
message might end up in a
voice-mail box, and even if
you do get them, verbal
communication is not
considered the most
effective medium. 

So you fall back on
your trusted e-mail client
to push the message
across. But then, there is
more to Microsoft Outlook
than just Send/Receive.
There are tons of features
built into this nifty utility,
which can help you manage
your work-related tasks. 

Thankfully, there’s a
way to reach out to
multiple recipients and
schedule meetings. You
can also keep a tab on the
run-up to the meeting, and
make changes, either in
the agenda or the timing. 

How To Get There
To schedule a
meeting using

Microsoft Outlook, click on
the Calendar tab. Select
the date when you want
the meeting scheduled.
Right-click on the date to
open up the dialog box
with options such as ‘New
Appointment’, ‘New
Recurring Meeting’, ‘New

Meeting Request’, etc.
Click on ‘New
Appointment’ and a new
window will open. In this
window, you will be
presented with options
such as Appointment,
Schedule, Reminder, etc.

Enter Names
Now let’s get the
names of people

from the Address Book.
Click on ‘Address Book’;
this will open it up.
Double-click on each
of the contacts to add
them to the recipient
list. Click ‘OK’ once you
are done. Selected contacts
will be displayed beside
the ‘To…’ tab. Clicking
the ‘To’ tab also brings
up the Address Book.

Where And Why?
Write the ‘Subject’
and ‘Location’ in

their respective fields. This
gives the recipients the
purpose of the meeting
and the location of the
meeting at a glance.

What Time?
To assign the ‘Start’
and ‘End’ times for

the meeting, click on the
drop- down menu, or click
on the ‘Schedule’ tab, and
then set the time. This will
reflect in the Start/End
Time drop-down menu.

The agenda for the
meeting can be described
in detail later, while you
are drafting the mail,
which will get sent to
everyone. But once you
are through with the
above settings, you don’t
have to worry about the
scheduled time, place,
and recipients.

Hit The Send
Button
When you mail

this schedule to the
recipients, the task will get

added to their
calendar.
They, however,
must accept
the schedule.
If any of the
recipients
declines the
request,
he/she will be
out of the
loop. 

You can
also make this
a recurring

task, if the meeting takes
place at regular intervals.

When this is enabled,
the recipient will be
reminded in advance every
time the meeting is due.

aliasgar_pardawala@
thinkdigit.com

You’ve Got A Meeting
Make Microsoft Outlook do more than just Send/Receive
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Right-click on Date in the Calendar
to select a new appointment

Select ‘New time proposal’ from
the ‘Action’ menu to let others
specify what time suits them

Appropriate labels will help your
recipients understand the
purpose of the meeting

Select recurrence if the meeting
is going to be held at regular
time intervals

You can select multiples names
from the address book just by
clicking on their names

The green line indicates the ‘Start’ time, and the
red line indicates the ‘End’ time
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Print Without Opening
PowerPoint

To print your
presentation without

even opening PowerPoint, go
to Start Menu > Run. Type in
“powerpnt.exe /p
filetoprint.ppt” into the text
field, replacing
“filetoprint.ppt” with the
name of the presentation you
wish to print.

Using Your Toolbar On
Other Machines

When you customise
your toolbar

configuration, its layout,
icons, visible options, and
positions are all recorded in a
file called ppt.pcb. The
ppt.pcb file is typically
found at c:\windows\
application data\microsoft\
powerpoint\ppt.pcb, and by
copying this file, you can port
your toolbar customisation to
other machines.

Resizing All Images And
Pictures In Proportion 

When resizing any
image, picture, or

element in PowerPoint, you
may want to resize all the
images and graphical
elements in your PowerPoint
presentation at the same
time. For example, if you have
three images and two graphic
elements that you have to
resize, but must stay the
same size in relation to each
other, select the first image
you wish to resize. Hold down
[Shift]. Click on the other two
images. Still holding the
[Shift] key, also click on the
two graphical elements. Drag
your mouse in the direction
you wish to increase or
decrease the size of the
image, and the other selected
items will scale accordingly.

Apply A Template To An
Existing Presentation

Open your presentation.
While your presentation

is open, choose ‘Apply Design
Template’ from the ‘Format’
menu. Navigate to the
location of the PowerPoint
Templates, or where the
PowerPoint Template (.POT)
file that you wish to apply to

your presentation is located,
and select the template you
want. A small thumbnail
image of the design becomes
visible in the navigation
palette. Choose Apply.

Loop Music Across A
Certain Number Of Slides

To play a background
music loop or music file

across a number of slides in
PowerPoint 20002/XP 2003,
and 2004, first choose ‘Movies
and Sounds’ from the ‘Insert’
menu. Depending on what
you want, select ‘Sound From
Clip Organizer’, ‘Sound From
File’, ‘Play CD Audio Track’, or
‘Record Sound’. Locate the
sound file you wish to play
across any number of your
slides. Insert the sound. At
this point, if you don’t want
the sound icon to appear in
the presentation, drag it off
the slide. If you are asked “Do
you want the sound to play
automatically?”, select “Yes”.
Right click the sound’s icon,
and select ‘Custom
Animation’ from the
popup menu.

The ‘Custom Animation’
dialog box will open and your
sound file should be listed.
Click the arrow directly to
the right of the sound icon to
pull down various options.
Select ‘Effect Options’, and on
the ‘Effects’ tab, select the
radio button beside Stop
Playing > After, and select
the number of slides that you
would like the music to
continue to play through.

If you want the sound to
continue through the end of
the presentation, enter a very
large number, such as 999.
Now select the ‘Timing’ tab.
To play automatically, the
timing should be set to ‘After
Previous’ with a 0-second
delay. Click OK to close the
dialog box. Your music track
will now continue after you
leave the slide on which you
placed it, and play until it
reaches the slide number
which you entered to
‘Stop Playing’.

Change The Colour Of
Your Hyperlinks

To change the colour of
your hyperlinks in

PowerPoint 2002 and 2003 to
match the colour scheme of

your presentation, choose
‘Slide Design’ from the
Format menu. Click ‘Color
Schemes’ in the ‘Slide Design’
window. ‘Apply a color
scheme:’ appears beside the
thumbnail images at the top
of the window. Click ‘Edit
Color Schemes’ at the bottom
of the window, and the ‘Edit
Color Scheme’ dialog box
appears. Click the Custom
tab. Eight coloured squares
will now be visible. The
bottom two squares, ‘Accent
and hyperlink’ and ‘Accent
and followed hyperlink’ are
the colours used in your
presentation for your text
hyperlinks, and visited text
hyperlinks. Double-click the
‘Accent and hyperlink’ colour
square; this sets the colour of
your hyperlinked text. Choose
a new ‘Standard’ or ‘Custom’
colour in the colour selection
dialog box that appears, and
click ‘OK’. Now double-click
the ‘Accent and followed
hyperlink’ colour square; this
sets the colour of your visited
hyperlinked text. Choose a
new ‘Standard’ or ‘Custom’
colour in the colour selection
dialog box that appears,
and click OK.

Click ‘Apply’ if you wish
to apply these colours to the
current slide only, or click
‘Apply to All’ to apply the
change to all text
hyperlinks throughout
your entire presentation.

Dual Displays 
You can use PowerPoint
to display your

presentation on one screen,
or projector, to an audience,
while you read notes, and
control your presentation,
from another screen without
your audience seeing what
you are reading. In order to
achieve this, your system
hardware must support
dual monitors.

Open the presentation you
wish to show on one of your
monitors, screens, or
projectors. Select ‘Set Up
Show...’ from the Slide Show
main menu option. The ‘Set
Up Show’ dialog box appears.
If you wish to use a projector,
click the ‘Projector Wizard’
button. In the pull-down menu
option under ‘Show on:’,
choose which monitor, screen,
or projector you wish to
display your presentation on.
Now go to View > Notes
Master. Select ‘Set Up Show...’
again from the Slide Show
main menu. This time, select
which monitor, screen, or
projector you wish to display
your presentation notes on.

MS POWERPOINT

This is where you change the colours of your hyperlinks in PowerPoint.
You might want to do it so they go with the rest of your colour scheme

HHiiddee  SSlliiddeess  IInn  PPoowweerrPPooiinntt  
When producing a
presentation for different
audiences, often, you may not
want to show all the slides to
all the audiences. To hide a
slide, select ‘Slide Sorter’
from the ‘View’ menu. Click
on the slide that you want to
hide. Select ‘Slide Show’ from
the main menu toolbar. Click
on ‘Hide Slide’, and that slide
will now be hidden.

Bet You Didn’t Know
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Size Matters
Size and weight are
important

considerations when buying
a laptop. If you travel a lot,

opt for a laptop that is light
in weight. Weights of
laptops range from one to
four kg. While checking the
weight, include everything
you will carry along with
the notebook, such as the
power adaptor or any
external drives.

See Your Screen
The size of the display
screen directly affects

the size, and in most cases,
the weight, of the notebook.
The larger the screen, the
bulkier the notebook. A
bulky notebook will be a
problem to use in
cramped locations such
as in an airplane.

Power Struggle
Though performance is
not the most important

criterion while purchasing a
notebook, make sure you get
enough horsepower for the
applications you use or plan
to use. While 256 MB of RAM
should suffice for most,
power users should opt for at
least 512 MB.

All Work And No Play?
If you want to play 3D
games, or plan to use

your laptop for some
graphics-intensive
applications, opt for a model
that features good-quality
graphics. Options available
include Mobility Radeon
7500, 9700 and GeForce FX
Go5200.

These will give you better
graphics as compared to
commonly-used platforms.

Go Wirefree
Most notebooks today
offer Wi-Fi capabilities.

Check the Wi-Fi standard
supported by the model you
are considering for purchase.
An 802.11 b/g device will
give you higher data
throughput as compared
to 802.11b.

Upgrade
Check if the notebook is
upgradeable at a later

stage. Some options to look
for when upgrading your
laptop are the RAM, the CPU,
and the hard drive. Are the
upgrades something
you can do yourself, or do
they require visits to a
service centre?

Build Quality Is Important
Since laptops are meant
to be carried around,

good build quality is
essential. Opt for a notebook
that has a rugged build
quality that can withstand
jerks and shocks. The optical
drive tray, the screen hinges
and latch, the panel on top of
the keyboard, and the overall
casing are good indicators
of build quality. 

Warranty Issues
Warranty is also an
important

consideration. Make sure you
get a global warranty if you
travel abroad frequently. Even
if you don’t, make sure the
service centre is easily
accessible in terms of
location and distance so you
can get any problems
rectified quickly. 

Optical Drives
Most notebooks these
days come with a

DVD/CD-RW combo drive by
default. Make sure the
notebook you plan to buy has
a combo drive if not a DVD-
Writer. A combo drive will
enable you to read DVDs as
well as write CDs.

Optical Drive Location
Check for the location
of the optical drive. An

optical drive placed in the
front may be a hindrance
while working in cramped
spaces, or when the notebook
is placed on your lap.

Wider Is Better
Notebooks that come
with wide screens offer

a  better movie-viewing
experience. They are also
useful while working with

large spreadsheets. Also, look
for decent quality integrated
speakers if you want to
enjoy movies and music
on the move.

Hot Laps
Make sure the notebook
you plan to buy does not

get too hot after a while. A
hot laptop on your lap may
pose a serious health risk!

Storage
Most notebooks come
with 40 GB hard drives.

If this does not seem
enough, see if you can get an
upgrade to a larger capacity
hard drive. The drive’s

rotational speed also
impacts performance. While
4200 rpm drives are the
most common, look for
higher rpm hard drives for
better performance.

Go Legal
When purchasing a
laptop, make sure it

comes with legal software.
Some vendors may not
provide you with legal copies
of the software. Verify that
the software that comes with
your laptop is on an original
CD, and has a software
license or registration
number.

Laptop Drivers
Check and make sure
you get all the required

drivers on a disk along with
the laptop. A recovery disk is
also preferable, and will
come in handy in case of a
system crash.

Connectivity Options
The available ports on a
notebook will define the

types and number of
peripheral devices you can
connect. Most notebooks
come with 56K modems and
at least 10/100 Ethernet
integrated, so the notebook
will have RJ11 and RJ45 ports
for connecting a telephone
cord and a network cord
respectively.

Typically, you should look
for at least two USB ports, a
parallel port to connect a
printer, a VGA port for
connecting a projector or an
external monitor, and Audio
Out and Mic In ports to
connect speakers and a
microphone respectively.

PC card slots are also
essential, and you should
check the types of PC cards
that are supported. An
infrared port, if available, will
let you connect compatible
devices such as cell phones to
your notebook, while a
FireWire port lets you
connect digital such devices
as video cameras. Look for
these ports if you feel you
will require them even at a
later stage. Additional ports
such as S-video out are also
welcome!

One-handed Operation
Some notebook models,
especially those with

larger screens, come with two
latches that will require you
to use both your hands to
open the device. This may be
inconvenient in some
situations, for instance, when
you are speaking on the
phone. Look for a laptop that
has a single latch.

Touch The Pad
Most notebooks these
days feature touchpads.

Make sure the laptop you
plan to buy has one that is
large and offers smooth and
jerk-free control of the
pointer. Some notebooks

BUYING A LAPTOP
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Jayesh Limaye

The printer has become an
indispensable tool for the home
and SoHo segment these days.

Almost every inkjet printer is capable
of printing at a quality that was
available only in high-end printing
solutions a few years ago.

More often than not, though,
you’re stuck in a situation where
your inkjet printer starts acting up,
smearing your printouts with ink or
showing banding. And what happens
if this occurs when you need an
urgent print? You’d start running
helter-skelter: call the technician,
who, in turn, might take a long time
to get your printer fixed. This
situation can be avoided entirely;
all your inkjet printer needs is
periodic maintenance and
cleaning. Here’s how...

Clean The Print Cartridge
To start with, always use the
cleaning utility provided with

the printer driver interface. To access
this utility, click on ‘Start’, then on
‘Printers and Faxes’. Right-click on
the printer listed, and click on

‘Printing Preferences’. Now click on
the ‘Services’ tab, and click on
‘Service this Device’.

Place a blank paper in the paper
tray and click on ‘Clean the Print
Cartridge’, and then on ‘Clean’. A test
page will be printed and you have to
gauge whether the printout is clean
or not. You might have to repeat this
step several times; if this does not
help, proceed to manually clean
the print head.

Clean All Surfaces
You must be very careful
while doing this; handle the

printer gently to avoid any damage.
Disconnect the printer from the
power supply, moisten a clean piece
of cloth in mild soap solution, and
wipe the surface of the printer.
Open the front flap and gently wipe

all plastic surfaces, particularly
those stained by spilled ink, and the
rollers. Avoid
touching any lubricated surface
such as the slide bar.

Remove The Cartridges      
This step is only for thermal
inkjet printers and should not

be performed on printers based on
piezoelectric technology, also known
as ‘On-Demand’ inkjets. After the
printer has dried, keeping the front
flap open, connect the power cable
and switch on the printer. The print
cartridge cradle will now move
towards the centre of the slide bar.
Gently pull the ink cartridge towards 

you, and it will pop out of the cradle.
Repeat the above steps for the other
cartridge(s) as well.

Clean The Stubs
You will now be able to see
two small pieces or stubs

attached to the bottom of the cradle
on the left and right. This is where

the gunk and ink accumulates,
smearing your printouts.

Use the moist cloth to clean these
stubs. Similarly, clean the ink
cartridge print head using a lint-free
cloth, soaked in denatured alcohol. A
lint-free cloth (and not a cotton
swab) must be used, so that the print
head does not get clogged with
cloth fibres.

Your printer should now be
printing as good as new. But that’s
not the end of it—it requires periodic
cleaning in order to be able to
function at the peak of its efficiency.

jayesh_limaye@thinkdigit.com

Stain-free Printing
Maintaining your inkjet printer makes your printouts crisp and spiffy

Cleaning using the printer driver utility

The cartridge cradle moves towards the centre
when you power it on with the flap lifted up

The stub to be cleaned—this is where all the
gunk accumulates

Use a lint-free cloth to clean the print heads

Remove the cartridge
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also provide pointing sticks
as the pointing device. Go
for one with which you are
most comfortable.

Memory Card Reader
If you own a digital
camera or any other

device that uses a memory
card (such as SD, MMC, CF or
Memory Stick), it makes
sense to purchase a notebook
that has an inbuilt memory
card reader. This way, you
can transfer data to and
from the card without the
need to buy a separate
memory card reader. Check
whether the card reader in
the notebook is compatible
with the type of memory
card you use.

Ease Of Use
Some notebooks feature
scroll keys along with

the touchpad keys to enable
vertical and/or horizontal
scrolling in large documents.
Some also feature hotkeys
for launching your
favourite applications. 

Additional Features
Additional features,
including integrated

Bluetooth, biometric security,
keyboard light and integrated
Web cams, are offered in
some models. Since these
extra features also affect the
pricing of the laptop, opt
for one that has the
features you need.

Shortcuts To Success
Create shortcuts to your
most commonly used

applications, folders and files
on the desktop. This way, you
can access them quickly. If
you like your desktop clutter-
free, you can also create
custom toolbars in
Windows XP.

To do this, right click on
the Windows taskbar, go to
‘Toolbars’ and click on ‘New
Toolbar’. Next, choose the
drive or folder you want to
access using the toolbar. You
can create different toolbars
for different drives and
folders. To remove a toolbar
you added, right click on the
Windows taskbar, go to

‘Toolbars’, and uncheck the
toolbar. This is useful for
sales executives who want
easy access to presentations,
proposals and other
information on a day-to-
day basis.

Boot Faster
To make your notebook
boot faster, remove

unwanted programs from

startup. To do this, go to Start
> Run, type “msconfig” and
press [Enter]. Go to the
Startup tab and uncheck any
programs you do not need.
Click on ‘OK’ and then click
on ‘Exit’ without restarting.
The unchecked programs
will not run the next time
you boot.

Clean Up The Junk
Uninstall any
applications you do not

use. Apart from saving on
disk space, you will also
prevent your notebook from
slowing down.

Be Resourceful
Keep backups of the
operating system,

drivers and commonly used
applications on a secondary
partition so that you can do
some re-installing on your
own if you face some issues
while travelling. Carry driver
CDs and recovery disks 
with you.

Prevention
Is Better Than
Cure

Since a
notebook

may be
connected to
different
networks, such as
at a client’s
office, for
example, it is
essential you use
a good anti-virus
and firewall

software. Update your virus
definitions frequently. An
anti-spyware program is
recommended.

Don’t Be A Jerk
Be careful while
carrying the notebook.

Do not subject it to any jerks
and shocks. This will avoid
damage to your hard drive
and the precious data on it.
Preferably, power the
notebook off before moving it
from one place to another.

Dusty Notebooks
Don’t Impress

Protect your laptop
from dust. Clean your

laptop regularly to prevent
dust accumulation. Do not
leave your notebook on the
floor and make sure all vents
are clean to enable good 
air flow.

Drinks And Laptops
Don’t Mix

Avoid having beverages
while working on your

laptop. Do not place any
containers filled with hot or
cold beverages near your
notebook, to minimise
chances of a spill.

Protect Your Laptop
Do not leave your
notebook unattended in

a car or in a client’s office. Be
careful when going to a
restaurant or when using
public transport. 

Backup, Backup, Backup!
Keep backups of all your
important files and e-

mails in a safe location such
as your desktop PC or an
external drive. This way you

still have your precious data
even in case your notebook
is stolen.

Power Surges
Use a surge protector
with your laptop to

protect it from power surges. 

Condition Your Battery
A new battery needs to
be conditioned—it must

be fully charged and
discharged a few times
before it can use its
full capacity.

Leave Power Management
To The Pros 

Use the notebook’s
power management

features to improve battery
life. You can set the device to
switch off the LCD screen
and hard drive after set
intervals of time.

Screen Scream
The screen hogs a lot of
battery power. To

prolong battery life, dim the
screen brightness when you
are not connected to a
power source.

Close Applications
Close any applications
you are not using when

on battery power. Running
applications increase CPU
utilisation, thus reducing
battery life.

Disconnect
External peripherals and
accessories such as

external optical drives, PC
cards and USB keyboard
lights draw power from the
notebook. Disconnect any
such devices when not in use.

POWER-SAVING TIPS

LAPTOP SECURITY

USING A LAPTOP

Toolbars in Windows XP

Programs that run at startup

Power options in Windows XP
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Suspend Your Notebook
Booting the notebook
when it is not connected

to a power source draws a lot
of power from the battery.
Instead of shutting down
your laptop in the middle
of a meeting, choose the
suspend mode if you wish to
use it again after a short
period of time.

Entertainment Is Bad For
Your Battery

Playing graphics
intensive games, videos

or music drains the battery
quickly. Close any such
applications when on battery
to prolong battery life.

Carry Safe
A good carry case is
essential for your

notebook. There are a variety
of options available. Choose
one that fits your
requirements and budget.

Apart from being sturdy,
you should opt for one that
has a padded shoulder strap
and has enough space to
hold additional stuff such
as the power adaptor, CDs,
papers, external drives,
mouse and cell phone. Some
notebook bags also double-up
as overnighters. 

Get A Mouse
Users who do not find
the notebook touchpad

easy to use should opt for an
external mouse. Though you
can use a standard desktop
mouse with your laptop,

specially-designed notebook
mice are available. These are
smaller in size and easy to
carry around. Some even
come with retractable cords
to reduce the jumble of wires
you need to carry. You can
also opt for a wireless mouse.
Most of the newer ones use
the USB interface, so make

sure you have a free USB port
on your notebook.

Go The Desktop Route
Those who use their
notebooks as their

primary computer may want
to invest in an external
keyboard, mouse and even a
larger monitor. This will be
the closest to the feel of a
standard desktop.

Additional Connectivity
Some notebook models
can be hooked up to

compatible port replicators
and docking stations. These
devices allow for added
functionality by providing
additional ports and
external drives.

Must-Have
A USB thumb drive is a
useful little piece of

hardware for
transferring small
amounts of data
between
computers. These
come in handy in
situations where,
for instance, you
would like to
transfer a
presentation or a
sales proposal to

your client’s PC at
his office. Some USB

drives come with password
protection option and provide
a safe place to store
confidential files. Instead of
storing these files on the
notebook hard drive, just
carry them with you in the
USB drive. You can work on
them directly once the drive
is connected. This way, your
confidential files do not find
their way into the hands of
crooks even if your notebook
gets stolen.

More Power
An extra battery pack is
a good investment if

you plan to stay away from a
power socket for long.

When In Rome…
Different countries have
different types of power

sockets. Accordingly, check
and carry the appropriate
type. If you are a global
traveller, opt for a universal
adaptor. It offers a variety of

different plug types allowing
you to connect your notebook
power adaptor to power
sockets almost anywhere in
the world.

Stop Thief!
Invest in a Kensington
lock to prevent your

notebook from being stolen.
A Kensington lock features a
strong cord that can be
looped around the leg of a
table or chair and then locks
onto a slot in the notebook,
thus preventing anyone from
walking away with the device.

Some of the higher-end
lock models also boast of
motion sensors and emit
high-pitched beeps if any
motion is detected.

Enjoy The Trip
If you enjoy movies
and music on the

notebook and find the
integrated speakers to be
good enough, you may
purchase external speakers
specially designed for
notebook users. These are
extremely compact and easy
to carry. Most draw power
from the notebook or from
their own set of batteries. 

These speakers may not
offer the surround sound
experience, but will
definitely sound better than
most integrated laptop
speakers. However, if you
like to watch a movie or
listen to music while
travelling in an airplane or a
train, it makes sense to buy
a decent set of headphones

so as not to disturb your
fellow travellers.

Store More
An external hard drive
is a good option if you

want to carry large files
without stuffing your
notebook’s hard drive.

Charge Your Cell Phone
From The Laptop

If you are a cell phone
junkie and find that

your cell phone battery is not
able to give you enough juice,
buy a USB charger for your
phone. These are useful for
people who stay on the road
for the better part of the day
and are not able to access a
power socket to charge their
cell phones.

USB chargers are
available for most commonly
available cell phone brands
and draw power from your
notebook’s USB port to
charge the cell phone.

However, this will also
shorten your notebook battery
life, so make sure your
notebook battery is charged
enough to see you through till
the time you can connect it to
a power socket again.

Increase The Number
Of USB Ports

If you do not have
enough USB ports on

your laptop to connect all your
devices, opt for a USB hub.

Light It Up
A keyboard light is a
good buy for those who

want to work on their
notebooks without disturbing
their neighbours in a long-
haul flight or their spouses in
the bedroom. The light clips
on to the top of the notebook
screen, draws power from the
USB port, and illuminates the
keyboard so that you can work
in the dark.

Additional Stuff
A range of accessories
including battery packs,

Wi-Fi PC cards, USB to Wi-Fi
adaptors, USB to Bluetooth
adaptors, external optical
drives and notebook coolers
are available. Explore local
dealers and online stores, and
you are sure to find what you
are looking for.

ACCESSORIES

Digital Tools l Tips & Tricks



Private Eye

The D-Link DCS-5300W securicam is a versatile
IP-based camera with motorised tilt and pan

to cover almost an entire room.
To monitor a remote location, you need a

high-speed Internet connection and a PC. If
your office already has an ADSL connection
with a cable modem and ADSL router in place,
you can directly connect the camera to the
modem, bypassing the PC.

Once the camera is plugged to the system,
you type in the IP address as mentioned in
the manual, or retrieve it through the IP
installer utility to access the inbuilt Web server. This launches the camera
user interface. You can control the movement of the camera from the
interface or through the provided IR remote. There is a motion detection
and trigger recording (both audio and video) facility that helps you view,
at your leisure, activity in the area under surveillance.

Company D-Link India ltd 
Price Rs 15,000
Phone 022-26526696
E-mail sales@dlink.co.in
Web site www.dlink.com

Rating
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D-Link DCS-5300WTravel PAC FM Radio Handsfree

Ever wanted to hear a caller’s voice on the
surround speakers of your car or better still,

on your fantastic home sound
system? Well, now you can!

This latest hands-free
from Travel PAC clips on to
the earpiece of your cell
phone and beams the
caller’s voice at the 88.6 or
106.1 FM frequencies. You can
tune your FM receiver to either of
these frequencies, and listen to him or
her in Dolby Digital Surround! Only the caller’s
voice is transmitted; to reply, you still need to
use the phone the usual way. The device is really
tiny, but comes only with a car cigarette-lighter
charger—which means you can only charge it in
your car, and not at home. It’s mightily priced at
Rs 995, but is, even then, a device you should
look at for the sheer ingenuity of it!

Company Camac Holdings Pvt Ltd 
Price Rs 995
Phone 033-22207961   
Web site www.pac.com.sg 

Rating

A Smarter Communicator

The MPx is the latest in the series of
Pocket PC-based mobile phones from

Motorola. It takes the
Smartphone/Communicator concept
ahead with its radically new design,
based around a dual hinge that allows
the phone to be flipped open in
portrait as well as landscape mode.
The portrait mode is ideal for using
it as a phone, and the landscape
mode is more conducive for data
communication.

Though bulky in design, it is
pretty much in line with other
Communicator models such as the Nokia
9500, and the Treo 600. The body is made of plastic and
sports a combination of dark metallic blue and silver hues,
lending the phone executive looks. Fit and finish is top-notch. 

Ergonomically speaking, the keypad is usable, but leaves a
lot to be desired—especially when compared to the Nokia
9500. The blue backlight hampers legibility and does not help
much. The stylus is placed in an awkward position with
respect to the portrait mode. 

There are two displays on the phone—the small external
colour display is helpful but susceptible to blackouts in direct
sunlight. There are three quick access buttons beneath the
external screen, and these come in handy in putting the
phone into silent mode, or to control MP3 playback—or to
switch on the voice recorder. The internal screen is a regular

320 x 240 trans-reflective TFT capable of 65K colour depth.
Compared to other Pocket PCs, the screen on the

MPx is diagonally smaller by around 0.7-inch,
and this is instantly noticeable. That apart, the
display quality is reasonably good.

Like a true communicator, the MPx 300
offers abundant connectivity options such as
infrared, GPRS, Bluetooth and Wi-Fi. When
switching to a Wi-Fi connection, you need to switch
off the GPRS connection. A neat tool makes Wi-Fi
configuration a simple task. Bluetooth, too, works
perfectly without any problems.  

On the media side, a camera capable of a
maximum resolution of 1280 x 960 is integrated,
with a short-range flash that fails to impress. No video
recording is possible, but photo image quality is fairly

good. Memory is, however, limited, and one gets just 15
MB for use. You can, however, increase the memory by

way of an SD card. 
On the software side, you get most what MS Pocket PCs

have to offer. The speech recognition takes a while to get used
to, but it works. The box comes with a Bluetooth headset, a
sync cable, the power adapter and software CDs.

Company Esource Global

Price Rs 62,000 

Phone 0-9820522208

E-mail sales@esourceglobal.com

Web site www.motorola.com

Rating

1 2 3 4 5

Motorola MPx 

1 2 3 4 5

1 2 3 4 5



Just Bring It On

In addition to VCDs, DVDs and MP3 CDs, the Mitashi DIVX-
555 multimedia player can play MPEG4, JPEG, HDCD, and

many other media formats. A two-channel audio and com-
posite video cable to connect to a TV is also provided. Some
more supported features are wide-screen TV support, an S-
Video as well as Composite-out, a D-Sub connector to con-
nect to a PC monitor, SP-DIF coaxial and optical output,
Dolby Digital 5.1, Pro Logic II and DTS, to name a few.

We put it to test by playing DivX-encoded movies on
it, and it performed without any glitches. When a non-
standard compliant media is inserted in the player, an
easy, Explorer-like interface pops up so you can navigate
the folders on the media.

We then went one step further and tried to play a
movie encoded with the newer and now very popular
XVID (also an implementation of MPEG4) video compres-
sion and with Dolby 5.1 sound. We were pleasantly surprised
to see that it not only played the movie flawlessly, it also
correctly detected and played the Dolby 5.1 sound format. 

We then popped in the February 2005 Digit DVD, which
had lots of wallpapers, to see if we could view them. We
found that we could view all the images—even as a slide
show. Previews were available in the Explorer view. VCDs

and DVDs, as expected, had no problem playing. The image
quality in all these tests was crisp, and the colours vibrant.
Sound reproduction, both in 2-speaker and 5.1-speaker
modes, was also very good.

One thing to note is that the DivX-
555 has a 3D sound
processor that can
recreate

sounds according to
seven different preset environments, and

this feature actually worked.
Overall, this is a great player. Add a 29-inch TV and a 5.1-

speaker set, and what you have is a full-fledged home theatre.

Company Mitashi Edutainment Pvt Ltd
Price Rs 4,990
Phone 022-25006661
E-mail rakesh@mitashi.com
Web site www.mitashi.com                Rating
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Ozaki NB001

These two-channel speakers are specially
designed for notebook users. Encased in a

slim silver panel and weighing just 150 gm, the
device can be clipped onto the top of a note-
book, and it connects through the USB port. It
draws power directly from the USB port, so
there is no additional power adapter required.
What’s more, the bundled cable is detachable
and retractable, reducing the tangle of wires
you need to carry around.

The speaker configuration allows you to sim-
ulate a 5.1-channel surround effect, and you
can also adjust the sound to recreate
different environments such as a
living room, a hall, and sev-
eral others. Apart from
the manual
equaliser set-
tings, you can
also choose from a
range of presets.

With 1W RMS
output, the Ozaki NB001 speakers are not a
match for the 5.1 speaker system you have at
home, but are definitely better than most
speakers integrated into notebooks today. The
product is a worthy buy for executives who
would, for example, like to enjoy their own
music and movies in their hotel rooms
while travelling.

Company Rashi Peripherals
Price Rs 1,200
Phone 022-28221013
E-mail navinderc@rptechindia.com
Web site www.ozaki.us

Rating
1 2 3 4 5

1 2 3 4 5

1 Poor: Has serious drawbacks and needs improvement before it can be used for its target application. 2 Mediocre: Does not live up to expectations, needs improvment 
in many areas. 3 Average: Reasonably competent but nothing spectacular about the product. 4 Good: A good buy, better than most products in its category. 
5 Excellent: A brilliant combination of price, performance and features - far beyond expectations.

Please write to products@thinkdigit.com. The Digit Test Centre will be delighted to
respond to your queries.

Looking for more information on any of the products featured here?

A Lovely Spread

This 23-inch LCD from Benq overwhelms you with its size, and is a
pleasure to work with. It provides a range of connectivity options,

including DVI-D, S-Video, Composite, and D-sub—which means that other
than your PC, you can connect it to your DVD player, camcorder, game
box and so on.

The OSD menu is very easy to use, but the buttons are on the left face
of the panel, making it difficult to access. This model also has a picture-

in-picture feature. It offers a cool 155-degree viewing angle in the Movie
mode and 165 degrees in the Text mode,
making it a perfect choice for viewing with
friends around.

When we tested this model for
performance using DisplayMate, it returned
impressive results in the ‘Point Shape’ and
‘Visibility’ tests, where reproduction of a
fine dot, as well as text on a coloured
background, was crisp. The 16 ms response
time claim, however, was shattered in the
Passmark Monitor test, where tearing was

visible in a white block moving at 100 pixels
per second.

Graphics and CAD/CAM professionals who
need accurate colour reproduction and

accurate geometry must check out this panel. It is also
highly recommended for movie buffs who can afford it—it’s a

lovely 23-inch spread, apart from being an LCD!

Company BenQ India Pvt Ltd.
Price Rs 1,25,000
Phone 022-25705230 
Web site www.benq.com

Rating
1 2 3 4 5
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AMD Motherboards 
ASUS K8N-E Deluxe

Excellent performance and 
great features
Lacks PCI-Express
Contact ASUSTeK Computer Inc
Phone 022-56290785
E-mail info_india@asus.com.tw 
Price Rs 8,500

MSI K8N Neo Platinum (Gold)
Excellent performance and
good features
Lacks PCI-Express
Contact Cyberstar
Phone 0-9323809599
E-mail navin@cyberstarindia.com
Price Rs 7,500

Cell Phones 
Sony-Ericsson K700i 

Extensive feature set,
includes camera, MP3, FM
radio etc.
Fast processor
Contact Sony Ericsson
Phone 0124-2560808 
E-mail dhiraj.soni@
sonyericsson.com
Price Rs 17,500

Nokia 6600
Brilliant display screen,
Bluetooth
No FM radio, slow processor
Contact Nokia India
Phone 011-26779000 
E-mail Nokia.ebag@nokia.com  
Price Rs 14,999

Projectors
Acer PD11

High 1600 lumens bright-
ness support 
Big 330-Inch diagonal
image size capability
Picture in Picture mode
Contact Acer India Pvt Ltd 
Phone 080 25219520
E-mail rajesh_aiyar@acer.co.in
Price Rs 62,999

Sony VPL-ES2
Easy to set up
Low running cost of lamp
Good performance
Contact Sony India Ltd
Phone 022-28313333
E-mail chiragk@sid.in.sony. 

com.sg
Price Rs 75,990

CRT Monitors (19-inch)
Samsung SyncMaster 997DF

Good colour reproduction
Compact in size
Contact Samsung Electronics India
Phone 011-51511234 
E-mail marketing@

samsungindia.com
Price Rs 14900

Samsung SyncMaster 957MB
brightness modes for different
viewing environment
good colour reproduction
Contact Samsung Electronics India
Phone 011-51511234 
E-mail marketing@

samsungindia.com  
Price Rs 16500

PDA Phones
Nokia 9500 Communicator 

Full QWERTY keyboard
Slightly bulky
Contact Company: Nokia India Ltd
Phone 011-22677900
E-mail jay.bakshi@nokia.com
Price 39,359 

O2 XDA II Mini 
Small, thin and pocketable
One-handed operation not 
possible  
Contact Creative e-biz
Phone 022-23828100
E-mail creative@goldkist.net 
Price Rs 32,888

Portable Hard Drives
WD-Media Centre 250GB

Very low cost per MB 
Memory card reader slots

Contact Western Digital 

Phone 022-25851085 
E-mail ajay.kapure@wdc.com
Price Rs 15,999

Freecom FDH-2 Pro 80 GB 
Extremely compact and bun-
dled carry case
Contact J S Equipments
Phone 022-23810713
E-mail jse@vsnl.com
Price Rs 15,500

CRT Monitors (17-inch)
Acer AC715

high resolution of
1600x1200@75Hz 
good finer details 
reproduction 
Contact Acer India Pvt.Ltd.
Phone 080-5219520
E-mail rajesh_aiyar@acer.co.in
Price Rs 6,995

Viewsonic E71f
Aesthetically good looking  
good geometry reproduction
Contact Roop Technology Pvt. Ltd.
Phone 022-26680022
E-mail roop@vsnl.com
Price Rs 7500

Intel Motherboards
Gigabyte GA-8I915G Duo

Excellent Performance at an 
affordable price 
Contact Digi Giga System Ltd.
Phone 022-26526696 
E-mail sales@digigiga.co.in
Price Rs 5,500

Gigabyte GA-8I915G-MF 
Very affordable
Average performer 
Contact Digi Giga System Ltd  
Phone 022-26526696
E-mail sales@digigiga.co.in
Price Rs 5,100

The best products tested so far in different 
hardware and software categoriesThe A-List

March 2005

DIGIT APRIL 2005
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CMV-CT-722A
Inexpensive
Good pixel response time of 
16 ms
Contact Cee Vision Technologies
Phone 022-26733353 
E-mail chemoplastmumbai@

vsnl.net
Price Rs 17,000

Laptops 
ACI Emerald C2

built in web camera
Affordable price
Contact Allied Computer 
International

Phone 022-56943260  
E-mail hirji@aci-asia.com   
Price Rs 44,999
Website www.aci-asia.com

MSI MegaBook M510C
Terrific performance, typical
feature set
High screen resolution
Average wireless LAN 
performance 
Contact Maxtone Electronics
Phone 022-23011434
E-mail maxtone@vsnl.com
Price Rs 63,000

LCD Monitors (15-inch)
CMV CT-522A

High contrast ratio—500:1
Average quality inbuilt 
speakers
Contact Cee Vision Technologies
Phone 022-26733353
E-mail chemoplastmumbai@vsnl.net
Price Rs 12,000

LCD Monitors (17-inch)
Samsung SyncMaster 173P

Great design, superb contrast 
Quite Expensive
Contact Samsung India 
Phone 011-51511234
E-mail marketing@

samsungindia.com
Price Rs 30,000

Home Inkjet Printers
Pixma iP1000

Economical, decent photo
printing. 
No output tray, No pictbridge  
Contact Canon India Ltd
Phone 0124-5160000
E-mail www.canon.co.in

HP Deskjet 3745
Fast print outs, excellent price
Below par photo printing

Contact Hewlett Packard India Ltd. 
Phone 0124 2566 111
E-mail www.hp.com 
Price Rs 2999

Office Inkjet MFDs
Lexmark X7170

Full featured MFD, fast 
printing,copying speeds. Decent
quality photo prints
No memory card reader, B&W
LCD screen 
Contact Lexmark India Ltd.
Phone 022-2605 7755

Website www.lexmark.com
Price Rs 14999

HP PSC 2310
Excellent text printing, fast
photo printing
slow text printing, average
photo quality

Contact Hewlett Packard India Ltd. 
Phone 0124-2566 111
Website www.hp.com 
Price Rs 11499

Fujitsu S2020 
Hot swappable combo drive
Good graphic performance  
Average screen readability in
sunlight 
Contact Fujisan Technologies Pvt Ltd
Phone 022-56368718
E-mail gathani.paresh@

fujisan.co.in
Price Rs 78,000

Zenith Presidio Vu
Good battery life
Built in web cam and SD/MMC
card reader support
No recovery CD provided

Contact Zenith Computers Ltd 
Phone 022-28377300
E-mail kalpak_bhatt@

zenith-india.com 
Price Rs 70,000
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Office/ Photo Inkjet
Printers
Canon Pixma iP 3000

Fast, Excellent photo and 
text printing
No LCD 

Contact Canon India Ltd. 
Phone 0124-5160000
Web site www.canon.co.in  
Price Rs 8495

Canon Pixma iP 4000
Fast, Excellent photo and 
text printing
No LCD
Contact Canon India Ltd. 
Phone 0124-5160000 
Web site www.canon.co.in  
Price Rs 10995

Photo Inkjet MFDs
HP PSC 2608

Inexpensive, excellent and
fast text and photo printing
None
Contact Hewlett Packard India Ltd.
Phone 0124-2566 111 
Website www.hp.com
Price Rs 
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Pixel Palette
Meera Vankipuram

uring the Renaissance
period, artists such as
Leonardo da Vinci

attempted to observe, study, and
recreate objects with a greater
degree of realism than previously
existed. Renaissance artists
created lifelike images of people
and animals, set against back-
drops that presented the illusion
of depth and distance—like in the
famed Mona Lisa—by using
certain stylised techniques. 

Today, 21st century offerings
such as Adobe PhotoShop, Corel
Painter, Adobe Illustrator, 3D
Studio Max, Macromedia Free-
hand and SketchPro are helping
artists go where the palette and
brush weren’t able to—achieve a
greater degree of realism as well
as manipulate the ‘real’—through
the medium of digital art.

The term ‘digital art’ is expan-
sive—it can refer to purely
computer-generated art or digital

D

image manipulation (synoymously
used with terms such as ‘retouch-
ing’ or ‘morphing’) of images or
scanned photographs created on
vector-based programmes. 

The Medium Is The
Message
As a medium, computer-generated
art has, and continues to evolve
with technological advances. 

While traditional art was
confined to the canvas or paper,
computer art can exist in differ-
ent forms, such as images, an
animated sequence, video,
website, installation or ‘kitsch’ art
forms. Photo manipulation is
another emerging area of expres-
sion for digital artists. 

Today, most advertisement
banners (vinyl), animated films,
and SFX sequences also employ
variants of the digital art form.
Digital art is an integral part of
desktop publishing—consider
jacket-design for books and cover
design and/or layout for maga-
zines and other periodicals.

Many traditional artists view
digital art as a poor substitute for
‘real’ art. But, as artist and assistant
professor G V Sreekumar of the
Industrial Design Centre
(http://www.idc.iitb.ac.in/) at IIT-
Bombay says, “The visual grammar
of digital art is entirely different
from traditional art forms. Artists
shouldn’t try and recreate the
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The Web offers digital artists myriad resources to innovate and to enhance their skills

Web Resources 
GFX Artists: www.gfxartist.com
CG Talk: www.cgtalk.com
Sijun: www.sijun.com
Surf Union: www.surfunion.com
CG Tantra (Indian CG Community):
www.cgtantra.com
Furiae: www.furiae.com
Deviant Art: www.deviantart.com
Digital Art Museum: www.dam.org
ARS Electronica:
www.aec.at/en/index.asp
Rhizome: www.rhizome.org
Leonardo Electronic Almanac:
http://mitpress2.mit.edu/e-
journals/LEA/
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in its
v a r i o u s

guises—such as
interactivity, artifi-

cial intelligence, surveil-
lance systems, and so on, I
use the term digital art as a
reference to art created on a

computer and then printed
out as hard copy.”
According to Parthan, aspir-

ing digital artists ought to
“browse the Web regularly, to stay
abreast of recent developments.
They should not be afraid of
trying out new software and tech-
niques, and should also have a fair
understanding of the way infor-
mation technology is reshaping
our perception of the world.”

Apart from a digital camera
and a scanner, Parthan uses 3D
graphics and image processing
software to composite his digital
prints. “When I work with media-
based art such as interactive video
installations, I depend a lot on
Flash movies and action-script
coding,” he says.

Shankar, a freelance designer
based in Hyderabad nods in
unison. He is quick to point out,
“Digital art provides designers
like me the opportunity to create
paintings as authentic as those
created by using a real brush. In
addition, design software
provides different textures, back-
ground lighting options, and
many other useful features.”

For instance, software such as
Corel Painter offers options such
as Pencil, Charcoal, Acrylic, Oil
Paint, and Pastel to name a few
which help recreate the brush-
and-palette effect.

Cyber-Communities For
The Digital Artist
While most artists assert that
there is absolutely no substitute
to self-learning, meaning fooling
around with software and discov-
ering new shortcuts and effects,
cyber-communities are also a
useful resource for the cubicle-
bound design professional.

Digital art forums are akin to
the Guru-Sishya tradition where
commercial artists exhibit their
paintings, critique others’ works
and offer useful tips. Online
communities are a treasure-trove
of data, software tips and tricks. 

Designers, students of Fine
Art, and commercial artists use
the forums to interact with other
artistes, enhance their skills,
source projects, and offer invalu-
able guidance to their peers
and newbies.

Photographers like Atul
Sharma (http://www.atulsharma.
com/), based in New Delhi, who
use image-editing software for
digital manipulation and
enhancement, recommend
Adobe’s online tutorials. Read the
manuals carefully; but after a
certain stage, the artist has to
experiment with the software.
The more styles you try out,
the better your portfolio is
going to look.

International Web communi-
ties such as Deviant Art offer
newbies a platform to exhibit
their work. Art forums such as
CGTalk (www.gctalk.com), Sijun’s
Forums (http://forums.sijun.com),
a n d S u r f U n i o n
(www.surfunion.com) are also
popular haunts for digital artists.

Freelance designers like
Shankar rely heavily on forums
for work-related inputs, ideas as
well as constructive criticism.
“Not only do we obtain valuable
feedback on our work, we also
make a few good friends on the
forum… sometimes, people who
I’ve never met. Forums help us
share our thoughts, ideas, and
software tips with like-minded
artists,” he says. 

Perhaps the most interesting
facet of online communities is
the absence of the language
barrier. This reinforces the ‘art
has no boundaries’ dictum. By
facilitating knowledge sharing,
these cyber communities play a
greater role—nurturing, perhaps,
the Ravi Varmas and Van Goghs of
the digital world. 
meera_vankipuram@thinkdigit.com

same styles or effects, but should
treat the two media differently.”

Artists like Sreekumar who
first experimented with the digi-
tal medium several years ago still
remember the Apple Macintosh
fondly. “Back then we didn’t have
the WWW and relied on our own
experiments with Mac.” Sreeku-
mar currently uses Photoshop CS,
QuarkXPress, Macromedia Free-
hand and Fontographer. 

IDC, which believes in intu-
ition-based learning, conducts
workshops on design software
such as 3D Studio Max and Maya.
Sreekumar himself uses “forums
and the IDC Yahoo! Group” to
keep himself up-to-date on the
latest trends. Magazines such as
Folio, Computer Arts, and Publish
also offer valuable tips.

Today, digital artists have
access to tools that offer a wide
range of options—from colours to
styles to layers, perhaps imbuing
in them a greater urge to inno-
vate. Artists such as Baiju Parthan
(http://snipurl.com/dhio) for
instance, work extensively on the
digital medium.

Says Parthan, “Since there are
several forms of media art that
employ information technology

Digital Tools l Enhance

Guruspeak

Sanjeev Kothari (www.sanjeevkothari.com)
is a name to reckon with in the world of

digital photography and imaging. Hailed by
photographers and artists across the globe
as one of the most talented photographers
in the media today, Kothari has offered his
expertise to Adobe in the development of
Photoshop 3 and 4. Currently based in New
York, Kothari’s work has been featured in
Entertainment Weekly, GQ, Wired,
Newsweek, Time and Fortune. His
philosophy regarding photography is
“to embrace every possibility, digital or
analogue, in the process of creating a
more meaningful picture.”

Q: How does one evolve as a digital artist?
A: Well, I started off with Photoshop, then
moved to Illustrator and other 3D programs. I
think in an evolving medium, a combination of
skills and inclination to innovate is imperative. 

Q: Design software you work with?
A: I primarily use Adobe's PhotoShop CS for
photo design.

Q: Do you use any Web-based resources to
upgrade your skills?
A: I frequent Shift (shift.jp.org), a Japanese e-
zine that features new and innovative design
and photography.

Aspiring
digital artists
should not be
afraid of
trying out
new software
and
techniques  
Baiju Parthan
Painter and 
Digital Artist



With a fair bit of technology
skills (typing and word processing
skills, being PC literate), entrepre-
neurs can use the worldwide web
to start companies and work from
the convenience of their homes. A
network security firm in Mumbai,
for instance, sourced almost all its
initial jobs from the Internet—
crawling through Google, adver-
tising the website, and improving
its page ranking on search engines
so that users looking for a certain
security solution, would hit their
site as soon as they entered the
particular keyword. 

Before you get into the home
employment groove, make sure
you have the requisite qualifica-
tions, hardware, and time-
management skills to convince
potential employers that you are
the right person for the job.

The Checklist
Make The Right Choices
Before you consider quit-
ting your day-job or begin

working from home, take a piece
of paper and list out your skills,

preferred areas of employment,
and your comfort-level in each
area. For instance, if you are a
programmer, weigh the benefits
of home employment versus
working in a corporate environ-
ment. If you are a student, chart
out your daily schedule and
figure out how much time you
can spare for a ‘part-time’ job,
even if it doesn’t involve stepping
out of home. 

Remember, you may or may
not earn as much as you would in
a full-time job, and freelance proj-
ects take time to source and
payments are delayed, in some
cases. Zeroing in on the right kind

Meera Vankipuram

here is no such thing as a
free lunch. Neither is
there an easy way to earn

money, especially from home. To
make yourself employable, you
need to ensure that you have the
required skill sets as well as good
marketing and interpersonal
skills. A sound portfolio (for aspir-
ing writers, editors, photogra-
phers, designers, et al) is a must. 

Today, several private compa-
nies and MNCs are employing
people who prefer working out
of their homes. A host of oppor-
tunities exist for home employ-
ment in areas as diverse as
telemarketing, selling insurance,
data entry, accounting, writing
(academic and journalistic writ-
ing), editing and proof reading,
web design,  content develop-
ment, Internet-based research
for companies, graphic design
and desktop  publishing,
programming, audio and video
editing, and translation. 

Your Ten-Step Guide

T

Home employment is not merely about registering on a website. It requires a lot of effort,
active networking and acquiring requisite skill sets

Illustration Shyam
 Shriram

To Home Employment
Your Ten-Step Guide
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The story titled ‘Home Is Where The
Money Is’ featured in the February
2005 issue received nearly 700 
e-mails, from readers across the
country. While we cannot source jobs
for our readers, we can recommend
methods using which you can make
yourself employable, without enter-
ing the ‘corporate rat-race’.



people (www.it-people.com), and
Times Jobs (www.timesjobs.com) to
get a basic understanding of the
job profile. Use Resume Builder on
these sites (needs registration) and
on MS Word. 

Set Up A Web Site Or Blog
Create a good web site
(one that’s not too garish,

text or image heavy). Use services
such as Godaddy.com or
Net4India.com or free services
such as, Geocities to purchase
domain space. If you are a free-
lance photographer or graphic
designer, put up thumbnails of
your work on the site. You could
also set up a web log (blog) on sites
such as Blogger.com and LiveJour-
nal.com. Don’t forget to provide
your e-mail address, resume, and
contact details at a prominent
location on the site. 

Browse the Web
Use the best search
engines in the business

(Google, Yahoo!, MSN Search, and
the right keywords (‘freelance
programming’, ‘freelance transla-
tion’) to find the jobs you want.
Don’t provide personal details
while registering on a website
unless its absolutely essential.
Rent-a-coder (www.rentacod-
er.com), a freelance-sourcing site
has a ranking system to rate the
work of freelancer programmers,
and help companies choose
people best suited for a particular
project. Guru.com (www.guru.co-
m) and I Hire Programmers
(www.ihireprogrammers.com) are
other popular freelance sites.

Network
It’s very, very important
to ‘connect’ with the

outside world. Join networking
groups such as Friendster
(www.friendster.com) and Ryze
(www.ryze.com), have your blog
linked to blog rings, and enroll in
forums, user groups and other
specific online communities. A
caveat—online communities have
their own set of protocols and
etiquette. Remember to follow the
rules; don’t forward your resume
to everyone you meet. 

Create A Work 
Schedule And Meet
Deadlines

Create a ‘work culture’ for your-
self. Just because there is no ‘boss’
breathing down your neck, you
can’t afford to slacken or miss

of job is important. Don’t get
stuck with a job you don’t like.  

Set Up Your 
Workstation
Once you have narrowed

down your choice of employment,
you can set up your workstation.
You need to make sure that your
future work area is very comfort-
able—use ergonomic furniture,
wherever possible. 

For Writers/Editors: A fast
PC is a pre-requisite, you may also
have to install software such as
MS Office/Open Office, QuarkXP-
press or Adobe InDesign. 

For Designers: Although it’s
not important to invest in a Mac
(Apple Macintosh), make sure
your PC has enough RAM (at least
1GB), hard disk space, and install
a good graphics card. You also
need to install a design software
such as Adobe Photoshop, 3D
Studio Max, Quark, Corel Painter,
or Adobe InDesign. 

For Data Entry/Typing Assign-
ments: A computer, MS
Office/Open Office, or other data-
entry software. 

For Medical Transcription:

Medical transcription involves
transcribing medical records
dictated by doctors (patient
history, records, notes, lab reports),
usually located in clinics abroad.
Basic requirements include a PC
with about 20 GB hard disk space,
256 MB RAM (minimum), sound
card and Internet access. You
would also require headphones,
word processing software, and a
good dictionary.

Prepare Your Portfolio
Prepare a good resume,
entering the right key

words under ‘Objective’. Use sites
like Monster (www.monster.com),
JobsAhead (www.jobsahead.com),
Naukri (www.naukri.com), IT-

A caveat—
online
communities
have their
own set of
protocols and
etiquette.
Remember to
follow the
rules; don’t
forward your
resume to
everyone you
meet. 

Use the Resume Builder feature on job-sites to
prepare a top-notch resume

1 col AD
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deadlines. In fact, you have to work
twice as hard to ensure that the
companies/clients hiring you have
absolutely no reason to regret
employing a freelancer. 

Sell Yourself
Be your own boss, and
brand manager. While it’s

important to have an online pres-
ence in the form of a website or
blog, it’s equally important to be
aware of competitive pricing and
different payment strategies. 

Do not charge your clients less
because you are working from
home. Make enquires pertaining
to the market rates for a particu-
lar project (say, web-design or
coding), and charge them accord-
ingly. Also, do not under-rate or
over-rate your skills; and do not
undersell or oversell yourself. Be
as honest as far as possible.

Tip: To ascertain that Google
throws up your site when users
enter a certain keyword, make the
title of your web page very specific
(‘Fashion Photographer’ or ‘Free-
lance Writer’ as the case may be).  

Ensure that your site is linked
to other prominent ones, by
publishing research papers online,
being part of active online commu-
nities or regularly updating your
web log with quality content. 

Upgrade Your Skill-sets
When you have time,
enrol in training sessions,

part-time diploma courses or
distance education programmes
to upgrade your existing skill sets.
With technological advance-
ments, there will be rapid
changes in the employment
scenario as well. 

The IT industry, for instance,
is continuously evolving. You may
have to invest in software courses,
at least once every year, to learn
new programming languages,
improve your design and editing
skills, and so on. Not upgrading
your skills periodically would
reduce your chances of employ-
ment, in any field.

Exercise Regularly
As the maxim goes,
health is wealth. Working

from home may reduce your
travel time but it might also bring
to a halt the little exercise you
were getting earlier by walking to
and from the train or the bus
station. To ensure that you give
your best to the projects you
source, some physical exercise,
yoga, and meditation sessions
coupled with a balanced diet will
help you stay mentally and physi-
cally in good shape. 

Choose Your Weapon
Browse through the classifieds of
your local newspaper. There are
plenty of opportunities to ‘earn
from home’, from growing mush-
rooms, to clicking on advertise-
ments. Web Sites such as,
click2freemoney.com, for example,
employ people to click on websites
and ad banners, in return for cash
payment made through PayPal.
The site currently pays 40 paise to
Rs 2 (or 40 points to 200 points) per
click, depending on the advertis-
ing revenue. You might have to
‘share’ some of the moolah with
middlemen who charge a ‘commis-
sion’ on daily earnings.

But what makes the difference
between a sustainable source of
income and a flash-in-the-pan job
opportunity is how you go about
preparing yourself for a sustained,
long-term effort.  

As Confucius says, “The
mechanic that would perfect his
work must first sharpen his tools.”
So are you ready to hit the home-
employment road?
meera_vankipuram@thinkdigit.com
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Disclaimer: DIGIT does not claim
responsibility for a) the accuracy of infor-
mation on the websites we recommend,
and b) any damage arising from the use
of such services.
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Ram Mohan Rao

1. When you paste text from a
Web page, you get all
unwanted formatting too
Reason: Word XP was designed so you
could choose to either paste content as it is,
or modify it to match the destination
formatting, or keep only the text.
Unfortunately, as it oftern happens, Word
takes a long time to convert the Web page
formatting to either plain text or to the
destination formatting.

Solution: Use Paste Special. Go to the
menu Edit > Paste Special > As Unformatted
Text, and click OK. You can also use the

keyboard shortcut sequence, which is [Alt]
+ [E] > [S] > [U] > [U] > [Enter].

2. Horizontal lines that you draw
don’t get deleted
Reason: When you draw a horizontal line
using underscores, some of the lines get
converted to double lines, and you find
that deleting the lines and pressing [Enter]
only results in more lines coming up. This
happens because of the AutoFormat and
Borders defaults in Word.

Solution: Once you have a document
with some lines that you would like to
remove, go to Format > Borders and
Shading > Borders and click ‘None’. Also
go to Tools > AutoCorrect Options >
AutoFormat As You Type, and under ‘Apply
as you type’, uncheck ‘Border lines’. At a
later stage, you can enable the ‘Border
lines’ and draw horizontal lines the way

you want. Remember, doing this will
change the setting in the ‘Borders and
Shading’ menu, so you will need to
readjust that if you would like to remove
the lines again.

3. Word keeps trying to help you
Reason: This, of course, is an inbuilt
feature—Word was designed to help you
as often as you might require it.

Solution: Go to Tools > AutoCorrect
Options, and make changes under all five
tabs. For instance, under ‘AutoFormat’,
you can remove the automatic
hyperlinking of Web addresses; under
‘AutoFormat As You Type’, you can
remove the automatic generation of

bulleted lists. Set everything the way
you want it, so Word will help you as
little or as much as you would like it to.

4. Word crashes or freezes as
soon as it opens, or doesn’t 
open at all
Reason: The odds are that your global
template is corrupt, or something is
loading automatically in your Word
Startup folder that is wrongly configured.

Solution: To check if it’s a corrupt global
template or some add-in that is loading
on startup, go to Start > Run and key in
“winword.exe /a” without the quotes. If
Word launches fine, then it is mostly a
bad normal.dot file or a corrupt add-in.
To get yourself a new, uncorrupt
template, simply close Word and search
your computer for the ‘normal.dot’ file,
and rename or delete it. If you find more

than one instance of normal.dot, rename
or delete all of them. When you launch
Word again, it will look for ‘normal.dot’,
and if it cannot find it, Word will create
a new one.

The usual location for ‘normal.dot’ is
<Drive Letter>:\Documents and
Settings\<Your Username>\Application
Data\Microsoft\Templates

5. Inserting foreign characters 
is a pain
Reason: In order to insert a special or
foreign character, you can either use the
Insert menu or the Character Map. In
case you feel wary of the thousands of
signs that appear, there is an easier way
to do it—using keyboard shortcuts.

Solution: Here are the keyboard
shortcuts for various symbols:
à, è, ì, ò, ù, À, È, Ì, Ò, Ù: [Ctrl]+[`]
followed by the letter
á, é, í, ó, ú, ý, Á, É, Í, Ó, Ú, Ý: [Ctrl]+[‘]
followed by the letter
â, ê, î, ô, û, Â, Ê, Î, Ô, Û: [Ctrl]+[Shift]+[^]
followed by the letter
ã, ñ, õ, Ã, Ñ, Õ: [Ctrl]+[Shift]+[~] followed
by the letter
ä, ë, ï, ö, ü, ÿ, Ä, Ë, Ï, Ö, Ü, Ÿ: [Ctrl] +
[Shift]+[:] followed by the letter
å, Å: [Ctrl]+[Shift]+[2] followed by a or A
æ, Æ: [Ctrl]+[Shift]+[7] followed by a or A
œ, Œ: [Ctrl]+[Shift]+[7] followed by o or O
ç, Ç: [Ctrl]+[,] followed by c or C
ø, Ø: [Ctrl]+[/] followed by o or O
¿: [Alt]+[Ctrl]+[Shift]+[?]
¡: [Alt]+[Ctrl]+[Shift]+[!]
ß: [Ctrl]+[Shift]+[&] followed by s 

ram_mohan@thinkdigit.com

Microsoft Word

When copying and pasting text from Web
pages, you often don’t want the formatting
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Word giving you trouble? Here are five common niggles,
and what you can do about them

Go to all five tabs in the AutoCorrect options to
customise the way Word helps you

For foreign characters you can either use
‘insert symbol’—or keyboard shortcuts
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Auto-starting Viruses

I have a Pentium III 500 MHz CPU, 128 MB of
RAM, and an 80 GB hard disk running

Windows XP Pro. My computer was
infected by the W32.Passma virus, so I
loaded Norton AntiVirus 2004
Professional and even updated it, but to
no avail. Norton detects the virus and
deletes files but does not clean the virus
out. Help me get rid of this infection!

Girish

Removing autostart entries from
the registry prevents the malware

from executing during startup. Here’s
what you need to do:

Log on as Administrator and open
the ‘Registry Editor’ by going to Start>
Run, typing ‘regedit’, and pressing
[Enter]. In the left panel, navigate to
H K E Y _ L O C A L _ M A C H I N E \ S O F T W A R E \
Microsoft\Windows\CurrentVersion\Run and
locate and delete the entry ‘Service Manager =
“%System%\SERVICEMGR.EXE”’. Close the
Registry Editor.

The next thing you need to do is turn off
system restore by pressing [Windows]+[Pause/
Break] to go to system properties, click on the
System Updates tab and check the ‘Turn off

System Restore on all drives’ box. Click ‘Apply’
and then click ‘OK’.

Start Norton AntiVirus, scan all drives and
let it delete infected files. Reboot the
computer after the scanning is done and
then, if you want, re-enable System Restore.

Overheating Blues—Again

I have an original Intel 865 GBX mother-
board with an Intel Pentium 3.0 GHz proces-

sor, 256MB of DDR RAM and an 80 GB HDD. I use
an I-Box compatible cabinet. The problem is, my
system heats up very quickly. I check the
temperature using active monitor; immediately
after being switched on, the system temperature
rises in no time. I have installed an additional fan
and also got the internal cables neatly fixed to a

side, but the problem persists. Please
suggest what I should do. 

Kamesh

It is extremely likely that your CPU
fan is not mounted properly, and

that the thermal paste has not been
applied correctly. If that is not that case,
then you have to check and make sure
that your cabinet is properly ventilated.
Simply adding extra fans won’t neces-
sarily solve the problem—the ventilation
may not be adequate, and it is possible
that your fans are circulating the same
hot air inside. 

An ideal setup would be where a
front fan sucks in fresh cool air from the

outside, and a rear fan sucks the air out from
the rear of the cabinet, thereby ensuring
there is cross ventilation in the cabinet. This
is gauranteed to keep the temperature at
acceptable levels.

Mismatched Modules

I have a Pentium 4 2.26 GHz and a Mercury
motherboard with two memory slots. Each

slot can hold a 1 GB RAM stick. There’s 128 MB
DDR RAM installed in one slot. I would like to
install a 256 MB stick in the vacant slot. Would
there be a problem if I have two memory slots
with memory modules of different capacities?

Goutam Ghosh

There should be no problem with putting
in RAM modules of different capacities.

However, you might encounter problems if
the RAM frequencies are different. 

If you would like to check your RAM
frequencies, download a software called
Everest from www.lavalys.com. Insert one
module at a time and check for the core
frequencies. If they match, you will most
probably not face a problem. 

However, it is not a sure-shot testing
method, as different CAS (Column Access
Strobe) latency timings might conflict. If the
core frequencies match, you can put in the
chips and test your system for stability. If the
system is stable, keep them inserted, else
discard the 128 MB module.

Your Questions, Our Answers

Open the System Properties dialog box and check the
‘Turn off System Restore on all drives’ option
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CD vs VCD vs DVD

I recorded and saved a TV programme using
Pinnacle PCTV, and did a bit of editing using

Virtualdub. I saved the file as a .avi file, and then
compressed it to Windows MPEG. After that I
burnt it onto a CD. Unfortunately, the CD does
not play on my Philips DVD player, but it does
play on my PC. Why? 

K N Prasad

Your DVD player probably does not
support MPEG videos. To view it using

your DVD player, burn a VCD rather than a
regular CD. Your CD-burning software will
then convert the file to a VCD-compatible
format. You should be able to play the VCD on
any regular VCD or DVD player. 

However, keep in mind that depend-
ing on your specifications of your
computer, the encoding process can
take quite some time.

I Changed My Mind…

I recently downloaded a BIOS update
from Intel’s Web site. But now, I

would like to roll it back. I want to know if
there is a  way to uninstall or remove the
update? I have a P4 1.7 GHz computer, and
the board is an Intel D845GLLY.

Bishesh Bhatta

It is possible to roll back your BIOS
by re-f lashing it with an older

version. If you have saved your previous BIOS,
you can simply flash it from that particular
file. If you didn’t save your previous BIOS, you
will need to download that version of the BIOS
from the manufacturer’s Web site.

Please be very careful while flashing your
BIOS as it can render your motherboard unus-
able if done incorrectly.

Old Is Gold

I own a P4 3 GHz CPU on an Intel mother-
board. There are two 40 GB partitions on my

HDD. I use Windows XP on  the C drive, and Win
98 SE on the D drive. My current default OS is
Windows XP, but I would like to set Windows 98
as my default boot OS.

I would also like to modify the default time
for which the boot menu is displayed.

Sanjay Kapoor

As it happens, you don’t need to go into
the BIOS for this. You can do this right

through Windows XP, by keeping XP in
control of what happens during the boot
process. Boot into XP, and under My
Computer>Properties, go to ‘Advanced’, and
click on the settings button in ‘Startup And
Recovery’. Under the default operating
system drop-down menu, you can choose the
operating system you would like to boot into
by default.

In the same window, you can also set the
time limit for displaying the boot menu.

Rolling Back DirectX

I am using Windows XP with SP1. I recently
installed DirectX 9.0c from the Digit DVD.

Can I uninstall it? Or can I simply install an older
version over the newer version? Will this affect
my system in any way?

Raj Pratap

It is not recommended that you roll back
or uninstall DirectX, as it is closely inte-

grated with your video drivers. Also, you will
not be able to roll back to a previous version
at one go. You will need to download a utility
called DirectX Uninstaller, located at
http://snipurl.com/dd6y. This lets you uninstall
your DirectX version 9.0c, and if you want,
you may then install an earlier version.

Spyware Blues

I run Windows 98 SE, and every time
I open Internet Explorer, I am taken to

a site called www.cursormania.com. Even
while browsing, I am often taken to this
page. What do I do?

Via E-mail

Your computer has been infected
with spyware from companies such

as Smiley Central. For some reason, the
makers of Spybot Search and Destroy
have deemed this particular piece of
spyware a safe application, which
means you cannot use that software to

uninstall this application. You will have to
remove it manually. 

Go to Start>Run and type in “appwiz.cpl”,
which opens Add/Remove Programs. Find the
application called “My Web Search (Cursor
Mania)”—it should be there in the list—and
then uninstall it. 

Also look through the application list for
programs from FunWebProducts, such as “My
Web Search”, “My Way Speedbar”, “Search
Assistant”, and possibly others. 

You can download HijackThis from
http://snipurl.com/dd6z—download and run it.
Also go to C:\Program Files, and delete all the
folders that FunWebProducts, MyWebSearch
and other similar Web sites created. This
should rid you of your problem.

Programs such as MyWebSearch can get installed auto-
matically—you can uninstall them manually
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Increase Your Browsing Speeds

Slow connection speeds have always been
the bane of Internet users in India. Even
‘broadband’ connections aren’t exactly

lightning fast. India has more than one million
Internet connections, out of which most users
are on a dial-up or pseudo-broadband connec-
tions provided by the local cablewallah. For a
dial-up user, waiting for ages for a page to load
is the norm. 

So, is there any light at the end of the
tunnel? Well, there just might be. A British
company, Onspeed, has launched a paid service
that claims to increase your Internet speed by
as much as 5X on a dial-up, 3X on a broadband
and 8X on a GPRS connection. The utility works
on Windows and Mac platforms. However, Linux
users will have to wait a while for their version.

Modus Operandi
Onspeed has developed an algorithm that
performs a ‘content-sensitive compression
(CSC)’. This means that it doesn’t blindly
compress anything and everything, but the
compression ratio is applied depending on the
content. At present, Onspeed compresses JPEG,
PNG, GIF, BMP, HTML objects, texts, office docu-
ments such as Microsoft Word, Excel,
PowerPoint, and Flash files. It also works for e-
mails. According to Onspeed, the service was
actually developed for the US military, and later
released as a service in the public domain. 

Content-sensitive compression is the name
given by Onspeed to nine patented compression
technologies, which work in the background to
compress the data. This novel idea takes the
approach of compressing data flowing through
whichever Internet pipe is available rather than
going for the thicker, costlier Internet pipes. The
compression is done on the fly by the Onspeed
server (http://helium.onspeed.com) and the
final data is sent to you. So, you do not have to

change your ISP or get any additional hardware.

Let’s Get Started
Since this a software solution, all it asks for is, a
modest 200 MHz processor, 128 MB of RAM, and
10 MB of hard disk space. The download size of
this utility is a mere 1 MB. So even your dial-up
connection can download this neat piece of code.

Go to www.onspeed.com and sign up for
an account. Once you pay for the service using
your credit card, the download will commence.
Double click on the .exe file when download
completes to start the installation, and that’s it.
You do not need to change any of your dial-up
network settings or any settings from your
Network Connection dialog box if you are on a
broadband connection. 

A green Onspeed icon will appear in the
system tray at the end of the installation. Click on
this to start the service. It will ask for a login
name and password. You must make sure that

you are connected
to the Internet as it
authorises your
login and password. 

Right click the
system tray icon
and click ‘Settings’.
This will present
you with four
options, namely,
Image Quality,
C o n n e c t i o n ,
Feature, and
Update.

From Image
Quality you can set the compression ratio for
the image, from high acceleration to best
quality. When set to very high acceleration,
the browsing speed will increase, but at the
cost of the image quality. We used a dial-up
connection to test this. At default settings
when we downloaded a 400 KB image, it was
compressed to 148 KB. We were getting
around 2.1X to 2.5X acceleration and Onspeed
was reporting a ‘Current Connection Speed’
of 37 Kbps. This speed is half of what
Onspeed claims but the pages were loading
really fast.

When the acceleration was set to a maxi-
mum, a 168 KB image was compressed to a
mere 34 KB. However, the pixilations were quite
evident—something that might not appeal to
everyone. If the slider is moved to ‘Good image
quality’, the original size of the image will be
retained. This will in turn decrease your brows-
ing speeds, defeating the whole purpose of
having the service. To work around this issue,

Onspeed has
added an extra tab
called as ‘Show
Original Image’.
This feature loads
the original image
from the site,
giving you the
freedom to view
select images at
their true
resolutions.

What Else?
Apart from increasing the browsing speed
Onspeed also has pop-up blocker and in-page
advertisement blocking. However, every time
a pop-up was blocked an irritating beep was
emitted. However, this can be turned off.
Onspeed also worked with the Windows XP
SP2 default firewall, without any problems.
Currently the service does not support .exe,
mp3 and Mpeg4 files. But the next version,

expected by mid-2005 will offer supports for
these formats as well. An Update tab
provided within settings eliminates the need
to go to the Onspeed site. 

The Cost Factor
This service is available for £24.99 per year
(Rs 2,100), or roughly Rs 175 per month. The
amount is negligible if we consider the
amount of time it saves by speeding up your
connection. A dial-up user rarely downloads
programs, therefore it still makes sense to
opt for this service, even if it can’t handle
.exe and mp3 formats as of now. The good
part is, it can be used in any part of the world
and can be easily purchased online from
www.onspeed.com. 

Move the slider to the
left for speed and to the
right for image quality

Type in your username and password as you
entered them during registration

Enable email compression and pop-up
blocker from here

The dialog box displaying
an increase in speed
after starting Onspeed

Have you given up over your sluggish Net connection? Check out Onspeed—a paid service
that claims to increase your browsing speeds and block irritating pop-ups 
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Modem Madness

I own an AMD 2400+ based PC with an Asus
motherboard and 256 MB of DDR RAM.

Recently, I installed XP and a modem (Motorola
SM65). I didn’t have the XP drivers for it, so I
installed the Windows 2000 drivers. My PC
restarted just as the installation was about to
complete. It kept restarting during the POST
period. I thought it was a hardware problem, so I
removed the modem, and the PC started. 

I then downloaded the XP drivers, and
again put on the modem. This time the PC
started—then, just as I was installing the
drivers, the PC restarted yet again, and it
kept restarting until I disconnected the
modem. Is this a hardware problem? If so,
why does it happen only after I try
installing the drivers?

Via E-mail

Download your modem drivers from
the Motorola Web site at

http://snipurl.com/dd6v. Now, go to My
Computer>Properties. Under the
‘Hardware’ tab, click on ‘Device
Manager’; your modem should be listed.
Click and uninstall it completely. Reboot your
PC and re-install the modem. If the problem
persists, try installing the modem on a differ-
ent computer; if it installs there, then you
need to extract your modem driver files into a
folder, go to ‘Device Manager’, select your
modem, and under the ‘Driver’ tab, click
‘Update Driver’. Give the location as that of the
folder into which you extracted your drivers. It
should work now.

The Sound Of Linux

I have a Pentium III 800 MHz with 256 MB of
SDRAM. I also have an Xwave QS3000A PCI

sound card. The problem is my sound card does
not work under Red Hat Linux 9.0. I have

searched and asked all the technicians I know for
various solutions, but none seems to be working.
Is there any way I can use my sound card with
Linux, or will I need to go in for a new one?

Sanjeev Prakash

Red Hat Linux 9 by default does not come
with bundled drivers for your particular

make of sound card. But your Linux-specific
drivers are available at www.alsa-project.org.

Download the following from the main
page: library, utilities and tools. Now,
uncompress the files and recompile the
Linux kernel with the new drivers. Your
sound card should work now.

Partitioning Woes

I have a Pentium 4 3.2 GHz processor
with 512 MB of DDR RAM and an 80

GB HDD. I have been using Windows 98,
and now want to install windows XP Pro. I
would also like to keep Windows 98.
However, my hard disk is not partitioned,
and I do not want to format it. Is there a
way to partition a disk without formatting
it? Or, can Windows XP and 98 SE be

installed on the same partition? 
Nitesh Kumar

You can install Windows XP and 98 on
the same partition by specifying differ-

ent installation folders. This, however, can
lead to various conflicts as the two OSes use
entirely different drivers and system file
versions. The best way to do it is to install the
OSes on different partitions. 

One of the best softwares that will let you
accomplish this is Partition Magic 8.0. You can
download it from http://snipurl.com/cbdk.

Note that you will need to purchase the
software, as the demo version only shows you
the partition creating process and will not
actually create any partitions. 

E-mail us your comput-
ing problems aalloonngg  wwiitthh
yyoouurr  ccoonnttaacctt  ddeettaaiillss to
sos@jasubhai.com, and
we may answer them
here! Since we get more
mails per day than we
can handle, it may take
some time for your
query to be answered.
Rest assured, we are
listening!

Get Help Now!

Windows Is Not Windows

I copied the Windows XP SP2 final file from the Digit
September 2004 DVD. When I tried to run it, the applica-

tion extracts all the files but then displays “The core system
file (Kernel) used to start this computer is not a
Microsoft Windows file. The service pack will not be
installed.” Setup then aborts. How can I install SP2? I
have a Pentium III 1.14 GHz and 256 MB of SDRAM
running Windows 98 and XP Professional.

Ram Kishore

This happens when your computer has a modified
version of the Ntoskrnl.exe file that uses the /KERNEL

switch in the Boot.ini file. This is due to a third-party
application, such as BootXP or LogonUI Boot Randomiser,
which customises the graphics that are displayed when
your computer starts up. 

To solve this problem, go to Start>Run, type in
“appwiz.cpl” and press [Enter]. Select the program name you
installed that customises startup graphics, and click ‘Remove’.

Now restart your PC
and try and install SP2.
If this still doesn’t
work, press [Windows]
+ [Pause/Break] and go
to the Advanced tab
and click on the
‘Settings’ button
under ‘Startup and
Recovery’. Under
‘System Startup’, click
‘Edit’—this will open
the ‘boot.ini’ file in
Notepad. Locate and
delete the line
containing “/KERNEL
=”, and save and close
the boot.ini file.
Restart the computer,
and you should be
able to install SP2.

Question 

of the

Month

Here’s where you edit the startup options file



71DIGIT APRIL 2005

Digital Tools l Agent 001

The other day I received a message from my
dearest friend Abhijeet—no, not the Indian
Idol guy—he had just bought a Sony

Ericsson P910. I was eager to meet him, not just to
tinker with his new toy, but also to show off my
new Nikon digicam. We decided to meet up at his
house and then go out to grab a ‘byte’ to eat.

I arrived, promptly 30 minutes late, as is
my trademark. Abhijeet answered the door,
earphones dangling from his ears. Did I men-
tion that he’s a music fanatic? Even at school,
when we would bring tiffin-boxes, Abhijeet
would bring his Walkman! 

Twenty minutes later, we were sitting at our
favourite Punjabi restaurant. Between mouth-
fuls of Chhole Bhature, Abhijeet complained about
the dearth of memory in his phone. He could
never have enough memory for his MP3s. I
realised that my Nikon’s 16 MB of internal mem-
ory was also far from sufficient for a
shutterbug like me. It was decided that soon, we
would embark on a search for good flash
memory bargains. 

The next day, driving to our destination, I
began explaining why people need to be
careful when buying flash memory.
Quite often, they end up buying the
wrong type of card, because they
don’t realise there are various
types of flash memory—
CompactFlash (CF), MultiMedia
Card (MMC), SD (Secure Digital),
xD-Picture card, Memory Stick
Pro/Duo, and many more.

For digital cameras, the most
commonly used format is
CompactFlash. It’s a large card, and
is used in the medium to SLR range of
cameras. But that’s not all: you have
CompactFlash I and II formats as well, and
your camera supports either of the two.
MMC and SD cards are most commonly
used in PDAs, cell phones, camcorders, and
the like. Newer phones, such as Nokia’s
6600, 9500 and 7710, use an enhanced ver-
sion of the MMC card, called Reduced Sized
MMC (RS-MMC).

Most Sony digital cameras and cell phones
use Sony’s proprietary standard called Memory

Stick, and this has three different formats—the
original Memory Stick PRO, Memory Stick Duo
and Memory Stick PRO Duo, which vary in capac-
ity. The xD-Picture card, by Olympus and Fuji, is
extremely small and provides up to 1 GB of stor-
age space.

We knew that the two best places to shop for
flash memory in Mumbai are Heera-Panna and
Alpha shopping centre. We visited Heera-Panna
shopping centre first, and straight up, spotted a
swanky-looking shop that had digicams and MP3
players on display. I walked in and asked for a CF
memory card for my camera, as usual playing as
dumb as possible. “There are many brands of CF
cards; SanDisk is well known for its performance
and reliability, and Lexar media is another well
known brand that you should look out for,” I was
told. Apparently, both these brands have special
Compact Flash ranges for professionals that offer
higher speeds—especially good for those into
sports photography. The highest capacity you
can buy is 8 GB, but the vendor told me that he
would have to call someone to enquire about the
price—and was only willing to do so if I was seri-
ous about buying it. I wasn’t, and decided to
drop the subject.

I asked for MMC and SD cards, and was
shown Panasonic, SanDisk, Lexar and Kingston
cards. The highest capacity available for stan-
dard MMC cards was 128 MB. Then I saw a

Kingston MMC Plus format that offered a
whopping 1 GB of space. SD cards were avail-
able up to 1 GB as well.  

When I asked for a Sony Memory Stick, I
was shown original Sony Memory Sticks as well

as those manufactured by third-
party vendors such as Lexar

and SanDisk. The price dif-
ference was negligible,
and I was told that the
maximum capacity sup-
ported by the Memory
Stick format is 1GB. 

I also asked to see a
card reader—it eases the task of transferring

data to and from the PC to assorted cards of dif-
ferent formats. I saw a 7-in-1 card reader for Rs
400 and a 19-in-1 card reader for Rs 550.

Eventually, we never made it out of Heera-
Panna, and I ended up buying a SanDisk 512
MB CF card for Rs 2,400 and the 7-in-1 card
reader for Rs 350. We also got a good bargain
for a 512 MB Sony Memory Stick for Abhijeet’s
P910—Rs 4,500.

Agent 001

The highest
capacity of
Compact Flash
card that you
can buy is 8 GB

MemoCards Demystified
CF, MMC, RS-MMC, SD, xD-Picture... huh? Here’s the straight dope on memory cards

Want more of Agent 001? Turn over to read his
answers to your buying questions

Capacities

128 MB
256 MB
512 MB
1 GB

Memory
stick Pro
1,100
3,000
5,000
7,000

MMC 

800
1,300
2,000
4,200

SD 

950
1,500
2,700
4,300

xD

1,000
1,700
3,000
NA

Compact 
Flash
NA
1,500
2,400
4,000

Memory Card Price List (Rs)

Illustration Shyam Shriram
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Where, And How Much?

I want to purchase an AMD Athlon 64-bit 3000+
Processor and an MSI K8N Neo Motherboard,

but my retailer says it is not available. Where can I
find retailers dealing in these products, and what
would the prices be like? 

Manish

I cannot give you the address of a specif-
ic retailer in your locality, but I can give

you the details of distributors who may be able
to tell you where to purchase the items from.
The distributors for AMD processors are Tech
Pacific, and can be contacted at 022-55960101,
and for the MSI motherboard, you should con-
tact Cyberstar Infocom at 0-9323809599, or
Tirupati Enterprises at 0-98310022600. A sim-
pler way of getting around the problem is to
post your query on our forums at
www.thinkdigit.com/forum. Forum members
who stay in or around your area will help you
find the right place to buy these components.

Upgrade Now Or Later?
My system configuration is an Intel Pentium 4
2.4 GHz processor with HT technology, an Intel

865GBF original motherboard, and 256 MB of DDR
400 RAM. I want to upgrade my graphics card so I
can play the latest games such as Half-life 2 and
DOOM 3. The new series of cards from nVidia and ATi
are expensive, so does it make sense to buy a MX-
4000-based card for now and then later opt for the
new cards when they get cheaper?

Ajit Das

If you really want to play Half-Life 2,
DOOM 3 and other upcoming games,

then settling for an MX-4000-based card is not
going to help you. In the next two years, graphics
card manufacturers will move to the newer PCI-e
interface, and it will become difficult to find a
high-end AGP card. This will put you in a fix, and
you will have no option but to upgrade your
entire system, since your current motherboard
does not support PCI-e. I suggest you invest in a
good AGP card now, so that your system will
allow you to play most of the upcoming games.
Remember, when it comes to IT, there’s always
something better looming on the horizon, and if
you keep waiting, you are bound to end up
spending a lot of money on components you
don’t really want.

Recording Via TV-Tuner
I want to purchase a TV-tuner card, mainly to
record content from my VCR and TV pro-

grammes. I want you to help me choose a good card
with capturing capability. My budget is Rs 3,000.

G V V Rao

For Rs 3,000, there are many good TV-
tuner cards that you can buy. Aver TV

GO 007, Pinnacle PCTV Pro and Compro
Videomate are the cards you should be look-
ing at. Though these cards support video cap-
ture, the output isn’t exactly of a professional

quality, just in case you are thinking of using
such cards to convert your VHS tapes to CD.
The price for these cards will vary between
Rs 2,250 and Rs 3,000. 

A Workstation And A Cabinet
I am currently in the process of building a
workstation and need a full tower enclosure,

but have been unsuccessful in locating a dealer. I
would appreciate your help in locating a dealer, and
if possible, please mention the brand and the price
of the cabinet I should be looking at.

Kanav

You can opt for Antec tower cabinets—
they have some good models meant for

workstations. Their ‘Performance’ series has an
array of cabinets to choose from, I would per-
sonally recommend the Performance Plus
660AMG. You should also check out the roomy
P160, which Antec claims they have made from
recycled fighter jets. 

Antec cabinets come with efficient and reli-
able power supplies and are hence more expen-
sive than other products, so be prepared to
spend a lot more. You can contact Cyber Space
Abacus on 044-24917667, or visit their Web site
www.theitdepot.com.

The Future-proofing Problem
This month, I got a lot of queries regard-
ing a good CPU-motherboard combina-

tion, or a good PC configuration that is at least
two years future-proof. I decided to list down
the components that you should be looking for. 

The motherboard mentioned below is based
on ATi’s new Express 200 chipset and has inte-
grated graphics that will let you play most
games at playable frame rates. However, if you
are an avid gamer, you should consider adding
the 6600 graphics card, but remember, this
board supports PCI-Express and not AGP. I have
mentioned indicative prices for these compo-
nents; remember that they will differ from
location to location. 

If you are an avid
gamer, you
should consider
adding the 6600
graphics card to
your system—but
remember, this
board supports
PCI-Express and
not AGP

Want a tech product, but
don’t know how to go
about buying it? Send an
e-mail to
agent001@thinkdigit.com
to get your queries
answered

Ask Away

Ask Agent 001

Product Vendor Price (Rs)
Aver TV Go 007 Access Pvt Ltd 2,950
Compro Mediatech India 2,275
Videomate TV/PVR
Pinnacle PCTV Plus Pinnacle India 2,500

CPU 

Motherboard 
RAM
HDD
Monitor
Keyboard
Mouse
Cabinet 
Power supply 
Optical drive

Graphics card

Rs 7,500

Rs 6,500
Rs 3,500
Rs 2,650
Rs 6,500

Rs 300
Rs 300
Rs 500

Rs 2,000
Rs 2,750

Rs 32,500
Rs 12,000

AMD 939 pin Athlon64 3000+
or 3200+ 
MSI RS480M2
512 MB DDR 400 Hynix
80 GB SATA Samsung/Seagate
17-inch Acer 715 
Logitech 
Logitech Optical
Any cabinet you like
Antec/VIP 350 W power supply 
Lite-On/Sony Combo drive

TOTAL
XFX Geforce 6600 card

Future-proofing Your PC
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Robert Sovereign-Smith

At first sight, this Web site looks
like just another news portal.
However, once you read a couple

of articles, you will realise that this is
anything but. Kuro5hin, or K5, is what
can only be described as news from the
community, by the community.

K5 has no reporters, and no
editor either. Sure, there are trusted
members that look after the site in
terms of policing the content, but the
rules are pretty relaxed—only pornog-
raphy and extremely offensive mate-
rial are not allowed.

Where Does The News
Come From?
From the K5 community, of course!
And all you have to do to join the
community is register on the site,
wait for a confirmation e-mail, and
start posting. Of course, you don’t
need to do any of that if all you want
to do is read the news. 

What’s So Great About It?
Every registered user is something of
an editor. A registered user can post a
story, comment on stories, and even
vote for stories that have been recently
submitted. You can do this by looking
for the ‘Moderate Submissions’ link on
the right after signing in. From here,
you read stories that have recently
been posted, and then rate them.

After the predetermined voting
time is over, the article is posted on
the site, or not posted at all,
depending on how much the
community likes the story. This
ensures that K5’s content is always
in tune with the interests of the
masses, and everyone always gets
to read things they find interesting.

Another Slashdot?
Well, yes—sort of. The difference lies
in the fact that K5 looks a lot better,
and is less of a nightmare to navigate.
Moreover, K5 is a lot more than just

technology, though
that is its focus. At
K5, the community
is expected to be
witty and intelli-
gent at the same
time, and readers
are encouraged to
think, think again,
and think once
more, before they
post. As the site
clearly says, “What
we need is more
‘Freedom’ and
less ‘FreeDumb’.”

At the same
time, K5’s more
aesthetic and easily
navigable site
layout  makes it
more pleasureable
to surf as compared
to Slashdot.

Kuro5hin.org

The topics are neatly and conve-
niently arranged along the top of 
the page, and offer a wide range of
interesting reading material—from
‘Technology’ and ‘Science’ to ‘Politics’
and ‘Fiction’.

Everything—from articles that
teach you a thing or two, to features
that tickle your funny bone—can be
found under each section. For exam-
ple, the ‘Technology’ section
currently has articles about one
person’s experience with laser eye
surgery; another write-up explains
how a Scottish Mathematician used a
chessboard to calculate in binary
code; and a story about old, useful
technologies that shouldn’t have died
out and so on. 

The site also has ‘Diaries’, which
could be called member blogs. This is
your personal section, and you can
post whatever you want to. No other
member can post articles in your
diary, but they can comment. All the
members here have teeth, and can
bite really hard—so make sure even
your diary entries are well thought
out and factually correct.

Kuro5hin has the potential of
becoming a regularly visited book-
mark. Add it to your Favourites folder,
and it can provide you with knowledge
that you never knew you might need,
act as an outlet for your thoughts, and
provide you all the reading entertain-
ment in the course of a regular day.
From laughs to learning, it’s all here! 

robert_smith@ thinkdigit.com

Technology and culture from the trenches

The Kuro5hin homepage is well designed. Everything you might need in order
to navigate the site is right there on the homepage

Kuro5hin is a democracy, and every article needs to
be voted for before it is posted on the site
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Jayesh Limaye and Varun Dubey 

D
espite all the talk
about the ability of
technology to enable
us to be more efficient,
there is one aspect

of work that has not really
changed—and the corresponding
paradigm shift has not actually
materialised. We are talking about
the paperless office.

The IT boom has subsided, but
paper has stayed put in the office—
in fact, we use more paper than
ever. Every year, India churns out
reams of papers in terms of filing
everything in triplicate—thanks to
our governance system. This brings
to companies the question of how
to print, where to print and what
would be the cost of printing?

The sheer convenience offered
by inkjet MFDs in this regard
makes them ideal for your SoHo
setup. They are a lot cheaper as
compared to a colour laser
printer/copier, and give you
outstanding quality for all your
presentations, brochures, company
reports, and official documents. 

For graphics professionals, the
advantages are unparalleled, as you
can scan pictures, edit them using
your image editing software, and
then print the same image, all
from a single unit—giving you tons
of space to do whatever you
choose! Moreover, some of them
even come standard with memory
card readers and PictBridge func-
tionality, so if you are Mr/Ms Sure-
Shot, you can print your images
straight off the camera with no
intervening PC.

The dipping costs of good
quality entry-level printers have
prompted widespread accept-
ance. The cost of these printers
may be low, but they are pretty
high on performance thus
making them  ideal for a home
user. Whether you would like to
print text or pictures, they do a
terrific job. In fact, they do a
commendable job of handling
almost all types of home printing
you can think of.

Mid-range printers come with
PictBridge functionality, CD/DVD
printing, memory card readers
and such life-like photo printing
capabilities that you will never
feel the need to go to the nukkad
photo studio. Shoot with your
digital camera and print images
with your photo printer—now
that’s convenience!

Just Push PrintJust Push Print
Print, copy, scan or fax... what would you like to do today?

Photograph Jiten Gandhi
Imaging Binesh sreedharan
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We explored the overflooded
market of inkjet printers and
MFDs to bring you a blow-by-blow
account of how they fared, and
what you should use until that
dream of a paperless office
becomes a reality—if it ever does!

INKJET PRINTERS 
Home Printers
The printers that featured in the
tests were in two categories: Home
and Office/Photo printers, based
on price. Initial price and running
costs are a more telling factor than
raw speed and performance, so
they were accorded a higher
weightage. Home printers were
identified as devices available for
Rs 4,000 or less. Printers falling
into this category are the Canon
iP1000, the Epson Stylus C45, and
the HP DeskJet 3745 and 3845. 

Features
In terms of features, the iP1000
surprised us: it does not even ship
with an output tray!  This seems to
be a trend now, since the 1500
didn’t ship with one either. Thank-
fully, the other manufacturers
were more considerate, and
squeezed in an output tray.

All the printers came with a
black and a colour cartridge. None
of them came with PictBridge or
automatic double-sided printing
or the ability to print CD or DVDs,
but hey, there’s only so much you
can get for Rs 4000! And if you
really look at it, who doesn’t mind
saving a few thousand rupees and
spending some extra time to print
pictures through your PC rather
than straight from your PictBridge
printers (read costly printers)?
Plus, you get the added ability to
tweak them via Photoshop!

The Epson Stylus C45 and HP
DeskJet 3845 looked really sturdy
and sleek and rated high on build
quality. The iP1000 was the worst
looker with a pale grey finish, and
none of the class exuded by its
bigger brothers, or indeed, any of
its peers in this segment.

Performance
After our initial tryst with it, our
expectations had lowered consid-
erably as far as the iP1000 was
concerned. But we soon realised
that it was a mistake to judge the
book by its cover—in the case of the
iP 1000, by the lack of a tray! 

The test results surprised us so
much, we conducted them twice!
Twenty-two pages of our drain test
document utilised a mere 10 per
cent of its ink. We tested it for
printing speed, and it left the
others behind, printing our test
document in 10 seconds flat.

The second-fastest printer was
the HP 3745 at 16 seconds; 17 for
the HP 3845. We then took an
enforced break; we figured it was
a better idea to have a cuppa tea as
the Epson C45 printed the page,
taking 35 seconds! The HP 3845
printed just two pages with 10 per
cent of its ink. The figures for the
HP 3845 and Epson C45 were seven
and 10 pages respectively.

For our quality tests, we took
pure text documents printed in
B&W mode with the print quality
set to Normal. The quality of the
text printouts was largely the
same, with the iP1000 giving us the
crispest and cleanest results
followed by the HP 3745. The Epson
C45 had some trouble—we could

discern a few cracks in the letters.
We assumed that at home, you
would want to print school proj-
ects or even presentations. So, we
created a document, affectionately
called ‘combi-doc’, consisting of
text, a pie-chart and various graph-
ics and photos, and tested the print-
ers for speed and quality. The
Canon iP1000 again boomed
ahead, printing the combi-doc in
50 seconds; the HP 3845 came a
distant second with 66 seconds,
while the 3745 took 76 seconds. The
Epson C45 brought up the rear
with a ridiculous 127.7 seconds!

In terms of quality of the print-
out, HP 3745 was snapping at the
Canon iP1000’s heels. The Epson
C45 was a let-down again—it took
forever to print the document, and
did a really bad job of it.

As Canon claims—Pixma is all
about fast image printing, we veri-
fied the marketing mumbo jumbo.
We printed the image at the high-
est quality settings.

Well, this time, it wasn’t just
mumbo jumbo. The Canon iP1000
truly outclassed the other printers,
printing the A4-sized document in
185 seconds, while the count was
592 seconds for the HP 3845 and
625 seconds for the HP 3745. And
yes, we also tested the Epson C45,
but we took a lunch break this
time—it took 1179 seconds! That’s
almost 20 minutes! 

In terms of quality of the photo,
the iP1000 really made an impres-
sion—not only did it hammer its
rivals, it even managed to keep up
with our more expensive photo
printers! So, if you want cheap high
quality printing, get this before it
goes out of stock! The HP 3745 had
better quality, but was a touch

slower; the HP 3845 was
the exact opposite—it
was faster than the
HP 3745 but was
wanting in terms of
quality. The Epson

C45 matched the HP
3845 in terms of quality, but

it also took twice the time.
So, if you want good quality

photos in a reasonable amount of
time, opt for Canon iP1000. If you
want to print anything with good
quality and great speed, the iP1000
is the way to go.

Conclusion
There’s no doubt about the
winner here. The Canon Pixma
iP1000 was the fastest, and the
best printer in every aspect of our
tests in the sub-Rs 4000 category.

The cost of
home
printers
today may
be low, but
they are
pretty high
on
performance

Epson Stylus C45 
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The HP 3845 lost out to HP
3745 mainly due to its high price-
per-page cost. The Best Buy Gold
award goes to Canon Pixma
iP1000 and the Best Buy Silver
goes to  HP DeskJet 3745.

Office And Photo Printers
In this category, we had eight
printers: the Canon Pixma iP1500,
iP2000, iP3000, and iP4000; Epson
Photo R210 and R310; the HP
DeskJet 5748; and Lexmark P915,
all priced over Rs 4,000.

Features
Features carried weightage, as did
performance while, price was
given slightly lower weightage.

The features we got to see on
some printers really brought
smiles to our faces. Soon enough,
it became clear that it would be
the Lexmark that would set the
benchmark in terms of its sheer
feature list, ease of use and looks.

When we unpacked the P915,
we heard ‘oohs’ and ‘aahs’, with
people flocking the desk all the
time trying to play with its colour
screen. The Lexmark probably kept
ease of use as the No. 1 priority
while designing this printer. 

The setting up was hassle-
free, and there was even an
animated display showing us
how to replace the cartridges.
The ink status display had a
‘skinnable’ interface and showed
the display in real time. It
supports PictBridge, and has slots
for various memory cards. It even
lets you do simple photo editing:

Our test bed comprised a Pentium 4 3.2
GHz processor plugged onto an MSI 875P

Neo FISR2 motherboard with 512 MB of
Corsair 400 MHz DDR RAM, a Gainward
nVidia GeForce FX 5950 graphics card, and
an 80 GB 7200 rpm ATA IV Seagate
Barracuda hard disk. 

We used Windows XP with SP1 as the OS.
The system was loaded with all the latest
chipset and graphics drivers. We also
installed the USB patch for XP and
connected the devices on the USB 2.0 port
for optimum performance. Across the tests,
we used the following media:
Text/combi-document printouts:
100 g/sm paper from Berga (A4 size)
Photo Printouts: 270 g/sm glossy photo
paper from Kodak (A4 size)

Inkjet Printers
We divided printers into two categories:
Home printers (sub-Rs 4,000) and
Office/Photo printers (Rs 4,000 and above).
The test process remained same for both
groups; the only change was in the
parameters to determine the winner.

Features
Printers were rated on various features:
PictBridge, memory card readers, duplex
printing, CD/DVD printing support,
input/output tray capacity, input buffer and
maximum resolution supported by the
printers’ LCD screens. They were rated on
the basis of features they supported.
Obviously, most of these features were
standard on the higher-end printers.

Performance
We tested the performance on three
parameters; speed, quality, and efficiency.

Economy Test
We conducted the economy test first to avoid
miscalculations later, with half-full cartridges.
We created a document that had eight per
cent of text and 60 per cent of images and
graphs. We then printed multiple copies of
the same drain test document on regular
paper. We noted an average ten per cent
drop in ink and extrapolated it to get an
estimate of the printer’s ink usage.

Speed And Quality Test
We used a text document to test the raw
print speeds of the printer. The quality
settings used were Normal and Best.

To test the ability of printers to handle
various aspects of a regular document, we
created a combi-document with black text,
interspersed with graphs and images. We
clocked the time it took them to print this
document in normal and best quality modes,
and accordingly analysed the print quality.

The final test for printers was the photo
test, where we used 270 g/sm Kodak Glossy
Photo Paper to print an A4 image. We timed
the process and examined it for quality of
print. The settings used here were the
highest quality available.

Inkjet MFDs
MFDs have a scanner, printer and copier.
MFDs with fax facility earned more points. 

Printer Test
The test process here was exactly the same
as that for the inkjet printers.

Scanner Test
We tested the scanners for speed using an
average of five previews of an A4 size image.
This was done when the scanner was fresh

out of the box to incorporate the warm-up
time. Scanners with a higher warm-up time
didn’t fare as well as the others.

We tested the warmed up scanners to
negate any possibility that a scanner might
scan faster than the others once warmed up.
We imported the same A4 size image at 150
dpi and 600 dpi, in Adobe Photoshop, and
scanned a full text document in B&W mode
at 200 dpi. The scanner then underwent a
test to determine its colour differentiating
abilities using a Kodak IT8 card with
different shades of colour—each with a little
difference from the preceding one.

Next, we tested the resolution card to
figure actual scanning capabilities by
checking for its native resolutions. We
scanned the card at 300 dpi to see how many
boxes it could differentiate in between the
lines. Most MFDs passed this test easily.

Finally, we did an OCR test to check the
scanner’s ability to differentiate light and
dark areas. A print article was scanned into
the trial version of Abbyy Fine Reader Pro
7.0, and scanned for wrongly-interpreted
letters in the software. We then gave a
percentile value to the devices.

Copier
We copied a text document in B&W and the
combi-document in colour, and rated the
MFDs on their speed and quality of printouts.

How The Awards Are Given
The scores from features, performance and
price are given category-relevant weightage.
An overall score out of 100 is calculated. The
product that scores the highest here is
adjudged the winner of the Best Buy Gold
award for this category. The second highest
score gets the Digit Best Buy Silver award.

How We Tested
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HP Deskjet 3745 
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Canon Pixma iP 1000
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cropping, rotating and resizing,
without the need for a PC! None
of the other printers had this. It
also featured an automatic print
head alignment function, where
you just click ‘align print head’,
and it does it for you. 

The Canon printers had the
worst ink status display as we had
to restart our PCs to get an
updated report. In most of the
other cases, simply restarting the
ink monitor did the trick. The
point to note is that except for the
Lexmark, none of them showed it
in real time.

The only other printer with an
LCD (B&W) was the Epson Photo
R310, and you could neither see
nor edit photos on it. Although it
did not feature automatic print
head aligning, it did have
memory card slots. The Canon
Pixma iP4000 did indeed have
automatic alignment, but it
lacked the colour screen and a
memory card reader, which is
strange considering this printer
costs Rs 11,000, and is being
touted as a photo printer!

One really innovative and
unique feature of the Canon
printers in this segment was
dual paper feed; they can take
papers from the
top or from the
bottom. This
e f f e c t i v e l y
doubles print
capacity to 300
sheets. This lets
you segregate
different types of
paper: you can
put your photo
papers at the bottom
and regular papers at the
top. Then, depending on your
printing needs, you can use the
dedicated button to select the
paper source. This feature is very
useful if you want to print in
large quantities, as you can load
up both trays and when one
finishes you switch to printing
from the other tray while the
first one gets refilled!

The Canon iP3000, iP4000
and the Epson Photo R310 all
supported CD/DVD printing.

Performance
The printers underwent the
same test process as home print-
ers. In pure text printing speed,
the Canons were miles ahead of
all others, with iP2000 printing
the document in just seven
seconds. The second-fastest was

iP1500 at nine seconds, while
iP4000 and 3000 took 12 and 13.5
seconds each. The fastest non-
Canon printer was HP 5748 at 16
seconds. The Epson R210 and
R310 clocked 49.7 and 46 seconds
each. The feature-rich Lexmark
P915 turned was slowest with
45.1 seconds.

In the quality of text prints, it
was all Canon again, with the
Pixma 3000 and 4000 giving us
some of the crispest printouts we
have seen. 

Since this is the office/photo
printing category, we assumed
that the combi-doc would have a
significant role to play, and
promptly put the printers
through their paces. It was all
Canon yet again, with the top
two being the iP4000 with 27
seconds and the iP3000 with 31.1
seconds. The third-fastest was the
HP 5748 with 47.4 seconds—a full
16 seconds slower.

In terms of quality of the
combi-doc, the iP4000 and
iP3000 tied for the top spot, with
the iP2000 coming in a very
close third. 

The Lexmark was close to the
Canons in terms of quality, and
was closely followed by the HP
5748. Epson turned out some
decent printouts, but those we
got from the others were better.

If you print lots of
official reports,
trend charts,
graphs and the like,
the iP3000 and
4000 will do a
smashing job.

Since this
section is for photo
printers as well, we

gave significant weightage to
printing photos, both in terms of
quality and speed. No surprises
again: the Pixmas shone, and the
fastest photo printout was shot
out by the Canon iP3000 in 177
seconds. This was followed
closely by the iP4000 with 210
seconds. The third-fastest was the
Lexmark P915 with 314 seconds.
The HP 5748 took 463 seconds,
with the Epsons bringing up the
rear yet again with the R210 and
R310 printing the photo in 488
and 523 seconds respectively.

In terms of quality, the Canon
iP3000 won by a hairsbreadth,
with the Lexmark P915 and
Canon iP4000 tying for second
position. The iP2000 came in
third, beaten by the iP4000 by
just a fraction.
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In fact, amateur photogra-
phers who would like to see hard
copies of their photographs, the
Canon iP3000 and 4000 will be
the best and fastest bets. 

For office users who prima-
rily print sales brochures and
other similar documents, these
printers will do an extremely
professional-looking job, and you
will not have to keep negotiating
with an outsourced printing
firm for every brochure you
would like to print.

Conclusion
After going through the various
tests, Canon had done it again.
This time, the iP3000 won, beat-
ing the iP4000 by an extremely
small margin, primarily on
account of its lower cost and
lower running costs.

Special mention must be
made of the Lexmark P915, as it
came quite close to beating the
Canon, but lost out mainly
because of slow printing speeds
and higher running cost. It is
aimed at the home photo print-
ing segment, and in that respect,
it performs well enough and is
competitively priced. If, for some
reason, you would like to use this
in an office setup, you can
replace the photo cartridge with
a black cartridge, which would
reduce the running costs to a
great extent.

Canon made a clean sweep
this time round in both the
home and office/photo segment,
with their brand new Pixma
range. Although the Lexmark
came close in the office/photo
segment, the iP1000 is far ahead
of the competition with the HP
3745 scoring nearly 15 marks
less. Canon has come and
outdone them all—it’s now time
for the others to catch up! 

MULTI-FUNCTION
DEVICES
Installation
Although this department does
not sway the overall scores much,
we thought it worthwhile to
mention it given our experiences
at the Test Centre.

In today’s plug-and-play era,
one would expect much easier
installation processes: the worst
installers in this segment were
HP’s MFDs. Strangely, their
printer installation was really
smooth, but the MFD installer
told us to wait as this could take
15-35 minutes depending on the
system. On our test bed, it 
took us 20 minutes to install 
one MFD!

A close competitor for the HP
on this front was Brother. The
installation of their MFDs was
cumbersome in terms of when to
connect and when to disconnect,
and then there was the waiting
and the praying for it to get
detected by the installer. More
like plug-and-pray! On the other
hand, the Epson and Lexmark
installers were smooth.

For the rest of the testing, 
we divided the MFDs into 
two categories—office use and 
Photo MFDs. 

Office MFDs
This category consisted of eight
MFDs, and the usage pattern
assumed during testing was that
of a regular SoHo, with emphasis
on performance, features and
running cost and not so much on
the initial cost.

Features And Build 
Quality
All the MFDs we received came
with LCD panels except for the
Epson CX 1500. Some of the LCDs
were decidedly better than the
others. The Brother LCDs were the
single line, B&W variety, and the
contrast was so abysmal that we
had to literally move around to
get a reasonable viewing angle
and read what the screen said.
The Lexmark P6250 was the sleek-
est-looking device, and looked
identical to the P915 printer.
Other devices, such as the HP
5510 and the Lexmark X7170,
came with ADF. None of the
Epsons were equipped with dial
pads for faxing, and this was also
missing on the HP 1608.

All the MFDs supporting fax
came bundled with telephone
wires. Some MFDs, such as the HP
4255, even had standard RJ45
sockets to connect them to a
network—an extremely useful
feature for a SoHo setup.Canon Pixma iP 3000 

Canon Pixma iP 4000
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Score Board for Inkjet Printers

Home Printers
Canon Pixma iP1000
HP Deskjet 3745
HP Deskjet 3845
Epson Stylus C45
Office/Photo Printers
Canon iP1500
Canon iP2000
Canon iP3000
Canon iP4000
Epson Photo R210
Epson Photo R310
HP Deskjet 5748
Lexmark P915

B/W and Color
B/W and Color
B/W and Color
B/W and Color

B/W and Color
B/W and Color
CMYK (4)
CMYK (6)
CMYK (6)
CMYK (6)
B/W and Color
Photo/Color(2)

4800x1200 
1200x1200 
1200x1200 
2880x720 

4800x1200 
4800x1200 
4800x1200 
4800x1200 
5760x1440 
5760x1440 
4800x1200 
4800x1200 

No/No
No/No
No/No
No/No

No/No
Yes/No
Yes/No
Yes/No
Yes/No
Yes/Yes
No/No
Yes/Yes

150/No Out Tray
80/50
100/50
100/50

150/No Out Tray
300/NA
300/NA
300/NA
120/80
120/80
100/50
100/70

No/NA
No/NA
No/NA
No/NA

No/NA
No/NA
No/NA
No/NA
No/NA
Yes/B/W
No/NA
Yes/Color

56.37
41.56
37.94
40.24

42.84
53.17
60.39
59.1
38.77
51.94
39.07
55.81

3195
2999
3999
3295

4495
6495
8495
10995
9895
13495
5999
8999

LCD Screen/
Type

Overall Score
(Out of 100)

Price (Rs)
Tray Capacity

(In/out)
Type of 

cartridges
Device

Interpolated
Resolution

PictBridge/Mem.
Card Reader

For the complete scoreboard, log on to www.thinkdigit.com

Home Printers
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In terms of scanning features,
not all MFDs had flatbed scanners,
and some, like the Brother 3240c
and the HP OfficeJet 4255, had a
sheet-fed scanner that made multi-
ple-document scanning an incon-
venient task. But the HP 4255 had
the advantage of being extremely
compact in design. The Brother
MFD, thanks to the sheet-fed scan-
ner, was also bulky as such devices
normally are.

On the other hand, the Brother
MFDs sorely lacked build quality.
The cheap plastic was quite obvi-
ous even without opening the box! 

Performance
Printing
The HP MFDs really shone in our
text document speed test. The
fastest time was clocked by the HP
PSC 1608 at 16.68 seconds. The
runner-up was another HP, the HP
PSC 2310 at 17 seconds. Not quick

by any standards—the Canon
Pixma iP 1000 did the same docu-
ment in seven seconds—still
pretty respectable. The fastest
non-HP device was the Brother
3240C at 23 seconds with its
sibling, the 210C, clocking 25.5
seconds. As in the printer tests,
the Epson stylus CX 1500 brought
up the rear with 37 seconds!

So if you believe the bulk of
your printing requirements would
be text documents, the HP PSC
1608 is the fastest, and is nearly
the most economical—second only
to the Lexmark X7170.

In the next stage, we put the
printers through our combi-doc
test. Surprisingly, the Brother
MFC 3240C outshone others,
printing the document in merely
46 seconds. It was followed closely
by the HP PSC 2310 at 48 seconds.
The Lexmark X7170 took a
leisurely 78 seconds, with the

Epson CX1500 in the bottom spot
again with 253 seconds.

Although we are not really
looking at the photo printing
capabilities of the devices in this
section, it never hurts to print the
occasional office picnic photo,
right? In our photo printing tests,
the fastest printer was the HP PSC
2310 which printed the A4-sized
image in a respectable 289
seconds. The Lexmark X7170 did
the same job in about 375
seconds, while Epson (yes, again)
with 1,159 (you read that right!)

seconds was last. 
It must be

mentioned here
that the Brother
MFDs did not fare
too well, with the

MFC 3240 and 210
clocking above 1,000
seconds each! If you
want to print a picture

ADF (for MFDs): An Automatic Document
Feeder (ADF) lets you automatically load
multiple-page documents into the scanner:
you do not need to keep feeding individual
pages to the scanner.

Optical Resolution: The optical resolution
of a printer or scanner refers to the real
hardware capabilities of the device.
Nowadays, the resolution of a device can
be increased by up to 8 to 9 times based
on the software assisting it.

Interpolated Resolution: This is the
software-enhanced resolution of the
device.

Input Buffer: This is the onboard memory
that a printer has, to keep a document in.
It assists in speeding up the printing
process when printing multiple pages.

PictBridge: This technology allows you to
directly print photos from your camera
onto your printer. You just connect the
camera to the printer, and select the photo
to be printed.

Number Of cartridges: As a thumb rule,
the higher the number of cartridges, the
more accurate the printout. Most high-end

photo printers come with six cartridges.
Besides the CMYK cartridges, they also
have light cyan and light magenta.

Ink Drop Size: This is usually measured in
picolitres—a trillionth of a litre. The smaller
the drop size, the better the print.
Manufacturers offer printers that can print
drops as small as one picolitre.

PPM: This is the abbreviation for pages
per minute, used to state the number of
pages a printer prints in a minute.

TWAIN: TWAIN was designed to provide a
universal public standard that links
applications and image acquisition devices
such as cameras, scanners and the like. A
common misconception is that TWAIN
stands for ‘Technology Without An
Interesting Name’. This is incorrect. It is in
fact from Kipling’s “The ballad of East and
West”—“... and never the twain shall
meet...” to show the difficulty faced, at
that time, in connecting scanners and
personal computers. It was capitalised to
TWAIN to make it stand out. This led to the
popular belief that it was an acronym. 

WIA: Abbreviation for Windows Imaging
Architecture, this is an interface provided

natively in Microsoft Windows XP and ME
enabling interaction with devices such as
scanners and digital cameras.

Print Media: The contribution of printing
paper towards the resulting printout is
grossly underestimated. If you want to
optimise your printing results, you must
use suitable media. Today, in the market,
you probably have more of a choice with
print media than printers!

Paper sizes that are available will
cater to every need you could think of.
There is a multitude of brands to choose
from. The more popular ones are Kodak,
Novajet, and Berga. The quality of the
paper is dependant on its density, which
is measured in g/sm (grams per square
metre). As a thumb rule, the higher the
g/sm, the better the paper quality.

Photo papers are classified into photo
paper, glossy photo paper and matte
photo paper, depending on the kind of
finish you are looking for. You can get an
A4-size 15-sheet pack of 275 g/sm Kodak
photo paper for approximately Rs 200.

CD Printing
A lot of the mid to high-end printers today
support CD/DVD printing. They come with
a special attachment tray where you can
print any image you choose on the
CD/DVD. This feature makes your
compilations look professional. To do this,
you need to have a printer that supports
this, and a CD/DVD with a printable
coating. If your CD/DVD media does not
have that coating, you can print the image
on paper and literally cut and paste it 
onto your CD!

Jargon Buster

Print Requirement
Regular everyday printing
High Quality text prints
(résumés, applications etc)
Normal photo prints
High quality photo prints

Print Media
70-80 g/sm paper
100-120 g/sm paper

170-210 g/sm photo paper
270+ g/sm photo paper

Approximate Cost
Rs 125 for 500 sheets

Rs 200 for 20 sheets
Rs 200 for 15 sheets

Epson Stylus PHOTO CX1500
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or a brochure, you should defi-
nitely go in for the HP. But if you
want an economical MFD, noth-
ing even comes close to the
Lexmark X7170, which printed a
whopping 22 pages in the 10 per
cent ink usage test. The closest
anyone got to it was the Brother
MFC 3240C, which printed a
decent 17 pages. The HP 2310
came fourth, with 15 pages, after
the HP 1608, which printed 16.
The Epson proved to be an ink-
hungry beast, printing just two
pages—and there wasn’t any
difference in terms of quality!

When buying an MFD or a
printer for your home or office,
always find out the cost of print-
ing a single page. Naturally, lower
is better. This applies especially to
offices where the printing load
is greater.

Scanning
Remember never to go by the
marketing jargon of maximum
dpi and interpolated dpi. These
are software-enhanced resolu-
tions and are not the real hard-
ware capabilities of the device.
Always insist on finding the real
optical dpi of the scanner. The
concept is similar to 
digital zoom and optical zoom on
digital cameras. While you may
have digital zoom in excess of 40x,
it will never give you the clarity as
that of a 24x optical zoom.

The first thing we tested was
the warm-up time of the scanner.
For this, we took a cold scanner
and scanned an A4-size image
five times over, and averaged the
recorded times. The fastest
device here was the Lexmark
X7170 with nine seconds,
followed closely by the HP 1608
at 11.1 seconds and the HP PSC
2310 with 14 seconds.

The Brother MFC 3240 failed
this test, and we could not get
preview values. The other sheet-
fed scanner, the HP 4255, did let us
do a preview job, although it was
not pretty—it took 42 seconds!

This time, Epson took a break
from bringing up the rear by
finishing second-last; the rear
was brought up by the HP 5510
at 16 seconds.

While testing for the resolu-
tions with a resolution card,
almost all scanners were able to
scan 3/5 boxes at 600 dpi, except
for the two Brothers and the HP
OfficeJet 5510. They could
manage only 2/5 boxes. The
reason we did not expect any of
the scanners to scan the remain-
ing two boxes was that they were
created at a much higher resolu-
tion of 1200-2400 dpi, and are not
really needed for an office scan-
ning environment—so we
restricted our scanning tests to a
resolution of 600 dpi.

We then got out the iT8 card to
test the scanners’ ability to distin-
guish different shades of colours.
This test was given the highest
weightage. Here, surprisingly, the
HP 4255 and the HP 1608 outshone
the rest by reading all 22 shades of
black. They were closely followed
by the Lexmark X7170, which
detected 21 of the 22 shades.

The Brother MFC 3240C came
a consistent third here. Here, the

rear was brought up by HP 5510
and the other Brother device.

One thing is for sure: if you do
a lot of scanning and are particu-
lar about accuracy, you should give
the Epson Stylus CX1500 a look.
Although it is ink-hungry when it
comes to printing and is slow in
terms of scanning, it does not
compromise on clarity.

Copying
Now, by virtue of having a scanner
and a printer in the same pack-
age, the device can also double up
as a copier. To test the copying
functionality of the MFDs we used
the copier as a stand alone func-
tion without the device being
connected to the PC. We tested
the speed of copying (both black
and colour) as well as the quality
of the copies produced.

In terms of sheer speed, the
Lexmark X7170 outpaced every-
one else by copying the B&W
document in 20 seconds and the
colour document in 39 seconds.
It was followed closely in B&W
copying by the HP PSC 2310 at 22
seconds, although it did stutter
in colour copying, giving a time
of 54 seconds! 

The second-fastest in colour
copying was the Brother MFD
210C at 41.9 seconds. It was also
the best quality copier in this
test, although the Lexmark X7170

When
buying an
MFD or a
printer for
your home
or office,
always find
out the cost
of printing
one page

Brother MFC-210C 

HP officejet 5510 all-in-one



83APRIL 2005 DIGIT

Digital Tools l Test Centre

did come close. The Brother,
though, edged ahead to claim
victory by virtue of better quality.

In terms of the B&W copying
quality, the Lexmark 7710 and the
HP 5510 tied for the top spot, with
the HP PSC 2310 and the Brother
3240 tying for second place. 

In case, you are required to do
a lot of copying—whether text or
colour—a smart choice would be to
go in for the Lexmark X7170.
Although you may have to do a
minor compromise in terms of
speed, the X7170 provides you
with really good printouts, which
are sure to come in handy during
presentations or meetings.

OCR
The last test we conducted was the
OCR (Optical Character Recogni-
tion) test. We scanned a newspa-
per article using ABbyy Reader 7
Professional, and let the software
read the characters without any
tweaks and at all the default
settings. We were checking for
errors given by the software. The
HP 2310 and the Epson CX1500
gave us zero errors! They even read
the characters embedded in an
image (a logo). The worst was the
Brother MFC210c, with 10 errors! 

The only problem Lexmark
X7170 gave us was that it did not
read the image file too clearly but,
the text part of the document was
completely error-free.

All said and done, and as the
smell of ink and the reams of
papers were cleared up, the
Lexmark X7170 came out the
clear winner on account of its
competitive pricing, extensive
feature set and miserly usage of
ink during printing. Yes, it was
not the top in all segments but if
you look at the whole picture, it
fared consistently better than

the others when taken as a pack-
age. So, let’s hear it for the
Lexmark X7170, the Best Buy
Gold winner!

The Best Buy Silver award goes
to HP PSC 2310. Though cheaper
than Lexmark X7170, it lost due
to its running costs. Cartridges
are costlier by almost Rs 500 than
the Lexmark ones and print

around seven
pages less with
10 per cent ink.

Photo MFDS
Only three MFDs

qualified for this
segment— the

Lexmark P6250,
the Epson RX630

and the HP PhotoS-
mart 2608.

Features
All the above mentioned MFDs
came with MMC Readers and were
PictBridge compliant. They also
had some of the sleekest LCD
screens we have seen, some of the
top cell phone screens included!

The build quality of all of
these printers was excellent and
really sturdy; the Epson RX630
even came with a transportation
lock for the scanner element.
None of the other systems had
this feature.

Performance
Printing
In our Printer tests, the test
process was the same as that for
Inkjet Printers. The fastest one
here was the HP PhotoSmart 2608,
which printed our test document
in 11 seconds, while the Epson RX
630 and Lexmark P6250 were
distant runners-up with 31 and 56
seconds respectively. So, if you
want fast printouts from your

MFD, the HP PhotoSmart 2608 is
the one to go for—it will save you
tons of time to get on with your
business or whatever else you want
to have time for!

The same story was repeated in
our combi-doc and photo printing
tests. The HP PhotoSmart 2608
took 31.3 and 263.8 seconds respec-
tively, as compared to 39 and
473.81 seconds for the Epson RX
630 printer and 145 and 312
seconds for Lexmark P6250. 

The great thing about this HP
printer is that it’s not only devas-
tatingly fast, but also does a stellar
job of printing in terms of quality.
The text printouts were crisp and
sharp. Eventually, though, in
terms of pure quality of the
picture, the HP was pipped to the
post—by a marginal difference—by
the Epson.

Since these are classified as
photo MFDs, the bulk of the
emphasis is on photo printouts,
with speed and quality both being
important. As always, though,
quality is preferred over speed.

In terms of printing speed,
the HP PhotoSmart 2608 was
blazing fast, with a text docu-
ment printing time of
11 seconds, as
compared to 31
and 56 for the Epson
and Lexmark. 

APRIL 2005

Lexmark X7170

HP PSC 2310 all-in-one
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The same is true for the
combi-doc, where the HP 2608
printer took a mere 31 seconds as
compared to 39 for the Epson
RX630 and 70 for the Lexmark
P6250. Again, in the photo test,
the HP printer did the job in 263
seconds, while the Epson RX630
took a whopping 473.81 seconds
and the Lexmark P 6250 took 312
seconds, nearly 50 per cent more
time! In this section, the focus is
more on quality than speed.

In terms of text quality, the HP
2608 and Lexmark P6250 tied,
leaving us with more tests to do.

In the image and combi-doc
quality, HP PhotoSmart 2608 was
significantly better than the
others, though Lexmark P6250
did give HP 2608 a pretty tough
run for its money. 

Scanning
In the scanner tests, the proce-
dure was no different, and HP
PhotoSmart 2608 simply
outclassed the rest by detecting
all 22 shades of black with amaz-
ing clarity. The Epson could
detect only 20 while the Lexmark
P6250 detected 19.

In the resolution tests, the
HP PhotoSmart 2608 again
detected all three boxes whereas
the Lexmark detected only two.
The Epson could detect all three,
but only when scanned at full
colour resolution at the highest
possible bit depth.

The HP was also the fastest
scanner and the only one that
could read 3/5 squares in the reso-

lution card. Epson and Lexmark
detected only two boxes. This
proved their native scanning capa-
bilities were not as good as  those
of the HP 2608. So, if you want to
scan fast and accurately, go for HP. 

Copying 
For these photo MFDs, the copier
test was the same as before, and
here as well, the HP PhotoSmart
2608 came out tops with the
most vivid colour and print qual-
ity of the copied document.

The speed of the HP PhotoS-
mart 2608 in copying documents,
especially B&W ones, was sensa-
tional. It took 17 seconds to copy a
B&W document, as compared to
the 37 and 41 seconds taken by the
Lexmark P6250 and the Epson
RX630 respectively. 

In colour copying, the HP
PhotoSmart 2608 and the
Lexmark P6250 tied in terms of
speed, with both taking 39
seconds, while the Epson
RX630took a leisurely 49 seconds
to copy our coloured document. It
got beaten by a small margin in
the quality of the colour copy by
the Epson RX630. The margin,
however, was extremely small.

Conclusion
This was a no-brainer! The clear
winner is the HP PhotoSmart
2608, given its reasonable pricing
of Rs 15,000, and its performance
as well—which is far superior to
the other printers in this cate-
gory. In fact, this device could
have given the Lexmark X7170 a

run for its money. It has super
copying abilities, extremely fine
scanning abilities and its print-
ing prowess is excellent. Though
a bit of an ink guzzler—it printed
12 pages using 10 per cent of its
ink as compared to 16 pages by

the others—the category it is
placed in is one where a few
pages less don’t really matter.

Overall Conclusion 
In the printer section, Canon
blew the competition away with
their latest range of Pixma print-
ers. If you primarily need to print
photographs, it would make more
sense to go for one of the higher-
end Pixmas than a mid-range
MFD, although they have the
disadvantage of not having a
scanner. You could always click
pictures of your document and
print them!

In the MFD section, it was HP
all the way. It was head and shoul-
ders above the rest and stamped
its authority across the category.

In the coming months, with
manufacturers sure to launch
new products to match and beat
the Canons and the HPs, it’s
going to be an interesting battle.
We will be in the thick of it… for
you. Watch this space. 

varun_dubey@thinkdigit.com 
jayesh_limaye@thinkdigit.com
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HP Photosmart 2608 All-in-one

Telephone Web siteCompany E-mailBrand

Contact Sheet Printers and MFDs

Brother
Canon
Epson
HP
Lexmark

Brother International
Canon India Ltd.
Epson India Ltd.
Hewlett Packard India Ltd.
Lexmark International (India) Pvt.Ltd.

022-25797470
0124-5160000
080-30515000
0124-2566111
022-2605 7755,45,44

shweta.bhat@brotherindia.co.in 
rajeev.singh@canon.co.in
vasu@eid.epson.co.in
saranya.rustagi@hp.com
lavanyaw@lexmark.com

www.brother.com.sg
www.canon.co.in
www.epson.co.in
www.hp.com
www.lexmark.com

Score Board for MFDs

Office MFDs
Brother MFC-210C
Brother MFC-3240C
Epson Stylus CX1500
HP PSC 1608
HP Officejet 4255
HP Officejet 5510
HP PSC 2310
Lexmark X7170
Photo MFDs
Epson Photo RX630
HP Photosmart 2608
Lexmark P6250

1200x1200
1200x6000
600x1200
1200x4800
600x1200
600x1200
1200x2400
1200x4800

2400x4800
2400x4800
1200x2400

CMYK(4)
CMYK(4)
B/W and Color
B/W and Color
B/W and Color
B/W and Color
B/W and Color
B/W and Color

CMYK (6)
B/W and Color
CMYK (6)

Yes
Yes
No
No
Yes
Yes
Yes
Yes

No
Yes
No

No/Yes
No/No
No/No
No/Yes
No/No
No/No
No/Yes
Yes/No

Yes/Yes
Yes/Yes
Yes/Yes

100/25
20/50
100/50
100/50
100/20
100/50
150/50
100/25

120/20
150/50
100/25

Yes/B/W
Yes/B/W
No
Yes/B/W
Yes/B/W
Yes/B/W
Yes/B/W
Yes/B/W

Yes/Color
Yes/Color
Yes/Color

50.16
50.83
33.14
53.26
48.01
43.81
53.58
63.33

43.96
55.33
49.7

9900
9900
5695
11700
7999
12499
11499
14999

24295
14999
12999

Tray Capacity 
(In/out)

LCD Screen/
Type

Overall Score
(Out of 100)

PictBridge/Mem.
Card Reader

Fax
Scanner Optical 

Resolution
Type of 

cartridges
MFDs

Price 
(Rs)

For the complete scoreboard, log on to www.thinkdigit.com



Preethi Chamikutty

racking your cargo has always been a
logistical nightmare. With a large number
of variables affecting the safetyand arrival

time of your cargo, this has been a major area of
concern for many transporters.

Logistics and transportation applications
have long been touted, but have been slow to
reach wide market acceptance. Though the ben-
efits of accessing asset information are
clear to logistics companies,
its practical

implementation have been hindered due to
steep prices.

Companies are looking forward to technolo-
gies to support their needs, such as Global Posi-
tioning System (GPS) and DIfferential Global
Positioning System (DGPS). Terrestrial networks
that provide more coverage, SMS, and GPRS as a
medium for data transfer have enabled compa-
nies to keep their productivity high, lower oper-
ational cost, improve efficiency,
reduce turnaround

Digital Business l Case Study

How Technology Can Help Your Organisation
Business
Digital

92 Why-Fi?

Case Study

How videoconfe-
rencing works90

Need a system
that keeps a tab
on your mobile
assets? MobiApps
seems to have a
logistical tool
ready for you

Dude! 
Where’s My Truck?
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their vehicles, provide infor-
mation about over-speeding

vehicles, unscheduled stops
and a host of other in-

vehicle conditions.
It streamlines the

management of fleets
by providing reports

and analyses of vehicle
journeys, and provides com-
plete journey records for 

all vehicles. This helps 
in planning, tracking,
and scheduling. 
It also assists fleet
managers to have
better control over
operations while
enhancing value-
added services to
their customers.

What Does It Do?
The m-Trak system is a

real-time vehicle tracking system
with a tamper-proof unit having a built-

in keyboard and a LCD panel. It can show the
real-time position of the vehicle or play back the
vehicle’s travel path on a digital map. The infor-
mation will include the current location of the
vehicle, distance travelled, vehicle speed,
number of stops made, and the location and
duration of the stops.

Its user interface enables two-way voice and
text communication. It also has an external
handset attachment for voice communication,
an inbuilt address book, call-log facility, one-
key predefined messages, built in GSM/SMS
communications, optional RF wireless commu-
nication, and an optional SOS switch. It can be
configured using a remote, can be customised
to meet client-specific requirements, and is also
capable of monitoring events occurring inside
the vehicle. 

m-Trak’s functionality integrates a host of
technologies. The GPS receiver determines the
vehicle’s location; after identifying the loca-
tion, the information is sent via SMS to the fleet
manager’s control station. The m-Trak control
station software then plots the vehicle’s loca-
tion on a display map, which can be viewed by
the fleet manager. (See infographic)

The Technology Behind It
MobiApps has designed the m-Trak solution
mainly around the Global Positioning
System (GPS). 

The GPS technology offers accurate infor-
mation such as latitude, longitude, altitude,
date and time, speed, moving direction, and dis-
tance (derived). In tangent with GPS, MobiApps
also uses terrestrial wireless communication
systems such as GSM and the Internet as the
medium for user interaction.

MobiApps adopted GPS, as it is a worldwide
radio navigation system based on a network of
24 satellites. These satellites determine the posi-
tion of any object on earth, provided these
objects have a GPS receiver. These GPS receivers
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cycles, and enable timely delivery, resulting in
delivering better service. 

Taking advantage of this, MobiApps, a Ban-
galore-based provider of hybrid terrestrial and
satellite technologies for commercial communi-
cations has developed a mobile vehicle tracking
system, which helps track, manage, access, and
monitor all your trucks or other mobile assets
developed m-Trak, an online asset-tracking solu-
tion that has been designed to support logistics
and transportation.

m-Trak provides real-time information on
fixed and mobile assets. It helps address issues
such as tracking, monitoring, managing, and
communicating with all mobile assets in real-
time. m-Trak integrates GPS technology, mobile
telephony (GSM), and the Internet, to provide a
solution that addresses these key challenges
with real-time, location-relevant, and time-sen-
sitive information. The m-Trak system helps
receive alerts from the assets, track assets on
map, generate reports, replay routes, and com-
municate with the asset drivers.

m-Trak is available in three variants:   m-
Trak 50, m-Trak 75, and m-Trak 100. m-Trak 100
helps fleet managers pinpoint the location of

How It Works
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tune to a particular frequency and listen to the
signals coming from the GPS satellites. 
The number of satellites transmitting signals
to the receiver determines the accuracy of 
the reading.

However, GPS receivers do not have the
ability to relay this information. This is where
the need for a wireless network arises, which
could be terrestrial networks such as GSM,
CDMA, CDPD, VHF, etc. It could also be a 
non-terrestrial network such as a satellite net-
work, which is capable of transmitting data
from the object to the asset manager’s
control room.

Next, the ‘short messages’ pro-
vided by the GSM network can be used
to relay the data from the m-Trak
device to the asset manager’s
office/control room. The GSM modem
periodically receives these messages in
near real-time. The GSM modem then
transmits these to the m-Trak soft-
ware, which processes them and plots
them on a visual map.

The  m-Trak device provides sup-
port for off-line storage of location
data in the device as well. This is
useful when the asset is in a remote
area where the terrestrial network
coverage is absent. So, there will be a
brief period when the asset manager
would not be able to track the asset in
real-time. In such a scenario, in order
to prevent loss of tracking data, the
software allows for storage of loca-
tion data locally in the device. Once
the asset comes back into a coverage
area, the stored data is transmitted
back to the control room. The asset
manager would now be able to view
the path taken by the asset in
the off-coverage area.

Customers Galore!
Asset tracking can be cost-effective
for the following customers: 

Industries where a production assembly
line depends on raw materials arriving ‘just
in time’

Hazardous chemicals and gas 
manufacturers who require safe 
transportation of their goods

Companies manufacturing high value
goods that require safety against pilferage

Transporters of frozen/perishable goods
Courier and express cargo companies who

require tracking of consignments 
Taxi operators, who require optimal usage

of their fleet by despatching the nearest cab to
a customer point

Public transportation systems that require
tracking of buses to provide real-time updates 
on arrival and departure to passengers

Companies that require a billing of mileage
Police force for patrolling, etc.

Currently, MobiApps’ list of clients includes 
the Bangalore Metropolitan Transport 
Corporation (BMTC), Karnataka State Road 
Transport Corporation (KSRTC), Safexpress, 

Dell, Ford Motor Company, General Motors 
Corporation, Hyundai Motor India Limited, 
Praxair Inc., Transport Corporation of 
India, Ltd. (TCIL), Life Fitness, Mercury and 
Wipro, amongst others. 

To understand what customers think, we
spoke to Ankit Kumar, manager, Network
HICON, Safexpress Pvt Ltd, a bangalore based
provider of a range of logistics and supply
chain solutions including door-to-door distri-
bution, single source invoicing, reverse logis-
tics, packaging solutions, etc. Their network
comprises over 513 locations of more than
2,400 vehicles, operating over 750 routes, 365
days a year. MobiApps is providing fleet man-
agement solution to track and manage their
logistics operations.

“We have about 3,000 vehicles in all on our
fleet, for which we have started planning imple-
mentation of the tracking system. We started
using the m-Trak system about eight months ago

and have been very satisfied. We have noticed a
huge difference in the stoppages, time taken,
departures, etc. and are quite satisfied with the
system,” says Kumar. 

Looking Forward
After a tie-up with the Tata Group Mobi-Apps is
very bullish about it's future. "There is a large cus-
tomer base that we are yet to tap into," says
Amitabh Satyam, Country Head, MobiApps. Like
any other Indian IT-services provider, MobiApps
too to expand its business beyond India shores.
Southeast Asia and the Middle -East are the areas
of focus for this logistics application provider.

But is the Indian market ready for a high-tech
tool such as m-Trak? MobiApps says that it has a
survey to back-up its claims about the large cus-
tomer base. However, convincing the smaller
transporters about the long-term benefits that
can be derived from using the software is not
going to be easy. And considering that the Indian
transport sector is largely unorganised and sur-
vives on very small margins, only time will tell
whether MobiApps, with its fancy logistical tool,
will be able to crack the market.

preethi_chamikutty@thinkdigit.com
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Let’s Meet Online

1

How real-time video sessions take place over an ISDN line or
broadband connection 

Cameras
One or more webcams or small video cameras,
with video input connections  

What You Need:

Videoconferencing Sessions 
Can take place between clients in different rooms within the same
premises, different offices within a city, as well as in different
countries. In a multi-party session, a multipoint control unit (MCU)
is used to mix the audio and send the video of the predominant
speaker to every screen. Like a telephony PBX, a video PBX is used
to switch calls and provide call forwarding and call transfer.

Speakers
To receive audio input from the client’s end

A Microphone
To enable audio input

A LAN Card
A Network Interface Card connects your PC to a LAN,
which provides access to a broadband connection.
Else, connect directly to a dedicated ISDN line. 
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2 Web-based Videoconferencing
Can take place using chat software such as
Yahoo! Messenger, or videoconferencing
software such as Microsoft’s LiveMeeting
or the WebEx client. WebEx requires just a
Web browser and a phone.  

3 Videoconferencing Over Virtual 
Private Networks (VPNs)
Some companies set up private Wide Area
Networks spanning large geographic areas to
connect branch offices. A VPN uses
encryption, and provides a secure tunnel over
the network with a guaranteed bandwidth.

Codecs
You will also need to install a codec—
hardware or software that compresses
and decompresses audio and video data
streams. Codecs reduce the size of audio
and video samples so as to speed up 
transmission.

First Steps
Set up the PC with the requisite
components to facilitate an audio-
visual session. Connect the PC to a
dedicated ISDN line or broadband

connection. Install the
videoconferencing software;

ensure that the software on
the client’s end is
compatible with yours. Dial
the client’s number. Once
the two sides are
connected, you will be able
to share audio-visual data.

Digital Business l Visual Explanation
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Vying With Wi-Fi 
If this were the company awards ceremony, we
would have numerous distinguished speakers
gushing superlatives, introducing the persona
that single-handedly revolutionised mobile
computing. Yes, that’s perhaps the most apt intro-
duction to Wi-Fi. Without it, every mobile device,
from laptops to PDAs, would be nothing more
than external hard drives—absolutely useless on
their own, but great for transporting data from
one network to another.

But should all businesses set up a Wi-Fi
network? If only it were that simple! New compa-
nies have no problem deciding: Wi-Fi is the way to
go—the setup is quick, easy and affordable, and
shifting offices is as easy as packing and unpack-
ing the equipment. However, existing businesses
really have to weigh the mobility offered against
the costs. If you have a huge inventory manage-
ment setup, and lots of employees using equip-
ment such as laptops and barcode scanners, you
should seriously consider Wi-Fi as an option.

I’m Sold. What Now?
You need to do a site survey, and then decide
upon the number of access points you need in
order to be able to provide seamless network
coverage. You also need to keep in mind that
there’s no such thing as a true wireless LAN
(WLAN) with no trace of wires. Your servers and
access points need to be connected via a regu-
lar wired LAN to give them the connection

Robert Sovereign-Smith

omputers invaded us, and won. The very
nature of businesses today demands
mobility and instant, anywhere access to

critical information. While the Internet has
given us this much-required data mobility on
a global scale, the same does not hold true
within our own offices. Unfortunately, the
desktop has been the ruling party so far, and
mobile devices are only just gaining
popularity.

We tend not to realise how chained we are
to our seats at work. Executives jet across the
world, access their e-mails in airports world-
wide, meet with clients in hotels and restau-
rants, and download presentations; yet, within
their own offices, they are confined to a 4 x 6
foot space called a cubicle—and all because of
a short wire with an RJ45 connector on one
end. Networking, the bane of mobility!

DIGIT APRIL 2005
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That’s the
question most
medium-sized
businesses are
asking
themselves…
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stability they need. You also need to make sure that you
overlap the access point coverage areas sufficiently to offer
the maximum possible network speeds to your users.

You will obviously need a lot of Wi-Fi-enabled equip-
ment to make use of your WLAN setup, and if this equip-
ment isn’t already deployed, this cost needs to be factored
in as well.

The Site Survey
A proper Radio Frequency (RF) site survey is a requisite, and
it can be done in two ways—as a task left to the firm you
hire to deploy WLAN, or done by your in-house IT deploy-
ment team. Of course, smaller businesses could have a
systems engineer using one access point and a laptop to
set up and walk around the site checking signal strengths.
Whatever the case, your WLAN deployment needs plan-
ning, as anything, from a wall to machinery can disrupt
the wireless signals.

You must also consider actual working conditions
when planning your WLAN setup. For instance, a ware-
house where a site survey is done when there is less activ-
ity and no goods are stored; after deployment, however,
you may find that running machinery, or even piled up
goods, can interfere with the wireless signals.

You should recognise the dynamics of your environment.
As explained above, a warehouse may require different deploy-
ment tactics than a regular office. In an office, users will be
at their desks most of the time. However, a regular office will
also have cubicles, walls and other obstructions that will
adversely affect the signal.

A Seamless WLAN
A seamless WLAN setup is one where users can stroll across
the covered area, and at the same time have constant
access to the network. This is easier said than done, and is
a lot more complicated than just setting up access points
to cover the desired area. The 802.11 specification offers
14 different channels, or frequencies, at which access
points can be set. The problem is, these frequencies are too
close together—a difference of just five MHz between chan-
nels—and interference is caused. To overcome this inter-

Digital Business l Smart Business

Perhaps the most ignored feature when choosing an access
point, antennas should be given considerable thought. Most

access points come with omni-directional antennas, which
means that the access point sends out a signal in the form of a
sphere all around itself. This is especially useful when placing an
access point in the centre of a smaller office, as it can cover the
entire office area easily. However, it is when we reach larger
offices—where numerous access points are needed—that
directional access point antennas may offer you some relief.

Directional antennas also offer some relief for those
obsessed with security, as you can ensure that all your access
points offer a known and fixed coverage area. Directional
antenna-based access points could be set to ensure that no one
ever gets a signal outside the office walls, and thus cannot hack
into the network. Directional antennas also help you plan and
position your access points better, so as to offer maximum
coverage. Their biggest advantage, however, is the fact that
they offer greater bandwidth and range, as a result of being
focussed in a single direction.

When deploying a WLAN in a large multi-storeyed office,
uni-directional antennas will be needed to ensure that there is
no overlap of signals of access points running on the same
channel, thus breaking the seamless network.

Access Point Antennas

1/2 pg V. AD
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ference, the three standard channels used are
1, 6 and 11. To offer seamless roaming around
the coverage area, you will need to ensure that
any three neighbouring access points are
configured to run on these three different
channels.

This is easy when setting up a two-dimen-
sional coverage area, say, on a single floor.
However, when you have to do this for a build-
ing, with access required on multiple floors,
sketch a 3D view of your coverage area and make
sure that all access points—on all the floors—are
set to operate on different channels. A good
blueprint of your office building will come in
handy. You will also need a wireless network
monitoring tool to test the actual setup. 

Bandwidth
Every network needs to provide its users with
the bandwidth they require, and this is where
wired LANs definitely have an edge. A standard
wired LAN will offer your users a theoretical
bandwidth of 100 Mbps, almost double the
theoretical bandwidth of 54 Mbps for a WLAN.
However, just as you do not expect the full 100
Mbps bandwidth from wired LANs, you cannot
expect anywhere close to 54 Mbps for WLANs.

The most logical calculation is to halve this
bandwidth and divide it by the number of
users you plan to provide access to in a given
area. For instance, if there are 10 users on a
WLAN per access point, each user will get
27/10 = 2.7 Mbps of maximum bandwidth,
which will suffice for most. Only users who
constantly transfer  large files to and from a
server will need more bandwidth. Take into
account this user-density factor when deploy-
ing your WLAN.

Security
Now that you have your WLAN plans in place,
your biggest concern will be security. No one
wants to have their private office LAN visible
to the outside world. Apart from people snoop-
ing around your LAN, you will also be put at
risk by worms and viruses from neighbouring
WLAN setups or wireless devices. What you
need to do is ensure that your WLAN is as
secure as it can be.

First of all, get a WLAN monitoring tool. In
case your system administrators largely use
Linux, then ‘kismet’, the default WLAN moni-
toring tool for Linux, will do the job. Windows
users can choose from a huge list of commer-
cial as well as free tools.

A seamless WLAN will need all access
points to have the same Service Set Identifier
(SSID). The primary thing systems administra-
tors should do is change the SSID so as to leave
others guessing. Default SSIDs for various

Planning Access Point Placements

Figure 1: For an office with multiple floors, you need to make sure that no access
point’s signal overlaps with any other’s, whether on the same floor or on the floor
above or below. In this figure, the shapes shown are each access point’s coverage area;
the colours green, brown and blue denote the channels 1, 6 and 11

The biggest thing that afflicts a WLAN is
interference. A WLAN signal is fragile and

can easily be disrupted by something as
simple as a wall, so the last thing you need
are pesky devices sending your WLAN
crashing. The 802.11 protocol runs at about
2.4 GHz, and this frequency is prone to
interference from numerous sources. The
problem with interference is the additional
load that is put on your networks. If one
wireless device is sending data packets to
another, and interference occurs, the
receiver gets a packet with errors. 

Most often, receivers are programmed
to not respond to the sender when this
happens, and this results in the sender
transmitting the packet once again. The
problem here is that all these packets being
re-sent can use as much as half your
bandwidth, which will hurt the overall WLAN
performance. Some devices that can cause
interference with WLANs are:

Cordless phones running at 2.4 GHZ
These are the latest cordless phones that
offer a longer range from their base
station. However, the problem lies in the
fact that these cordless phones use the
same frequency as WLANs, and thus turn
out to be the biggest source for
interference. If you have any of these
phones installed in your office, you will
need to get rid of them whenever you
install your WLAN or be ready to face
pathetic speeds.
Bluetooth-enabled devices
Many mobile phones and PDAs today are
Bluetooth-enabled, and this can cause
interference if a user uses such a device
where the signal strength of an access
point is already low—far away from the
access point and close to a device
connected to the WLAN. Thankfully,
current research, driven by the increase
in popularity of both Bluetooth-enabled

devices and Wi-Fi, will soon put an end
to this menace.
Microwave ovens
Every time employees heat their food, you
might find users in the immediate
surroundings yanking out clumps of hair.
Placing an access point next to a microwave
oven is a definite no-no, as these ovens
emit signals that clash with Wi-Fi.
Power Cables
Improperly shielded power cables can
interfere with wireless signals, and it is best
to keep access points positioned away from
power cables or power junction boxes.
Other WLANs
Most companies in India share buildings,
floors or even offices with other companies.
In such a scenario, a neighbouring office’s
WLAN could cause interference with your
own deployment. This is something you
should inspect and test thoroughly when
doing your RF site survey.

The Interference Dilemma
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access point manufacturers are well known,
and hence these should be changed immedi-
ately. Make sure you don’t use your company
name or initials as the SSID.

Also, you must enable encryption of signals so
that unauthorised users cannot use wireless
Ethernet sniffers to spy on the network. Even the
128-bit WEP encryption is fallible. For details on
problems that WEP faces, visit http://snipurl.com/
dggs. The latest 802.11i standard addresses these
problems and is recommended for its use of
AES encryption.

Turn off broadcast pings to make access
points invisible to sniffers and simple network
analysis tools. If you are paranoid about secu-
rity, program each access point to filter
requests by MAC addresses, though you will
need to add every single wireless device’s MAC
address to every access point in the network.
Or simply secure your network by information
overload. Once you set up WLAN, go to
http://snipurl.com/dgh4 and download FakeAP.
When you run this, any intruder will see thou-
sands of access points—so your actual access
points are hidden by vast numbers.

In Sum
Though there are costs involved, and security at
stake, the fact is that as wireless technologies get
faster, better and more secure, Wi-Fi could give
your business a welcome boost of steroids. In fact,
in certain cases, you might find that Wi-Fi is the
only option.

Look out for the Fast Track book on Wire-
less Networking, free with the May 2005 issue
of Digit! 

robert_smith@thinkdigit.com

Possibly the best way to check your security is to use the very tools someone
would use to gain unauthorised access to your WLAN. Here’s a short list of

tools that are built either to attack or defend:
AAiirrSSnnoorrtt:: A WLAN sniffer tool that recovers encryption keys by passively monitor-
ing transmissions. It calculates the encryption key after it has received enough
packets. It can be downloaded from http://snipurl.com/dgif
WWEEPPCCrraacckk:: This uses the latest RC4 key scheduling to crack a WLAN’s WEP code.
Get it from http://snipurl.com/dgih
NNeettSSttuummbblleerr:: This tool lets you ‘discover’ any WLANs or access points in your
vicinity. This tool can also be used for your site survey, as it will inform you of
any existing WLANs that may cause interference or help you know your signal
strength at different points. It can be downloaded from http://snipurl.com/dgij
IInntteerrnneett  SSccaannnneerr:: The Internet Scanner provides an automated network
vulnerability assessment. It performs distributed or event-driven probes of
network services, operating systems, routers/switches, servers, firewalls, and
application routers to identify potential risks. Try an evaluation version at
http://snipurl.com/dgil
WWiirreelleessss  SSccaannnneerr:: This detects and analyses your WLAN access points and
clients. It identifies and reports unauthorised and misconfigured devices. Try it
by going to http://snipurl.com/dgim.
BBllaacckkIIccee  PPCC  PPrrootteeccttiioonn:: This is a personal firewall for laptops and Wi-Fi-enabled
desktops with the ability to protect you from intrusions and client-to-client
attacks. Download a trial from http://snipurl.com/dgio

You should also visit www.iss.net, the homepage of Internet Security Systems,
a leading security consultant to companies and governments world-wide. Here, you
will find some of the tools mentioned above, and also many security solutions for
enterprises, educational institutions and even governments.

Software Saviours

1 Col Ad
If you are
paranoid about
security,
program each
access point to
filter requests by
MAC addresses
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Wired LAN v/s Wi-Fi 
Is it time to replace the conventional wired LAN with a Wi-Fi network? Find out…

ICICI bank has a network of 505 branches and more
than a 1000 ATMs in the country. It also has its pres-
ence in UK, Canada, Singapore, and other countries.

ICICI chiefly uses wired Local Area Network (LAN) for its
scale of operations.

“Almost all the ICICI offices work on wired LAN. As a
bank we do not need to have a complete Wi-Fi setup
because the staff would prefer to work on desktop com-
puters rather than laptops. Besides, Wi-Fi definitely works
better with laptops and just for the sake of having a Wi-Fi
connection we cannot afford to replace our existing desk-
tops with new laptops.

“However, a few of our branches do use Wi-Fi in areas
such as conference rooms and training centres to name a
few. Since we are using wired LAN at the moment, the
transition to Wi-Fi and the added burden of logistics and
management is not be feasible.

“Another major concern for us is security. If an out-
sider gains access to our customers’ account or to insider
information, the damage could be colossal. Banks func-
tion on closed networks, where it is not advisable to have
Wi-Fi connectivity.

“Nevertheless, we are using Wi-Fi as a pilot run in
some branches. For instance, at these branches, we pro-
vide our hostesses with a tablet PC and they assist cus-
tomers who are waiting in queues by solving their queries
and doubts. Through Wi-Fi, they can tell account holders
whether their cheque has been cleared or not, prepare
drafts and provide other similar services. This method
prevents queuing as customers are not required to go to
the counter any more. 

“Such experiments are being conducted using Wi-Fi.
Further deployment of Wi-Fi in our branches will depend
on various parameters, an important one being customer
feedback. Having said that, I still feel Wi-Fi will not
replace our wired LAN office environment.”

Afive star hotel in Mumbai, Hotel Marine Plaza has a
lodging capacity of 68 rooms. Though the rooms
are yet to be Wi-Fi (Wireless Fidelity) enabled, all

the restaurants, business rooms and terraces at Marine
Plaza are Wi-Fi hotspots. 

“We are living in an era where there is a constant
need to stay connected, not only to our workplaces but
also various other setups worldwide. Wi-Fi comes to your
rescue in such cases. At Marine Plaza, we access the
wireless Internet service through Wi-Fi technology.
Guests staying at the hotel have access to a high-speed
wireless Internet connection. 

“Along with EZ-COMM, our provider for Wi-Fi access,
we have adopted a model, which eliminates most of the
disturbances that occur in a typical LAN network and we
are able to have an uninterrupted Internet connection.
We can offer our guests a broadband connection of 512
Kbps. Moreover, they have the facility to buy prepaid
cards that can be used at any of the EZ-COMM wireless
locations across India.

“An organisation may function in different time
zones, and at times it becomes unavoidable to do official
work from home or even during vacation. Some guests
may be on a business trip. We also have  international
guests staying at the Marine Plaza. It is true that many
customers prefer to stay with us as they consider the
availability of Wi-Fi connectivity an added advantage to
their package.

“Altogether, we have six floors including the
ground floor of our building on wired LAN network. That
apart, most of our guest area is equipped with Wi-Fi for
Internet access. I believe that our business needs to be
completely Wi-Fi enabled to function better. Wi-Fi will
definitely help us serve our customers better. In terms of
expenditure,  Wi-Fi will work out be more reasonable and
effective than wired LAN.”

As told to Preethi Chamikutty (preethi_chamikutty@thinkdigit.com)

Transition to Wi-Fi with the
added burden of logistics and
management is not feasible

In terms of expeniture, Wi-Fi will
prove to be more reasonable and
effective than wired LAN 

Anurag Bajaj
General Manager, 
Hotel Marine Plaza

Banks function on closed
networks, where it is not
advisable to have 
Wi-Fi connectivity 

Our business needs to be
completely Wi-Fi enabled in
order to function better

Pravir Vohra
Chief Technology Officer,
ICICI Bank
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Renuka Rane

Babulal Mishra, of Jamuna
Park, Delhi drives a unique
auto rickshaw to his work-

place—the courts, at Delhi. He is
a digital photographer tending
to the passport photo require-
ments of applicants, or litigants
near the courts. His auto is a
converted, mobile digital stu-
dio, and attracts a lot of atten-
tion from onlookers. Mishra
simply clicks a picture with his
digital camera, and takes a
printout from a photo-printer,
all within a matter of minutes!

He gets anywhere between
20 to 60 customers

each day, and has been doing
this for a year and a half now,
ever since he became part
of HP Digital Photo Studio’s—
Project Muskaan.

The Genesis 
HP Digital Studio, a chain of
instant, digital, photo print serv-
ice has integrated digital print-
ing. ‘Project Muskaan’, or the
‘HP Digital Photo Studio’ proj-
ect, was launched by HP India in
May 2002 as a platform to gener-
ate sustainable self-employment,
and enable revenue generation
for people from urban and
rural India. 

Explaining the objectives
behind the venture, HP India’s
digital photography products,
consumer segment manager,
Ashwini Aggarwal says, “Project
Muskaan was launched in May
2002 to drive the concept of

Technology Beyond WorkHackers Did It!Modem
Man100 120

Leisure
Digital

digital photography into the
Indian mainstream photography
segment. We wanted to explore
how technology could be used in
emerging markets and be fitted
into new products, which would
specifically address the needs of
emerging markets in India.” 

Existing photo studios and
new entrepreneurs have setup
shop through Project Muskaan
by using the HP Digital Studio
package provided. The project
has an ever increasing 5,000-
member franchise network serv-
icing over two million customers
a month, and is spread across 75
cities and 1,000 villages in India.

Products And Prices
An individual photographer, or
an existing photo studio can
avail of the HP Digital Studio
package,  which includes a
multi-media personal computer,

Touched By Tech
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Creating A Million Smiles 
Mobility, technology and digital photography combine to offer livelihood, and a smile 



photo printer, scanner, digital
camera, and the HP Digital
Studio software. All of it comes
at a cost of Rs 50,000, as opposed
to a year ago, when the price was
around Rs 1.5 lakh. However, in
villages, where affordability is a
prime area of concern, the
company offers a photo printer
along with a camera for as low as
Rs 15,000. Moreover, one can
take advantage of easy bank
financing options, thus making
the package more affordable. 

Most of the photographers
did not want the computer inter-
face—all they wanted was a digi-
tal camera and an appliance for
printing. So, the company intro-
duced a lightweight Photosmart
printer, where one can simply
insert the memory card of the
camera into one of the card-
reader slots on the printer, see
and select the images, set print
size, quality and print crisp
pictures. This made the job
easier for photographers, who
didn’t have to resort to the
computer for either manipulat-
ing the images, or for printing. 

Bridging The Digital
Divide 
Project Muskaan aims to take tech-
nology to the rural and urban
masses, by converting conven-
tional photo labs into digital
photo studios. “We wanted to
narrow the digital divide between
urban and rural Indians. To target
emerging markets, we opened our
first lab in the Kuppam
constituency, of district Chitoor in
Andhra Pradesh. Our visits to
villages received a tremendous
response and people showed
enthusiasm towards using digital
photography,” explains Aggarwal.

Creating Entrepreneurs
The company also targeted
commercial photographers,
analogue photo studios, street
photographers, and tour opera-
tors whose services include pass-
port size photos, photo identity
cards, posters, and visiting cards.  

Consider Suniti, a young
village girl from Kuppam
district. When she shuts shop for
the day, she has earned a
respectable Rs 200 per day from
her profession as a digital
photographer to double her
family household income. 

“A significant revenue earn-
ing stream, Project Muskaan is
proof that such an endeavour
can be made financially sustain-
able, and even profitable. In
rural India, photo prints are
now available on the spot, at
affordable prices and people
don’t have to face the delay of
getting the prints developed and
delivered from a nearby town,”
says Aggarwal. 

In rural areas, Project
Muskaan serves to create
employment, encourages entre-
preneurship, and also aids
economic and social develop-
ment. The Digital Studio project
has gained prominence in north
India in the Sirsa district in
Haryana, Manas village,
Rishikesh, Uttaranchal, and also
in southern India by giving
villagers—men and women,
young and old alike, an oppor-
tunity to turn entrepreneurs.

From Polaroid To Digital 
So, is the transition from the
conventional forms to digital
photography advisable? It’s a win-
win situation for both the
customers as well as the photog-
raphers as Mishra is quick to
point out, “Customers get instant
pictures and we get instant
payment. So both of us are happy!
Moreover, foreign tourists insist
on instant digital photographs.”

The instant turnaround
time, coupled with fade resist-
ant images and high print qual-
ity has helped users to increase
their daily margins leading to
higher profits. 

Ease of use, low cost, and
mass appeal of instant solutions
has tipped the scales in HP’s
favour. This strategy helped HP
gain a wider presence, and
remove misconceptions about
digital photography being costly
and difficult to handle. 
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Harish Mendiratta, owner of
Sanjay Photo studio in
Pahadganj, New Delhi says,
“When we were using Polaroid
print, it cost us Rs 35 to prepare
a set of four passport sized
photographs. We went digital a
year ago and now it costs us Rs
12 for the same. We also have a
quick return on investment,
ease of printing and richer
colours. We can now develop all
sizes of digital photographs—
from passport-sized ones to
large posters.” 

“Earlier, we had to click
pictures, then develop them in a
dark room. Thanks to digital
photography we have bid good-
bye to this lengthy and cumber-
some process. We also perform
colour correction such as
increasing or decreasing the
contrast and so on. So there are
many options available to
us at an affordable price,”
Mendiratta adds.  

Evangelising Digital
Photography
D P Chauhan’s Chayya Photo
Studio in Noida, Uttar Pradesh, is
nearly 12 years old. Chauhan
became part of Project Muskaan in
2003. He explains, “Representa-
tives from HP provided me with
the basic training. Through
brochures and practical demon-
strations they explained what digi-
tal photography is all about. They
helped me with the installation of
the equipment and frequented my
studio for three to four days until
I was comfortably settled.”

The company provides retail
franchisees and members of
Project Muskaan with marketing
support initiatives such as train-
ing, branding, promotional mate-
rials such as user account
management, loyalty programs,
and special pricing. 

HP India’s  initiative to bring
photo printing to the masses has
sparked off a digital imaging revo-
lution in India. 

renuka_rane@thinkdigit.com

The HP Digital Studio package
includes an HP personal
computer, HP photo printer, HP
scanner, HP digital camera, and
the HP Digital Studio software 
for Rs 50,000. 

In villages, HP offers an HP
photo printer along with an HP
camera for as low as Rs 15,000.

What Is Available

A digital photgrapher, this village belle in Andhra Pradesh is
now an independent and confident young woman

Our visits to
villages
received a
tremendous
response and
people
showed great
enthusiasm
towards using
digital
photography

Ashwini 
Aggarwal
Consumer
Segments Manager,
Digital Photography
Products, HP India
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An interactive programming
language developed in 1990,

by Guido van Rossum, originally as
a scripting language for Amoeba
OS, is now an open source project,
managed by a non-profit
foundation. Name it.
a. Ruby b. Java
c. Python d. Visual Basic

Name the company which
offers the popular blogging

service LiveJournal, and open ency-
clopaedia Wikipedia.  
a. Wikimedia Foundation    
b. Wmedia Foundation   
c. Wiki Foundation   
d. World Media Foundation

Intel is technically aiding a
project by Richard Wool

(University of Delaware), who
wishes to recycle discarded ________
to make circuit boards, replacing
petroleum-based components with
keratin-based composites. 
a. Chicken feathers b. Eider feathers
c. Chicken wings     d. Frog’s legs

The contents of this A-list
celebrity’s T-Mobile Sidekick

were recently published online,
after being allegedly hacked into.
It contained phone numbers of
Eminem, Vin Diesel, Christina
Aguilera, Andy Roddick and Anna
Kournikova. Name her. 
a. Britney Spears b. Paris Hilton
c. Jennifer Lopez d. Cameron Diaz

EduVision’s pilot project at
Mbita Point primary school in

western Kenya involves students
using a handheld computer with a
stylus to work on exercises in their
digitalised school textbooks.  What
is the device called?
a. E-vision b. E-slates
c. E-text d. E-pod

Name the Microsoft Outlook
companion released recently

by WinZip, which allows users to zip
files (automatically or manually)
when attaching them to messages.
Users can also encrypt them using
Advanced Encryption Standard
(AES) encryption.
a. Ziplock
b. ZipOutlook   
c. WinZip Companion for Outlook
d. WinZip Outlook Add-On 

Jef Raskin, who conceived
Apple Computer Inc’s __________,

died on February 26 this year, at
the age of 61.  
a. Mac OS X   b. Macintosh Computer 
c. iPod           d. iPod photo

Name the recently-unveiled
‘alternate-reality game’, an

extremely complicated series of
puzzles involving coded Web sites,
real-world clues (such as
newspaper ads or midnight phone
calls from game characters), set to
unfold on a global scale. 
a. Night Rider b. Complex City 
c. Perplex City d. VR World

What does the Windows
desktop shortcut ‘Windows-

SHIFT-M’ do?
a. Empty Recycle Bin
b. Restart the PC
c. Minimize all open windows
d. Undo minimize all windows

10

9

8

7

6

5

4

3

2

Across
7. Convert into data or 
image form processed by 
a computer (8)
8. Application-specific 
Integrated Circuit 
(abbr) (4)
9. Bombard attempt to 
violate computer security (6)
10. Accounting journal upsets 
red gel (6)
11. Ultra Large Scale 
Integration (abbr)(4)
12. Expert in circuit design (8)
15. Professional beans as  
software (8)
19. Short for computer 
advertisement (4)
21. Application software for
Macintosh computer (3,3)
23. Wear off unit of instruction (6)
24. ______Code, final 
ready-to-manufacture 
software (4)
25. Teething ring is a 
conciliator (8)

Down
1. Contraction of
Windows and
Intel (6)
2. Software theft
rearranges a pit
ring (8)
3. ‘Ni’ in Ni-Mh
batteries (6)
4. Temporary loss
of contact by a
server (6)
5. Range of
frequencies used
for transmitting a
signal (4)
6. Anemic burns
theatre (6)
13. Unit of electrical
resistance is a 
mystic syllable, it’s heard (3)
14. Restrict information in a
categoric arrangement (8)
16. Start off treachery for rational
motive (6)
17. To receive connection request

from host (6)
18. Pick out highlighted text with
cursor (6)
20. Purplish-blue colour of mouse (6)
22. Esau reversed the 
operational state 
of a computer (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
editor@thinkdigit.
com

Of Hacked Sidekicks
Name the innovative
lighting product, a

desktop-sized device, which
splits three electronic
lasers, high-intensity blue
and ultraviolet LEDs, and
throws them into a hand-
cut faceted crystal to create
impressive mood lighting. 
a. Laserbulb b. MoodPod    

c. MoodLight d. Laserpod

1

Last Month’s Solution

1. Laserpod
2. Python
3. Wikimedia     

Foundation
4. Chicken feathers
5. Paris Hilton
6. E-slates

Answers

7. WinZip Companion
for Outlook

8. Macintosh
Computer

9. Perplex City
10. Undo minimise all

windows

Worldwide, companies with
100 e-mail addresses or

less have received up to 10
times more spam than those
with 10,000 addresses or
more (according to research
firm Postini).

Did you
know?

Send in
your
answers
to the crossword to
TQ@thinkdigit.com.
One lucky participant will
win a Professional Java
Programming
by Brett Spell, published by Shroff Publishers 
Winner of March 2005 Crossword is
Neelima Premsankar, Calicut.

Win!
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A look at two Image Managers that bring order to your photo collection

Sanket Naik

A
digital camera has its
advantages, such as low
running costs, instant
access to results, and so

on. However, managing the
images after transferring them
onto your computer is a gargan-
tuan task. With a film camera, all
you had to do was click and send
them to the studio for develop-
ing, and they even would give you
an album to store your photos! 

With digital cameras, though,
your photos are now stored as
files on your computer. Searching
through a number of un-indexed
files on your computer can be a
veritable nightmare.

The problem is akin to when
MP3s were the rage. You would
have thousands of these files on
your hard drive with none tagged
properly, and searching for a
particular song was tedious.
Then, someone came up with a
multi-feature MP3 manager that

allowed tagging, simplifying the
whole process.

Similarly, today, we have
managers that take impeccable
care of your digital photographs.
They allow you to take complete
control of your digital assets, be
they photographs or videos. They
let you capture your photographs,
tag them, fix minor problems such
as red eye, apply basic effects such
as blur, and share them in the
form of slideshows, calendars,
VCDs and much more.

To take you through some
practices that you should help
you take care of your digital
photographs, we have chosen two
of the best available managers;
Adobe Photoshop Album 2.0, and
Picasa 2 from Google. 

As we proceed, we will look
into their utility value in terms
simplifying the image manage-
ment process.

Taking Those Images In
Typically, images on a PC have
multiple sources; they could be

those shot using your digital
camera, a scanned photograph,
photos taken by your mobile
phone or even wallpapers down-
loaded from the Internet. So, an
image manager should have the
option of capturing images from
all possible sources. The process
of acquiring images is often
termed ‘importing’.

As you will see, Photoshop
Album 2.0 has a neat, simple
interface for importing photo-
graphs. It has options for import-
ing from cameras, scanners,
mobile phones and folders on
your hard disk. 

Picasa 2, too, has a similar,
simple-to-use interface, but lacks
the structured segregation
offered by the Adobe product.

Once the photographs are
imported from the respective
devices, they are stored on your
hard drive. In Windows XP, ‘My
Pictures’ is the default folder for
storing images. However, as far as
possible, avoid storing your
photos in this folder. There are

…And There Was Order!
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need to be arranged; this is done
by cataloguing or categorising. 

Cataloguing is the most 
important step in image
management. It decides how fast
a particular photograph can be
searched from your collection. 

There are many ways of cate-
gorisation; the simplest is similar
to the directory and file structure
we have on our computers. 

A parent-child relationship
exists between the directory and
files. The disadvantage of such
classification is that a single file
cannot be linked to two separate
instances unless two copies of the
same files are put into two sepa-
rate folders. This is especially true
in the case of photographs, as
they are connected to a person on
multiple levels such as, the event,
the involved people, the place or
a variety of factors. 

So, if you want to segregate
your photographs, you have

multiple options to consider;
should they be categorised under
an event, people or place? 

To get past this hurdle, you
need another method for classifi-
cation, which runs parallel to the
simple directory and file struc-
ture and eliminates the need for
having multiple copies of the

same image. This is achieved by
means of ‘Tags’. 

Tags allow you to append
extra information to the same
photograph so it can be linked to
multiple occasions or people. 

Picasa 2 allows you to add the
folder name, captions for the
folder, information about the
place you shot the photos, and
the date at the end of the import-
ing process. This is the first level
of categorisation. 

Once the photos are arranged
in a folder, you can add captions
to individual photos too. So,
while searching, a filter can be
applied for these captions. 

For adding tags to a particu-
lar photograph in Picasa 2, you
need to select it and then click on
the ‘Label’ button in the bottom
pane. Every label entry is
displayed on the top left hand
corner. So for searching, you can
go through the label entries, or
type in the label or caption.

In Photoshop Album 2.0, once
the ‘Import’ function is
completed, images are placed in a
temporary folder—Photowell. The
next stage is to organise them. 

Images can be tagged either
by applying pre-defined tags or by
creating new ones. You can even
create sub-tags under a main cate-
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Importing photos is a one-step job in Picasa 2

Categorising images in Picasa 2—you can add captions too!

Adding tags in Photoshop Album 2.0 is a drag-and-drop process

two main reasons for this.
First, in case of a virus,

where your OS fails to boot,
a backup of this folder would

be required before you can rein-
stall the OS.

Second, as the ‘My Pictures’
folder is in the root drive, C:\, the
eventual increase in the folder
size will slow down your system. 

The best option is to create a
dedicated folder on a partition of
your hard drive, and then set the
appropriate path in the image
manager. You could even move
the entire ‘My Documents’ folder
to a different partition for safety.

Cataloguing
Once you import the images, they

From The Word Go
When you take a photograph with a digital camera, the camera
automatically attaches some information related to the photograph to
the file. This information is known as meta-data, which includes the date,
time, resolution, exposure settings and other technical information.
Image management applications often use this information to organise
photographs,; especially if the manager has a ‘Timeline’ feature. It is
therefore advisable to set the date and time of your camera before you
start shooting. All digital cameras allow appending names to the
photographs. Clever use of this feature reduces your post-shooting work
and also takes care of basic organisation of photos. For example, append
‘party’ to photos taken at a party, so when you download them, they will
automatically be named as party001, party002, and so on. 
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gory, for example, under the
main tag ‘people’, you can add
‘family’, ‘friends’ etc. It also
allows you to collect random
photographs and group them as
a collection (album). This comes
in handy when you want to
collect, say, all the photographs
of cars that are on your hard disk,
into one collection called ‘Cars’. 

Now, when you need to search
for any particular file, you can do
so using a tag. A point to note is
that Photoshop Album 2.0 does
not allow you to search by typing;
it has checkboxes against the
name of the tag. When you
search by applying a particular
tag, you select the check box
against that tag. You can also
check multiple boxes so that it
does an ‘or’, ‘and’ and ‘not’
search. This search methodology
is not available with Picasa 2.

Straightening Out Those
Rough Edges
No matter how diligently you

take those pictures, they lack
that extra bit, you think, would
make them outstanding. In digi-
tal photography, the trick lies in
post-shooting touch ups that can
transform mediocre photographs
into breathtaking shots. Red-eye,
blur due to shaky hands, and
dark photographs due to
improper lighting are some
common ailments in digital
photography, and any image
manager worth its salt should be
able to correct these aberrations. 

Picasa 2 comes with some
neat, handy tools that let you
play around with your photo-
graphs and bring in that profes-
sional touch. These tricks are
divided into three categories—
Basic Fixes, Tuning and Effects. 

Basic Fixes offer a one-click
solution for some common prob-
lems, such as Auto Contrast, Auto

Colour, and Fill Light. It also
consists of a ‘Cropping’ and a red-
eye removal tool. One feature in
particular that we found quite
unique and interesting was the
‘Straighten’ tool. It allows you to
straighten a tilted photograph
i.e., it aligns the subject along
the vertical axis.

‘Tuning’ provides that extra
control over lighting conditions
and shadows. Here, too, you have
a one-touch correct option,
which that does the magic, in
case you fall short of the requi-
site creative ability. 

Finally, ‘Effects’ allows you to

apply digital effects by using
filters. In all, there are 12 effects
that can be applied on the fly, at
the click of a mouse. In case you
don’t like the final output,
there’s always ‘Undo’!

Compared to Picasa 2, the
touchup options in Photoshop
Album 2.0 are limited, though it
does offer the necessary tools
cutting out the fancy bells
and whistles.

For fixing your photographs,
you need to click on the ‘Fix’
button in the main menu, which
opens a window. The fixes are
classified into General, Red-eye,
Crop and Filters. 

The fixing window has
‘Before’, ‘After’, and ‘Before &
After’ panes that let you view the
photo to be touched up in three
versions as the names suggest.
We found the ‘Before & After’
pane useful since the resultant
effects after applying a fix are
easy to notice.

For applying any fix in Photo-
shop Album 2.0, you need to click
on the check box that automati-
cally applies the fix. Clicking on
the adjoining ‘Expand’ button
reveals options for finer control
over the fix. 

Spreading The Warmth
The best part about digital
photography is that you can
make as many copies as you want
at a click of a button and share
them with friends and family.
You can also put them up on your
Web site, make an e-card, a
photo-VCD, or a slideshow. 

When it comes to sharing
photographs, Picasa and Photo-
shop Album have some unique
features. Photoshop Album 2.0,
though, scores over Picasa, as it
offers significant, yet unique and
simple ways to share photos.

Photoshop Album 2.0 allows
creation of your own albums,
slideshows, VCDs, eCards, calen-
dar, and photo book. It provides
you with more templates than
you would need for creating that
special album or calendar. 

In fact it requires just six
steps to make any of the above
(Refer explanation below). While
slideshows are common, albums,
calendars, and VCDs require
some optimisation for proper
printing and running. Photoshop
Album 2.0 does all necessary
optimisations for printing an
album on your desktop printer. 

Picasa 2 has options that help

The ‘Straighten’ tool in Picasa 2 lets you
correct wrongly-framed photos by simply
moving the slider

Photoshop Album 2.0 lets you preview effects before
you apply them

Your images can be enhanced by Effects such as ‘Soft Blur’ and
Sepia tone in Picasa 2

Fixes to the most common problems such as Red-eye are just a
click away in Picasa 2



103APRIL 2005 DIGIT

Digital Leisure l Test Centre

Creating A Calendar Using Adobe Photoshop Album 2.0

1. Click on ‘Create’ and select ‘Calendar’ to begin 4. You can add photos for each month of the year

2. The next stage is to choose a template 5. A preview of what the calendar will look like

3. Name the calendar and decide the year you want it for 6. You could e-mail, print or make a PDF of the calendar

create posters, collages, screen-
savers, and even a movie, straight
from the selected photographs.
Once created, you can print
them, e-mail them or send them
directly to blogger.com for shar-
ing using hello.com. 

Backup
Like all other digital assets that
can vanish off your hard drive in
the event of a crash or any other
outage, digital photographs are
prone to the same fate; a backup
is therefore a must. 

A good image manager

should provide you the option of
backing up your photos onto
CD/DVD or to some other
machine on your network. 

Both Picasa 2 and Photoshop
Album 2.0 have backup options
built into them, which work
flawlessly. Moreover, both appli-
cations allow incremental
backup, thereby saving precious
space on your hard drive.

The Verdict
To conclude, Picasa 2 and Photo-
shop Album 2.0 are excellent in
what they do, although Photo-

shop Album 2.0 comes across as
a full-fledged professional appli-
cation. Picasa 2, though, is excel-
lent considering it’s free. 

We recommend Photoshop
Album 2.0, though, to those who
have to deal with a lot of photo-
graphs on a daily basis. For
an amateur, Picasa 2 is more
than enough. 

It’s important to remember,
though, that digital photographs
can add up in numbers rapidly,
and maintaining an easy-to-
remember system of tagging and
nomenclature is a must. 

sanket_naik@thinkdigit.com

A copy of this calendar is available on the April 2005 Digit DVD
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Newsweek, March 14

History Is Going, Going, Gone
STEVEN LEVY, NEWSWEEK’S Senior Editor, has always
been writing technology articles with a twist. His
expertise lies in tying in technology and culture, and
how it impacts the common man. Here, once again,
he is at his usual best...

ALMOST 30 years ago I came to possess a little piece of
computer history. At the time, it seemed to me a fairly
straightforward handwritten letter acknowledging my
request to terminate an apartment lease, with instructions
on how I could recover my security deposit. What I did not
know then was that my landlord, a fellow with the
unforgettable name of J. Presper Eckert, was a pioneer of
the digital era, a co-inventor of one of the first operational

electronic computers.
The idea that this

note might qualify as a
historical artifact dawned
on me a couple of weeks
ago as I examined the
254 lots in the “History
of Cyberspace” collection
auctioned at Christie’s on
February 23. The earliest
items were from the
brilliant minds of the pre-
computer age such as
Charles Babbage, the
19th-century visionary
who designed a
programmable machine
known as the “the

Difference Engine.” But the meat of the collection
consisted of documents from the vacuum-tube cowboys
who made the early giant computers, especially my
landlord Pres Eckert. His key papers were up for grabs,
including the first business plan ever written for a
computer company. Other items included his badge for
that company (which became Sperry Rand UNIVAC), and
his letters, though none concerning an apartment building
on the Wayne Avenue in Philadelphia.

Jeremy Norman, the California bookseller who built
the collection, was thrilled that the auction garnered
unprecedented advance publicity. But on the morning of
the auction, he seemed nervous that the big money might
not show up. Indeed, a disappointed Norman afterward
conceded that the results were “mixed.” Though some of
the most desirable items, such as a letter from Lady Ada
Lovelace, who wrote the first programmes for Babbage’s
never-built machine (she was also Lord Byron’s daughter),
went for prices in the high five figures, barely half the
lots were actually sold.

Specifically, the auction lacked spirited bidding wars
between moguls who made billions in computers and
cyberspace. The only PC legend in attendance seemed to
be Lotus founder and venture capitalist Mitch Kapor. If Bill
Gates (who once paid $30 million (Rs. 1,305,750,000) for a
Leonardo da Vinci codex) or Larry Ellison had been taking
him on, we might have seen some fireworks.

Want to read more? Visit http://snipurl.com/digit_history

Wired, March 2005

The Fox Is Lurking
WIRED REPORTER REGINA Lynn writes how the Internet
has changed our concepts of dating, love, and even
sexuality. And that, she says, may not necessarily be a
bad thing.

REMEMBER the days when hooking up with romantic
partners online was considered weird? Something only geeks
or losers did? 

Even three years ago when I had an online dating profile,
people thought it was strange that anyone would try falling in
love “with a computer”. Three years before that, when I flew
across the country to meet a chat buddy in person, all the
media could talk about was how dangerous it was to get
involved romantically (or sexually) online.

Meet in a public place! the magazines screamed. Don’t
trust anything! Your intuition could get you killed! 

Meanwhile, thousands of people less wired than I were
quietly finding
companionship and sex
through the connections they
made online. It wasn’t just
the nerds. It was people fed
up with the singles scene,
people unhappy with their
current relationships, people
seeking escape into the
drama of a romance novel or
a porn film come to life. 

And it was people finding
the loves of their lives. 

These days, if you’re
single and have Internet
access, you’re about as likely
to have an online personal as

not. I even know a woman who checked her Yahoo! matches
from a computer at the library for months. She saw no reason
that the theft of her laptop should dampen her chances of
meeting Mr. Right, or at least Mr. Friday Night. 

Not long ago I read a series of articles about how
membership in online dating sites was leveling off. Of course
it is! If a matchmaking site is any good, it stands to reason
that people would pair off and cancel their memberships. If
the site isn’t good, members will move on to places where
they have more luck. 

Besides, even if you count the marrieds pretending to be
single, there are only so many daters in the world. 

And dating sites are hardly the only place to find partners
online. It seems that despite the mass adoption of database
dating, the more traditional ways of falling in love online are
just as popular as ever. Community and common interests are
just as important as a catalog. 

Last year, Janet Lever, a sociologist at California State
University at Los Angeles, conducted a survey on cybersex
and romance. “(We found that) a lot of people used the
dating sites who never wanted to meet anyone,” she says.
“Women especially had to learn how to distinguish between
guys looking for flirty and dirty talk from the men who
wanted to meet. And it turns out that an almost equal
number of people met someone through erotic chat rooms.” 

Visit http://snipurl.com/digit_date for the complete picture

MediaWise



The New York times, March 8

A New Direction at Google
GOOGLE NEVER FAILS to make news; if not for products, it
manages to hit headlines with developments in the
technology market. Bob Tedeschi of the New York Times asks
why Google is now interested in domain names.

AFTER Google disclosed last week that it had been granted the
right to sell domain names, the question in many minds was,
“Why?” Why would the company, which just reported click-
advertising sales of more than $1 billion (Rs. 43,525,000,000)
in the most recent quarter, compete in a relatively low-margin
business with Network Solutions, Yahoo!, GoDaddy and others?
Would it use its new registrar status to snap up expired
domains and show ads to wayward surfers? Is this a move
toward Google world domination?

“In a few years, you’ll be driving your Google to the Google to
buy some Google for your Google,” read one posting on Slashdot,
an online technology forum.

Eileen Rodriguez, a Google spokeswoman, hardly quelled
the speculation by explaining that the whole thing was really a
learning opportunity for the company. Google “has become a
domain name registrar to learn more about the Internet’s domain
name system,” she said recently in an e-mail. “While we have no
plans to register domains at this time, we believe this information
can help us increase the quality of our search results.”

Ms. Rodriguez would not say how having registrar status
might help Google improve search results. But Bret Fausett, who
publishes Lextext.com, a Web log following the domain name
industry, and who first disclosed the news that Google had
become a registrar, said Google could improve the quality of

search results by getting
better access to the list of
expiring domain names—a list
available only to registrars. 

When a domain expires
and changes hands, Mr.
Fausett explained, Google
can now more easily find,
scan and index the new site,
so it does not mistakenly
point searchers to a site with
irrelevant content, or place
advertisers on sites with
content that does not match
their products or services.

That alone could
profoundly affect the
domain name market, which
has rebounded partly
because of another Google

service, AdSense. Through AdSense, Google pays publishers to
display text ads related to a site’s content. Speculators often
buy the expiring domains of even marginally popular Web sites
and replace the site’s content. But because the practice
diminishes the usefulness of Google’s search engine, the
company has long sought ways to curb it.

Google’s continuing refinement of its search technology
underscores the intensifying competition in that market, which
has carried Internet advertising back to life in recent years.
MSN, Yahoo! and others have seen Google parlay popular
search technology into a dominant business by selling text
advertisements to marketers whenever consumers search for
words related to a business.

Read the full report at http://snipurl.com/digit_google
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License to steal?
The focus here is on how easy it is to steal digital
information, and the big button in green gets the point
across very effectively.

The Spaminator
Playing upon the movie title ‘Elvis has left the building’, this
one uses an Elvis look-alike to create an unusual ad setting.
No boring computers here. And the words “left the building”
drill it into you that your entire office will be protected.
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How’d you like to
order a pizza by

visiting a pizza store in
a game? Sony has
recently made it
possible to do just that:
one can now order pizza
while playing the online
multiplayer game
Everquest II. The idea is to
not leave the game
while you are ordering
the pizza; one simply
needs to type in ‘/pizza’
within the game. This
leads one to the online
ordering section of Pizza
Hut to place an order. Soon,
players will be able to pay
for such orders via their
monthly gaming bill.

Although it’s not a big
deal quitting the game and
ordering a pizza the regular
way, it is certainly a novelty
to be able to order within
the game itself. The concept
adds to the virtual gaming
experience—and it could

certainly mean more pizza
orders, what with the
number of Everquest
subscribers. Schemes such
as free games, as long as
one spends more than, say,
$30 a month on purchases,
seem almost sure to come.

Sony Online
Entertainment said that it
thinks this is the first time a
game has been able to accept
orders for real-world items.
It certainly won’t be the last.

CELL USE WHILE DRIVING UP

Driving
Under The
Influence

In an earlier issue of Digit,
we reported that people

talking on cell phones,
while driving have their
mental age reduced to
approximately that of a 10-
year old, in terms of
response times. And now, as
per a survey released by the
United States National
Highway Traffic Safety
Administration, more
people than ever are using
their cell phones while
driving. The survey was
conducted at 1,200 road
sites across the country and,
in some cases,
supplemented by telephone
surveys. It showed that 8 per
cent of the drivers were
using hand-held or hands-
free cell phones during
daylight hours last year, a
50 per cent increase since

Think you have the most
beautiful, most innovative

desktop around? Send it to
mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit will publish the most 
eye-catching of them each month.

Rajneesh’s desktop has an Apple-style dock.
Sent in by Rajneesh Raghu, Fareedabad

My Desktop

This site, called ‘Nellikkal
Computers’, is the Web
site of a computer com-

pany based in Nagercoil,
Tamil Nadu. For some
strange reason, the site’s
builders seem to think that
tantalising you with pictures
and terms is better than
actually offering clickable
products. For instance, click-
ing ‘Networking’ leads you
to a page that helpfully lists
a few networking terms.
‘Laptop’ takes you to a page
where there are, umm, pic-
tures of a few laptops. No
prices, though—and nothing
like “available here” or any-
thing. Ostensibly, we are to
assume that these laptops
are available at the store. 

Clicking ‘Computers’
takes you to a page where
three computer configura-
tions are given. It’s not even
clear whether these configu-
rations are available at
Nellikkal Computers. But at
least that’s better than just
pictures, isn’t it?

An ‘under construction’
sign would have helped us
make some sense of this,
but there’s none.

The rest of the links
don’t work—and they don’t
give errors, to the site’s
credit: they are conveniently
not clickable.

The only link that’s of
any use is ‘Contact us’—but
we wonder who’d want to
contact them after a look at
the site!

www.nellikkal.com

A Robot In Every Japanese Home
Officials have compiled a report predicting that every hous-
ehold in Japan will own at least one robot by 2015. Robots
are already used as receptionists, night watchmen, hospital
workers, guides, pets and more. This trend may, scientists
say, change lifestyles more radically than computers did.

Teen Convicted Under Internet Piracy Law
Parvin Dhaliwal, 18, is the first person in the US to be
convicted, under state laws, for illegally downloading music
and movies off the Net. He was sentenced to a three-month
deferred jail sentence, three years of probation, 200 hours of
community service, and a $5,400 (approx. Rs 2,35,500) fine.

The winner
receives a copy
of professional
SLQ Server 
2000 DTS
By Mark Chaffin, Brian
Knight and Todd
Robinson, published by
Shroff Publishers & Distributors P. Ltd.
This month’s winner is
Rajneesh Raghu, Fareedabad  

KEEP GAMING

Virtual Pizza—For Real

Illustrations: Harsho Mohan Chattoraj
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2002 and a 100 per cent rise
in four years. Drivers aged
between 16 and 24
increased their talking on
cell phones by 60 per cent
between 2002 and 2004.

“While we don’t have
hard evidence that there’s
been an increase in the
number of crashes, we
know that talking on the
phone can degrade driver
performance,” NHTSA
spokesman Rae Tyson said.

Washington DC and the
State of New Hampshire no
longer allow talking on
hand-held cell phones
while driving. Some
communities require
hands-free cell phones.

The National
Transportation Safety Board
said it wants all the 50
states of the US to ban those
with learner’s permits from
using cell phones, or other
wireless devices while

driving. So far, however,
only two such states have
passed such a law.

MICROSOFT TECHFEST

Baby-sitting
Bots!

Think about a teddy bear
sitting in the corner of a

child’s room, his head
following the kid around
using a face recognition
program, also allowing a
parent talk to the child
through a special phone—or
monitor the child via a
camera and wireless
Internet connection. The
prototype, on display at
Microsoft’s annual gadget
showcase, is one of several
ideas researchers have for

robots. The idea is to create
a virtual being that can visit
the neighbouring cubicle
for a live telephone chat
while the owner is
travelling thousands of
miles away, for example.

The ‘Teddy’ project was
one of about 150 projects
on display at Microsoft’s
TechFest, a two-day event
that gives Microsoft’s
worldwide team of
researchers the chance to
show product developers
their creations. TechFest
opened on March 2, mainly
to full-time Microsoft
employees. The company
expected about 6,000 to
attend, including
Chairman Bill Gates and
other executives.

Another idea at TechFest
came from Raman Sarin, a
Microsoft development

engineer. Sarin’s
invention is
SmartPhlow, a
program that not
only monitors
current traffic
patterns but also
uses real-time and
archived data to
predict when the
next traffic jam
might occur.

SmartPhlow,
which can work on

This month’s winner is 
Dhawal Damle from Delhi. He wins

We take the humble
modem for granted,

but the fact is that the
Internet could not have
become what it is without
the invention of the PC
modem. It was Dennis
Hayes who set the stage for
massive computer-to-
computer communication
by inventing the PC modem
in 1977. This established the

technology
that would
allow the
then online
and
Internet
industries
to emerge
and grow.

Hayes had been working
at a computer services firm
that used leased-line
modems for point-to-point
connectivity between
microcomputers. He wanted
to open those lines of
communication so any one
system could talk to
another, and created the
standard AT command set, a
software string that let any
computer with a serial port
activate features on an
intelligent modem.

In January 1978, he
founded D C Hayes &
Associates, Inc, the company
known today as Hayes Corp.
Innovations at Hayes’
company resulted in
performance enhancements
and cost reductions that led
the industry in the
conversion from leased-line
modems to the intelligent-
dial modem, or PC modem.
The PC modem was initially
sold to hobbyists. Soon, D C
Hayes & Associates became a
1,500-employee company,
operating in 44 countries.

Hayes’ eyesight began
deteriorating in the ’70s,
and he today champions Net
accessibility for the visually
and hearing impaired.

Modem
Man

People Who
Changed

Computing

NBA LIVE 2004 
worth Rs 1,299

from Gayatri Impex
Pvt Ltd

Express your game
with new freesyle
shooting, signature
moves, mid-air shot
adjustments, and more.

Who was it that said “And never the
twain shall meet”?

WIN!
A Mini Keypad by Travel Pac just by sharing an
amusing picture with a tech angle to it. The
picture should be shot by you, and should not
have been published earlier.
Send your picture to
digipick@thinkdigit.com.
The prize-winning picture will be published
each month.

Cell use while driving is on the rise

Dennis Hayes



an advanced smartphone
or on a desktop computer,
takes into account
everything from weather,
to sporting events, to
accidents, in making its
predictions. It also looks at
traffic relationships—if, for
example, a northbound
freeway is jammed, it 
may be able to gauge the
ease or difficulty of a
westbound commute.

Sarin said at least 2,000
Microsoft employees are now
using a prototype of the
product in the Seattle area.

DEADBEATS AS CRIMINALS

Buyers
Beware

eBay, with its massive
reach and member

base, can be the starting
point for violent crimes
as well. Dewan Horne,
24, was indicted early
March by a US federal
grand jury: he first
auctioned vintage cars
on eBay, cars he did
not own, and then had
two partners rob the
would-be buyers at
gunpoint. The partners
are still at large.

In one of the robberies,
which occurred in
December, a father and son
were forced, at gunpoint, to
lie down. Horne and his
partners then took more
than $9,000 (Rs 4 lakh) in
cash and equipment from
their truck before leaving in
Horne’s car.

Horne is charged with
robbery and conspiracy
under the Hobbs Act, which
prohibits interference with
interstate commerce by
threats or violence, and for
his partners’ alleged use of
firearms during the crimes.
He could face prison time
and a fine, if convicted,
prosecutors said.

On eBay, though, Horne
probably got away with just
two negative ratings. If the
people who were robbed,
bothered to rate him, that is.

EDIBLE NANOTECH

Eat Your
Silicon

Nanotech may soon find
its way into your

stomach. It’s not about
nanobots—tiny
programmable robots;
rather, it’s about particles
that could enhance the
absorption of food and
medicine—meaning
programmable drinks and
more effective drugs.

“We’re creating
nanoparticles that can
assemble themselves and
that are made of materials
already found in food,” said
physicist Anthony Dinsmore
at the University of
Massachusetts in Amherst.

Edible nanoparticles
can be made in a wide
range of shapes, from
spheres to pipes, and are
composed of materials
either relatively inert in
the body, such as silicon
or ceramics, or materials
that react with the body’s
heat or chemistry, such
as polymers.

A key advantage edible
nanoparticles have over
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IT Law
You already know that lawyers
use such terms as ‘hereinunder’
‘wheretofore’ and so on. But
what kinds of terms do IT
lawyers use, under the
Information Technology Act of
2000? Here’s a sampler.
Computer: According to IT
lawyers, this does not refer to
the box you’re so familiar with.
It manipulates electronic,
magnetic, or optical impulses,
and for good measure, includes
all input, output, processing,
storage, and blah blah, that are
connected—or even related—to
the computer.
Access: No, this is not about
usernames and passwords.
Access is, as it turns out, “with
its grammatical variations and
cognate expressions,” gaining
entry into, instructing or
communicating with the
logical, arithmetical, or
memory resources of a
computer. Phew! Actually,
there’s more to it than that,
but we didn’t understand it.
Time and place of despatch
and receipt of electronic
record: We doubt that even
the lawyers understand this
section of the Act. It says in
the Act that the despatch of
an electronic record occurs
when it enters a computer
resource “outside the control
of the originator.” This is
something related to AI and
robotics: computers
communicating all by
themselves, without human
intervention...
Penalty for damages:It turns
out that whatever damage you
inflict upon a computer, you
don’t need to pay the owner
more than Rs 1 crore. If you
download a virus onto
someone’s computer, expect a
lawyer to refer to it as
“introducing, or causing to be
introduced, any computer
contaminant or virus into a
computer.” ‘Contaminant’?
Wonder what that means...
Residuary Penalty: Whoever
contravenes any rules or
regulations under the IT Act is
liable to pay Rs 25K to
someone hurt by your
activities! So next time
someone makes your
WIndows crash, remember to
ask him to shell out.

The bosses at Digit think they are god’s
gift to workaholism. So, on a balmy

March afternoon, they lug us all the way
to Khandala, to talk about various
official things. It is called mixing
business with pleasure, but we privately
call it torture. Khandala is this cool,
little hill station some 100 km north of
Mumbai. And trust our guys to put us all
in some claustrophobic conference room
for three hours with biscuits for
company. Credit to them, when they said
three hours, they actually meant two, so
we were out in two hours.

Anyway, the point of this story is not
to grumble about the bosses—we can fill
a whole new section on that someday—
but to talk about the ineptness of some
drivers. The worthy chap who was
cabbing us to Khandala thought that just
like a newly-
married couple
that lives on love
and fresh air, his
Toyota Qualis too

would live on two litres of diesel and will
power until Khandala.

Sadly for him, and tragically for us, it
did not. And we were stranded right in the
middle of nowhere on the Mumbai-Pune
Expressway. So there we were, nine people
trying to get to the destination desperately,
but helpless like a maiden in a Hindi film.
Our man wanted fuel, and there was no
fuel. The closest fuel station was 12 km
away. The next 20 minutes looked and
sounded like the Indian Parliament. There
was much consternation, shouting, buck-
passing, and ultimately one person even
wanted to stage a walkout, only to be
prevented by vehicles zipping at 120 Kmph
along the expressway.

Ultimately, another driver, who
dropped off the previous nine people,
came back and picked us up, and took us

to our destination,
where we spent the
aforementioned two
hours inside the
claustrophobic room.

Digitisers In Distress
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larger particles “is how
nanotechnology can take
something that is
extremely insoluble in
nature, like some drugs,
and by breaking them up
to the nano-level help
release them in the body,”
said Roger Aston, strategy
director of pSivida in
Perth, Australia.

In terms of enhancing
the nutritional quality of
food, “You can imagine
there are some things that
you would want to deliver
to, say, the intestine and
not the mouth,” Dinsmore
said. “For administering
drugs to a patient, you can
imagine delivering a
medicine to the part of the
body where it’s needed
most and not have to go
everywhere else, so the
overall dose you use is
lower but the drug is used
more effectively.”

Aside from carrying
drugs with precision,
nanoparticles have the
capability to break open
upon command,
something that could lead
to smart, programmable
foods and drinks.

Another concept under
development involves
nanoparticles that can
stick to specific parts of
the intestine. To enhance
the absorption of
medicines, researchers are
creating nanoparticles that
can hook onto the gut and
thus stay longer,
increasing drug uptake.

The future of edible
nanotechnology could be
silicon, Aston suggested.
Unlike nanoparticles 
made of polymers, he
noted, silicon does not
need exotic chemical
bonds to hold each
nanoparticle’s contents in
place, bonds that
conceivably could alter 
the content’s properties.
Aston explained, “The
edible silicon made by
pSivida has the capability
of holding processors, 
so you could program
chips in foodstuffs like 
you would computers or
air conditioners.”

Compiled by Aditya Kuber, 
Meera Vankipuram, 

Ram Mohan Rao and
Renuka Rane

You wouldn’t believe it, but this site is exactly what the
name says—a collection of belches. Don’t get it? OK, we

will spell it out for you. The site contains a whole bunch—and
we mean a whole bunch—of downloadable audio files con-
taining recorded belches submitted by different people.

To be honest, the titles given to all belches are hilarious.
Consider, “Who says French Canadians can’t do anything
right?” or “Here is Michelle and her ‘popcorn’ belch”, “This
long grumbling belch is courtesy of ‘Zode’”, “Trisha is sweet
sixteen, and she has an equally sweet burp”, and so on. Do
you really want to download those belches and listen to
them? In fact, has anyone ever downloaded those belches
and listened to them?

There are extras such as celebrity belches, a guide to
‘Things that make you go Buurrp’, a brief section called
‘What is a belch’, and so on. Titles such as “Sangria, a girl,
pushes out this 36 second belch” may perhaps tempt the
weirdo in you to actually listen—but nah, a burp is too gross
to actually go all the way. 

As with our previous selec-
tions in this space, someone
who actually spends more
than a minute on this site
needs psychiatric help. To its
credit, the site does make fun
of itself—it says it’s the ‘dumb-
est site on the Net’. We’ll con-
cede this much: the site makes
for a funny two-minute read—
but no belches, please!

whatweretheythinking.com

Carl Salminen
http://snipurl.com/digitblog1

Dope My Games
With all the hullabaloo surrounding steroid use by
Major League Baseball players I think it’s time that
Electronic Arts pick up on the trend. After all, the
motto for EA Sports is something like “If it’s in the
game, it’s in the game”. With that in mind, I demand
that next year’s baseball game include an option to
inject steroids in my players and mutate them into
Hulk-like monsters who knock out 100 home runs
every year.

Mavromatic
http://snipurl.com/digitblog2

Two Years, Plus Two More
So I’m almost done with the construction of my new
home, it has been two years of actual construction
and two years of planning. High on my list was to
design and install a complete home automation
system in the house. My goal is really simple. There is
no need to automate a toaster or have a TV screen
built into my refrigerator. I believe a ‘smart home’
should be just that. Smart. It should be bright enough
to know when I’m in proximity. Lets say I pull into my
driveway and open the garage door at 10 pm. The
house should turn on the lights leading to my
bedroom at 45 per cent brightness. If I turn lights on
after midnight, to get a drink of water or go to the
bathroom, the switches should know to only turn the

lights on 25 per cent, as I don’t want to be fully
awakened. A video server will play a major part...

Heath Dixon
http://snipurl.com/digitblog3

Speaking Of Which, Another University Gets
Hacked

California State University, Chico, announced that
it has informed more than 59,000 people that their
personal information may have been compromised in
an attack on the school’s servers earlier this week.

The school reports that computer hackers gained
access to a University Housing and Food Service
system. The system contained personal information—
including names and Social Security numbers—of
people with different ties to the university.

Roland Piquepaille
http://snipurl.com/digitblog4

Elephants Send SMS to Tell Where They Are
Two months ago, I told you that the Wildlife

Conservation Society was planning to count
elephants from space. So I was very intrigued by a
very short article from the Inquirer, “Elephants text
their location.”

This teasing story said that when elephants start
to approach their fields, the farmers are alerted by
SMS in time to politely ask the elephants to move
over and save their crops. The whole story is told on
the Save the Elephants (STE) site.

From the fascinating
world of blogs this
month: what a really
smart home should
be, according to
‘Mavromatic’; Carl
Salminen’s demand
for baseball players
in games to have the
option of using
steroids; yet another
university computer
system that got
hacked into; and
something about
being alerted about
elephants via SMS.

www.belch.com

www.belch.com



Putting A Spim On It
Sachin Kalbag’s editorial on the issue of
mobile spam or spim (‘Don’t piss me off’,
March 2005) had just the right tone. I am
not a regular victim of spim, but I
completely agree with the need for iron-
cast laws on spimming. We have already
entered the era of low cost text messaging,
and it is high time authorities took notice
of the inherent dangers of spim-and take
action to protect our privacy and rights.

The problem is, in a technologically
illiterate nation-headed mostly by
equally illiterate ministers-how do we
make our leaders sit up and take notice
of this gradually-spreading evil?

I believe spimming is illegal in the
US, or at least, some sort of legal
recourse can be taken against it by
victims. But can this be happen in India?

I find it hard to visualise technocrats
putting up a ‘dharna’ to ban spim! Nor
would politicians understand the
importance of such a law. 

Whatever the case may be, the
situation is definitely going to get worse
in the coming years.

Arjun R
Via e-mail

The March editorial couldn’t have come
at a better time. Given current trends,
mobiles seem to be the ideal gateway for
the Indian masses into the digital world,
as these gadgets provide cheap
computing and connectivity to a number
far greater than those with access to a
PC. Therefore, the problem of spim will
increase only exponentially as the
market expands.

It will be compounded when mobile
phones become the preferred Internet
gateway, which is inevitable. It needs to
be nipped in the bud. Now!

You suggest that we all call them
back and give them a piece of our minds.
But I don’t think they (the spimmers)
will be bothered one bit—they are thick-
skinned enough to simply ignore the few
angry calls they get.

The law isn’t a solution either: on
what grounds do we punish them?
Doing business via SMS? Sending
unsolicited SMSes? If there were such a
law, it would be the most misused law in
the country, and could be used by
anyone against anybody.

The solution, I think, must be
implemented at the service provider’s
end as in the case of spam. Somebody
(Digit, perhaps?) is bound to figure out a
way to do so, before the problem gets
out of hand.

Ojas Amalnerkar
Via e-mail

Dear Arjun and Ojas,
Digit’s editorials usually reflect what most
technology users are thinking about at any given
point in time. Spimming is indeed a menace that
deserves the axe; and the earlier the better. The
trouble with taking a legal recourse in India is
also that it is a long-drawn process. Besides, it
may be in the media’s spotlight for a day or two,
and then everybody gets back to their respective
jobs. For instance, has a single print publication
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Digit Forum

To post your comments on Digit Forum, 
visit www.thinkdigit.com/forum

Anti-piracy. What’s up with that?

sunnydiv
Digitized!
When I look around, I see all the companies
using and looking for better anti-piracy
techniques; I want to put forward a question. 

Do they really work?  As far as I know they
don’t, all they do is cause more and more pain
to those who purchase the original copies,
pirates always find a way to pirate! 

Example: Microsoft XP! Now they are
asking real buyers to call Microsoft to
activate Windows. And you have to do this on
every reinstall!!! For Pirates, a simple and
easy keygen; no call, no nothing, put in key
and its done 

Games: Real buyers have to insert the
CD every time they play, lose the CD and
that’s about it for them. Pirated games are
copy protection free, you can make an ISO
image, you can even find a crack where the
CD isn’t required. 

Now they are working on inbuilt hardware
piracy protection; that’s going to give the real
buyer more problems.

Software companies need to remember:
They are only causing pain to the people who
actually pay. And Pirates, always find a way
****************************************
rajkumar_personal
Resident Techie
A POST THAT NEEDS EVERY1's attention! Well
said mate! Hope that many ppl take notice and
do something about it!
****************************************
gamefreak14
Digitized!
Sunnydiv, Your colourful explanation of
pirates being the happiest really opened my
eyes. I never knew such a free, free world ever
existed. And all this while, I was being
tortured. Why discuss the obvious? There are
people who'll even “pirate” Linux. Anti-piracy
measures are intended to stop casual piracy—
of the harmless kind. 

I lost Rs 500 when I lost my wallet
yesterday. Since I couldn't make an ISO of my
cash, I expect you to reimburse it. Got it?  
****************************************
goobimama
Resident Techie
Location: Goa
TOTALLY SUPPORT SUNNYDIV

I’ll tell you an incident with an original
Windows Installations. My friend, who had
opted for the government scheme “The
Cyberage Scheme” got a computer with
Windows XP Home Edition installed. Now,
somewhere down the line something got
screwed up (as it always does). So, he asked
me how to reinstall. After reinstalling, he had
to activate it. No modem. So, he tries dialling
those numbers that were given. Always
engaged. Gets really frustrated and asks me
what to do. I go and install my pirated copy of
Windows XP Professional with SP2 (Microsoft
claims “only original Windows has SP2”!). He's
happy now. Pirates and crackers will always
find a way, they are smarter than those who
created the software. Also, as the saying goes
“everything that is made can be broken” 

The ThinkDigit blog: By the readers and for the readers



or a television channel followed up on the
‘Marketing calls on Mobile’ case? The spim and
spam cases, as and when they happen, require as
much media attention as an individual’s.

As Arjun rightly points out, it is hard to
imagine technocrats sitting on a dharna to
protest against spam and spim. Even if they do,
will the law makers understand what the
hullabaloo is all about? Yet, we must not lose
hope. With technologies such as DomainKeys, and
progressive service providers instituting a Do Not
Disturb regime (Hutch, for instance), there may
still be a way to fight people like Vipin Saxena. 

—Executive Editor

The Digit Blog
I started a blog called Thinkdigit at
http://thinkdigit.blogspt.com. I would
love this blog to grow into one of the most
popular technology blogs in India. Some
of the forum members have supported
me, and they have joined the blog.

Our problem is we don’t have any
active team members to regularly post
new stuff on the bog. I would like to
request you to publish this letter so that
some members get to know about the
blog. They can mail me at
lwadhwa@gmail.com if they want to
work as blog team members.

We need at least 10 talented users
from different fields—such as
programming, graphics, animation, and
so on. Also, the ‘thinkdigit’ wiki at
http://en.wikipedia.org, which I started,
has gotten a good response, and is
growing every day

Lovedeep Wadhwa
Via e-mail

Dear Lovedeep,
That is a fantastic gesture on your part. We
sure do love it at Digit!

—Executive Editor

Zero To Hero
I have been a subscriber for the past two
years—two great years. From ‘dumb’, you
turned me into a geek. I got so geeky that
my girlfriend left me. But I let her go. Why?

Because I can find another girl like her,
but another magazine like Digit? No way! I
used to get a shock every two or three
months because of your surprises. Not any
more. But not because you don’t spring
surprises anymore—I’ve become immune to
them! Your latest addition—the Fast Track
book—just proved it. It was awesome!
Excellent work, guys.

Snehasis Ghosh
Via E-mail

Just What I Needed
The March 2005 issue was like a God-
send. I had been searching for Grand
Theft Auto-2 in all the showrooms, and I
just couldn’t find it. Imagine my joy
when I found that the DVD with the
March issue came with the full version
of GTA-2! Thanks a million.

Pulkit Sharma
Via e-mail

Fast Track To Technology!
I read Digit regularly. I was pleased to
see the Fast Track book with the March
issue—it was an amazing, marvellous
and a wonderful book. I’m looking
forward to the books with the
forthcoming issues.
When I purchased a
DVD drive, I didn’t
have any DVDs;
Digit, at the same
time, started giving
out DVDs. And
when I purchased a
digicam, Digit came
up with a book on
digital
photography!
Whatever
technology I upgrade to, Digit always
seems to be by my side to guide me.

Ramji V K
Via e-mail

Dear Ramji,
Your words do put a smile on our faces, and
make us more responsible to our readers. 
It is real hard work for every single Digit team
member who work non-stop to bring the Fast
Track book. Yet, it is also an enjoyable project. 
We love bringing it to you, as much as you love
reading it.

—Executive Editor

Corrigendum
With reference to our article titled “Anywhere
You Roam” published in the March issue, we
wish to clarify that the price of Acer TravelMate
4002WNLCi was incorrectly mentioned as
Rs 51,999 on Page 94. The correct price of this
notebook at the time of publishing that article
was Rs 69,999.

Since price is a critical parameter in
deciding our winners, the Acer TravelMate
4002WNLCi is no longer the Best Buy Gold
Winner. The new title holder is MSI Megabook
M510C, while the Best Buy Silver award goes to
ACI Emerald C2.

- Executive Editor

Inbox
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Appearances Are Deceptive

The March 2005 issue of Digit held
out a big promise, only to deceive. As
soon as I opened the package, I was
thrilled to see the book Fast Track to
Digital Photography included with 
the magazine. 

However, my heart sank as I turned
the cover page. A book on digital
photography, that too from the
publishers of India’s top IT
magazine, amply illustrated
with photos and screenshots—
all in Black and White! 

This book, otherwise
superbly written and designed for
its size and scope, is totally ruined
because of the monochrome
illustrations of colour images. I often
read reviews of commercial books on
image processing, even when mostly
complimenting, ending with a sigh:
“Alas, illustrations are, once again,
only in B & W”! Explaining colour
image processing with illustrations in
B & W? How silly can one get! 

Nevertheless, I did not expect a
publication ostensibly written and
designed by the much revered
technical staff of the Digit magazine to
deliver this disappointing feature.
Now, this book, which includes the
screenshots of the colourful cover page
(in B & W, pages 44-47), couldn’t
possibly have been created, on the 
PC, in B & W. 

Therefore, this book can be useful
as a quick reference, but can be easily
complemented by a digital copy in full
colour in the CD/DVD accompanying
the May 2005 issue. That will also be
the best way to fully justify, and truly
acknowledge, the painstaking effort of
your staff responsible for the
production of this book. 

I am sure this is not too much to
expect from the Digit magazine which
routinely feeds us with about 4.3 GB
(not counting the CD) of games, other
software and useful digital data such
as eBooks, wallpapers and even movie
trailers—all on a single DVD! 

In this context, the eBook on
Physics is an example par excellence,
and I am sure most readers of Digit
like me highly appreciated it. So, come
on Digit, show us your true colours.
Yes, the pun is intended!

Subhendu Joardar 
Via e-mail
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